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WF-C8690 User's Guide
Welcome to the WF-C8690 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics
See these sections to learn about the basic features of your product.
Installing the Optional Cabinet and Paper Cassettes
Using the Control Panel
Product Parts Locations
Using Power Saving Settings
Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint
Using Google Cloud Print
Setting Up Google Cloud Print on a Chromebook
Android Printing Using the Epson Print Enabler
Using Fire OS Printing
Using Windows 10 Mobile Printing
Using Epson Print and Scan App with Windows Tablets
Using the Mopria Print Service
Printing and Scanning with NFC from Your Android Device

Installing the Optional Cabinet and Paper Cassettes
Follow the instructions in this section to install the optional cabinet and paper cassettes to your product.
If you are installing the optional cabinet, install the cabinet under the bottom optional cassette unit first.
Installing the Optional Cabinet
Installing the Optional Paper Cassette Units
Parent topic: Product Basics

Installing the Optional Cabinet
You can install the optional cabinet to provide mobility and extra storage space.
1. Turn off the product, and unplug the power cord and any connected cables.

Warning: To avoid electric shock, make sure you unplug the power cord.

2. Remove the cabinet from its packaging and remove any protective materials.
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3. Make sure you have all the items shown here:

1 Optional cabinet
2 Side stands (×2)
3 Front reinforcing bar
4 Rear reinforcing bar
5 Front cover
6 Cabinet screws (×2)
7 Rear brackets (×2)
8 Bracket screws (x2)
9 Side stand and reinforcing bar screws (×8)



18

4. Place the stands between the cabinet's casters as shown.

5. Secure the stands to the cabinet with the included screws.

Caution: Make sure the stands are securely attached or the product may fall over.
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6. Attach and secure the reinforcing bars to the stands with the included screws.

7. Place the cabinet on a flat surface and lock the front casters.
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8. Attach the front cover to the stands.

9. Remove the output tray from the product.
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10. Remove the paper cassette from the product.

Note: If you are installing the optional cabinet under the optional paper cassette unit, remove the
paper cassette from the optional cassette unit instead.
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11. Lift up your product or optional cassette unit and gently lower it onto the cabinet with the corners
aligned. Secure the product or optional cassette unit to the cabinet with the included screws using a
screwdriver.

Note: Screws may be left over after installation.
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Warning: To lift the product, have two or more people hold it as shown here. Lifting from other areas
may cause the product to fall or cause you to pinch your fingers when placing the product down.

12. Secure the back of the product or paper cassette unit to the cabinet using the included brackets and
screws.

13. Insert the paper cassette you removed and attach the output tray.
14. Connect the power cord and other connection cables, then plug in the product.
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Parent topic: Installing the Optional Cabinet and Paper Cassettes

Installing the Optional Paper Cassette Units
You can install up to three optional paper cassette units to provide more paper capacity. If you are using
the optional cabinet, install the cabinet under the bottom optional cassette unit first.
1. Turn off the product, and unplug the power cord and any connected cables.

Warning: To avoid electric shock, make sure you unplug the power cord.

2. Uninstall any optional cassette units already installed on the product.

Note: To uninstall optional cassette units, turn off the product, unplug the power cord, disconnect
any cables, and follow the rest of these instructions in reverse.

3. Remove the paper cassette unit from its packaging and remove any protective materials.
4. Make sure you have all the items shown here:

1 Optional cassette
2 Screws (×4)
3 Paper size label
4 Cassette number sticker
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5. Remove the output tray.

6. Remove the paper cassette from the product.
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7. Remove the paper cassette from the optional paper cassette unit.

8. Stack all optional paper cassette units on top of each other and secure them to each other with the
included screws.
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9. Lift up your product and gently lower it onto the paper cassette unit with the corners aligned. Secure
the product to the paper cassette unit with the included screws using a screwdriver.

Note: Screws may be left over after installation.
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Warning: To lift the product, have two people hold it as shown here. Lifting from other areas may
cause the product to fall or cause you to pinch your fingers when placing the product down.
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10. Secure the back of the paper cassette units to each other and to the product using the included
brackets and screws.

11. Insert a label into the holder indicating the paper size to be loaded in each of the paper cassettes.
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12. Insert the paper cassette and place the correct sticker on the cassette unit to indicate the cassette
number.

13. Attach the output tray.
14. Connect the power cord and other connection cables, then plug in the product.
15. Turn on the product.
16. Pull out and reinsert the paper cassettes in the optional paper cassette units and confirm that each

cassette unit number is displayed on the screen.
17. Enable the optional paper cassette units in the printer software.
Enabling the Optional Paper Cassettes - Windows
Enabling the Optional Paper Cassettes - Mac
Parent topic: Installing the Optional Cabinet and Paper Cassettes
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Related tasks
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac

Enabling the Optional Paper Cassettes - Windows
You need to enable the optional paper cassette units before you can use them with the printer software.

Note: If you are using the Epson Universal Print Driver or PostScript (PS3) printer software, see the link
below to enable the optional cassette units.

1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click your printer name and select
Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click your printer name and select Properties.

2. Click the Optional Settings tab.
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You see a window like this:

3. Make sure Acquire from Printer is selected, and click Get.
The optional paper sources are listed in the Current Printer Information section.

4. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Installing the Optional Paper Cassette Units
Related tasks
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac

Enabling the Optional Paper Cassettes - Mac
You need to enable the optional paper cassette units before you can use them with the printer software.
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Note: If you are using the PostScript (PS3) printer software, see the link below to enable the optional
cassette units.

1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.

You see a screen like this:

4. Select the number of cassette units installed as the Lower Cassette setting.
5. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Installing the Optional Paper Cassette Units
Related tasks
Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac
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Using the Control Panel
See these sections to learn about the control panel and select control panel settings.
Control Panel Buttons and Lights
Selecting the Date and Time
Selecting Your Country or Region
Setting a Password and Locking the Control Panel
Setting User Feature Restrictions (Access Control)
Changing LCD Screen Language
Adjusting Control Panel Sounds
Adjusting the Screen Brightness
Turning Off the Operation Time Out Setting
Preventing PC Connection via USB
Parent topic: Product Basics

Control Panel Buttons and Lights

1 The power button and light
2 The NFC (Near Field Communication) tag
3 The Received Fax light
4 The home button
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5 The LCD screen
6 The log out button
7 The help button
8 The stop button
9 The Interrupt button
10 The Reset button
11 The Paper Setting button
12 The Job/Status button, the Error light, and the Data light
13 The numeric keypad
14 The Contacts button
15 The C clear button

Status Icon Information
Parent topic: Using the Control Panel

Status Icon Information
Your product displays status icons on the LCD screen for certain product status conditions. Select the

icon to view or change the current network settings.

Icons Description
Displays additional information or instructions, such as loading paper or placing a
document.
Displays the Printer Status screen.

Quiet Mode is enabled. Noise is reduced during printing, but the print speed may be
reduced. Select this icon to change the settings.
Quiet Mode is disabled. Select this icon to change the settings.

The Mute setting is enabled. The printer does not make any sound when you press buttons
on the control panel.
Displays the Fax Data Information screen.
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Icons Description
Select this icon to enable sleep mode and turn off the LCD screen.

The indicated setting has changed.

There is a problem with the indicated setting. Select the icon to resolve the problem.

No Ethernet connection.

An Ethernet connection is established.

No Wi-Fi connection.

A Wi-Fi network error has occurred or the product is searching for a connection.

A Wi-Fi connection is established. The number of bars indicates the connection's signal
strength.
No Wi-Fi Direct connection.

A Wi-Fi Direct connection is established.

Access to the product's functions are restricted to authorized users. Select the icon to log
in to the printer using a user name and password. Contact your administrator if you do not
know the login information.
Access to the product's functions are restricted to authorized users and a user is currently
logged in. Select the icon to log out of the current user account.

Parent topic: Control Panel Buttons and Lights

Selecting the Date and Time
Before using your product, select the current date, time, and daylight saving phase in your area, and
choose your preferred date and time format.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
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3. Select General Settings.

4. Select Basic Settings.

5. Select Date/Time Settings.
You see a screen like this:
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6. Select Daylight Saving Time.
7. Select the setting that applies to your area:

• Winter: it is winter or your region does not use Daylight Saving Time (DST)
• Summer: it is spring or summer and your region uses Daylight Saving Time (DST)

Note: If your region uses Daylight Saving Time (DST), you must change this setting to match the
season. When you change from Winter to Summer, your product automatically sets its clock ahead
one hour. When you change from Summer to Winter, it sets its clock back one hour.

8. Select Date/Time.
9. Select the date format you want to use.
10. Use the numeric keypad to enter the current date.
11. Select the time format you want to use.
12. Use the numeric keypad to enter the current time.
Parent topic: Using the Control Panel

Selecting Your Country or Region
Before using your product, select the country or region in which you are using your product.

Note: If you change the country or region, your fax settings return to their defaults and you must select
them again. This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
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3. Select General Settings.

4. Select Basic Settings.

5. Scroll down and select Country/Region.
6. Scroll up or down, if necessary, and select your country or region.

You see a confirmation screen.
7. If the setting is correct, select Yes. (If not, select No and retry.)
Parent topic: Using the Control Panel

Setting a Password and Locking the Control Panel
You can set an administrator password to lock the following settings and prevent them from being
changed:
• Network settings
• Web Service settings



40

• Scan settings
• System Administration settings
• Fax settings
• Web Config settings
• EpsonNet Config settings

Note: For more information on administration settings, see the Administrator's Guide.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Scroll down and select System Administration.
5. Select Security Settings > Admin Settings > Admin Password > Register.

https://files.support.epson.com/docid/cpd5/cpd55701/index.html
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You see a screen like this:

6. Use the displayed keyboard to enter a password and select OK.
7. Enter your password again to confirm.

Note: Keep a copy of your password in a safe place.

8. Select OK.
9. Turn Lock Setting on.
When the control panel is locked, you must enter the password to access any of the locked settings.

Note: If you forget your password, contact Epson for assistance.

Entering Characters on the LCD Screen
Using Presets
Parent topic: Using the Control Panel
Related tasks
Setting User Feature Restrictions (Access Control)
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Entering Characters on the LCD Screen
Follow these guidelines to enter characters for passwords and other settings.

• To move the cursor, select the left or right arrows.

• To change the case of letters, select .

• To delete the previous character, select .

• To enter numbers or symbols, select .

• To select from common email domain names, select .
• To enter a space, select Space.
Parent topic: Setting a Password and Locking the Control Panel

Using Presets
You can save frequently used copy, fax, and scan settings as presets. This lets you easily reuse them
whenever necessary.

Note: Presets can be locked by an administrator. If you cannot access or change presets, contact your
administrator for assistance.

1. Press the home button, if necessary.
2. Select Presets.
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You see a screen like this:

3. Select Add New. Enter the Administrator password, if necessary.

Note: You can save up to 50 presets.

4. Select the function for which you want to set up a preset.
You see the main screen for that function, such as the Copy screen:

5. Select the settings you want to save and select Register.
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You see a screen like this:

6. Select Name.
You see a screen like this:

7. Use the displayed keyboard to enter a name for the preset and select OK.
8. Select OK.
When you copy, fax, or scan, you can use the preset by selecting Presets and selecting your preset
name from the list.
Parent topic: Setting a Password and Locking the Control Panel
Related tasks
Entering Characters on the LCD Screen
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Setting User Feature Restrictions (Access Control)
Using Web Config Access Control Settings, you can restrict product features for individual users to
prevent misuse of the product. Restricted features require the user to enter an ID and password on the
product control panel.
After you setup feature restrictions, you must enable them using the product control panel.

Note: For more information on administration settings, see the Administrator's Guide.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Scroll down and select System Administration.
5. Select Security Settings.
6. Select Access Control.
7. Select On.
8. Enable Accept Unknown User Jobs to allow users to print from generic drivers or use the WSD

scanning function.
Parent topic: Using the Control Panel
Related tasks
Setting a Password and Locking the Control Panel
Entering a User ID and Password for Printing

https://files.support.epson.com/docid/cpd5/cpd55701/index.html
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Entering a User ID and Password for Scanning

Changing LCD Screen Language
You can change the language used on the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Basic Settings.
5. Scroll down and select Language.
6. Select a language.
Parent topic: Using the Control Panel

Adjusting Control Panel Sounds
You can adjust the sound level heard when you press buttons on the control panel.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the home button, if necessary.
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2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Basic Settings.
5. Select Sound.
6. Select Normal Mode or Quiet Mode.

Note: Press the icon on the home screen to switch between Normal Mode and Quiet Mode.

7. Select Button Press.

8. Press to decrease or to increase the sound.
9. Select OK to exit.

Note: You can also adjust the Sound Type and the sound level for various product functions.

Parent topic: Using the Control Panel

Adjusting the Screen Brightness
You can adjust the brightness of the LCD screen.
1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.
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You see a screen like this:

4. Select Basic Settings.
5. Select LCD Brightness.
6. Press the – or + icons to decrease or increase the brightness.
7. Select OK to exit.
Parent topic: Using the Control Panel

Turning Off the Operation Time Out Setting
The Operation Time Out setting causes the LCD screen to return to the Home screen after a few minutes
of inactivity. This feature is enabled by default, but you can turn it off.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.
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You see a screen like this:

4. Select Basic Settings.
5. Scroll down and set Operation Time Out to Off.
Parent topic: Using the Control Panel

Preventing PC Connection via USB
You can disable access from a USB-connected computer. This restricts non-network access to the
product and protects the security of confidential scanned documents.
1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Printer Settings.
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You see a screen like this:

5. Scroll down and select PC Connection via USB.
6. Select Disable.

Note: You must restart the product for the change to take effect.

Parent topic: Using the Control Panel

Product Parts Locations
See these sections to identify the parts on your product.
Product Parts - Front
Product Parts - Inside
Product Parts - Back
Parent topic: Product Basics
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Product Parts - Front
Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, you
can use these codes to locate and correct the problem.

1 Automatic Document Feeder (ADF) cover (F)
2 ADF edge guides
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3 ADF input tray (F)
4 ADF output tray
5 Paper cassette 1 (C1)
6 Optional cassettes 2, 3, and 4 (C2, C3, and C4)
7 Optional cabinet
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1 Rear paper feed edge guides
2 Paper support and extension
3 Rear paper feed slot (B1)
4 Feeder guard
5 Output tray
6 Paper cassette edge guides
7 Paper cassette

Parent topic: Product Parts Locations
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Product Parts - Inside
Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, use
these codes to locate and correct the problem.

1 Document cover
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2 Scanner glass
3 Control panel
4 USB Type A port for external devices
5 Print head
6 Front cover (A)

Parent topic: Product Parts Locations
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Product Parts - Back
Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, use
these codes to locate and correct the problem.

1 Rear cover 2 (D2)
2 AC inlet
3 Rear cover 1 (D1)
4 Paper cassette rear covers (E)
5 Service USB port for future use (do not remove sticker)
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6 Line port
7 EXT. port
8 LAN port
9 USB port

Note: If you are using a USB connection, make sure you insert the cable in the correct orientation.

Parent topic: Product Parts Locations

Using Power Saving Settings
Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period
of time. You can make the time period shorter and select other options to save energy and resources.
Changing the Sleep Timer Settings
Changing the Power Off Timer Settings
Parent topic: Product Basics

Changing the Sleep Timer Settings
You can adjust the time period before your product enters sleep mode and turns off the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.
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1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Basic Settings.
5. Select Sleep Timer. Enter the administrator password, if necessary.

You see a screen like this:

6. Do one of the following:
• Select the– or + icon to decrease or increase the number of minutes.
• Select the number of minutes on the LCD screen, select the number of minutes from the on-

screen or control panel keypad, and select OK.
7. Select OK.
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Parent topic: Using Power Saving Settings

Changing the Power Off Timer Settings
You can have the product turn off automatically if it is not used for a specified period of time.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Basic Settings.
5. Do one of the following depending on the setting you see displayed on the LCD screen:

• Select Power Off Timer, then select a time period between 30minutes and 12h (12 hours).
• Select Power Off Settings, then select Power Off If Inactive to adjust the time before the

product turns off automatically or Power Off If Disconnected to turn the product off after 30
minutes of inactivity over the network.

Parent topic: Using Power Saving Settings

Epson Connect Solutions for Smartphones, Tablets, and More
Use your smartphone, tablet, or computer to print and scan documents, photos, emails, and web pages
from your home, office, or even across the globe.
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Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Print from anywhere with these Epson Connect solutions:
• Epson Email Print
• Epson iPrint Mobile App
• Epson Remote Print
Scan and send a file as an email or upload it to an online service directly from your Epson product with
Epson Scan to Cloud or the Epson iPrint Mobile App.
Setting Up Epson Connect Services
Using Epson Email Print
Using the Epson iPrint Mobile App
Using Epson Remote Print
Using Epson Scan to Cloud
Parent topic: Product Basics

Setting Up Epson Connect Services
If you did not activate your product's email address for use with Epson Connect when you set up your
product, you can activate it using the product control panel.
1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.
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You see a screen like this:

4. Select Web Service Settings.
5. Select Epson Connect Services

You see a screen like this:

6. Select Register.
7. Follow the instructions on the screen to activate your product's email address.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Using Epson Email Print
With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the
attachments will print automatically.
1. Connect your product to your network. See the link below.
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2. If you did not already set up Email Print when you installed your product software, see the link below
to use your product control panel to activate your unique email address. Or visit epson.com/connect
(U.S), epson.ca/connect (Canada), or epsonconnect.com (Caribbean) to learn more about Email
Print, create your Epson Connect account, and register your product to the Epson Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

Note: Go to epsonconnect.com and log into your Epson Connect account to personalize your product's
email, adjust print settings, and set up other Epson Connect services.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related tasks
Setting Up Epson Connect Services
Related topics
Wi-Fi or Wired Networking

Using the Epson iPrint Mobile App
Use this free Apple and Android app to print and scan with networked Epson products. Epson iPrint lets
you print PDFs, Microsoft Office documents, photos, and web pages over a wireless network. You can
scan and save a file on your device, send it as an email, or upload it to an online service such as Box,
Dropbox, Evernote, or Google Drive.
1. Connect your product to your wireless network. See the link below.
2. Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean)

to learn more about Epson iPrint and check the compatibility of your mobile device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.
Now you are ready to print or scan with your mobile device and your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

https://www.epson.com/connect
https://www.epson.ca/connect
https://www.epsonconnect.com
http://www.epsonconnect.com
https://www.epson.com/connect
https://www.epson.ca/connect
https://www.epson.com.jm/connect
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Using Epson Remote Print
With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson
Email-enabled product anywhere in the world.
1. Connect your Epson product to your wireless network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software,

visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address.

3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print
Driver software.

4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.
6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer

application and choose the Remote Print option for your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using Epson Scan to Cloud
The Epson Scan to Cloud service allows you to scan and send a file as an email or upload it to an online
service directly from your Epson product. Register an email address or online services such as Box,
DropBox, Evernote, or Google Drive with your Epson Connect account.
1. Connect your Epson product to your network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software,

visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address and password.

3. Visit epsonconnect.com to sign into your account with the email address and password you
selected.

4. Select your product, select Scan to Cloud, and select Destination List.

http://www.epsonconnect.com
http://www.epsonconnect.com
http://www.epsonconnect.com
http://www.epsonconnect.com
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5. Click Add, then follow the instructions on the screen to create your destination list.
6. Now you are ready to use Scan to Cloud. Select the setting for scanning to Scan to Cloud on your

Epson product control panel.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using AirPrint
AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of
iOS, and Mac with the latest version of OS X or macOS.

Note: If you disabled paper configuration messages on your product control panel, you cannot use
AirPrint. See the link below to enable the messages, if necessary.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking
Selecting Default Paper Settings - Administrator

Using Google Cloud Print
With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.
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1. Connect your Epson product to your wireless network. See the link below.
2. Note your product's IP address by checking your network status. See the link below.
3. Connect your computer or your Apple or Android device to the same wireless network as your Epson

product.
4. Enter your product's IP address into the address bar of a web browser.
5. Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

6. Click Register.
7. Select the checkbox to agree to the Usage Advisory and click Next.
8. Click OK to launch the sign-in page.

A separate browser window opens.
9. Enter your Google Account username and password and click Sign in, or, if you don't have an

account, click Sign up for a new Google Account and follow the on-screen instructions.
10. Click Finish printer registration to complete setup and print a test page.
Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for Google Cloud Print
(U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud
Print, or the Google Cloud Print website for a list of supported apps.
Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.

https://www.epson.com/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
https://www.epson.ca/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
http://www.google.com/cloudprint/learn/index.html
http://www.google.com/cloudprint/learn/apps.html
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3. Do one of the following:
• Click Add to Cloud Print in the notification that appears in the corner of your Chromebook

screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

• Open a web browser and enter chrome://devices in the address bar. Skip to step 5.
• If you see a registration confirmation screen instead, click Register.

4. Click Add Device.
5. Click the Register button that appears next to your product.
6. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation

message.
7. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and

print a test page.
Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone,
or Android phone with Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson
Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the
Google Cloud Print website for a list of supported apps.
Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Android Printing Using the Epson Print Enabler
You can wirelessly print your documents, emails, photos, and web pages right from your Android phone
or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson
product and print.
1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Epson Print Enabler plug-in from Google Play.
3. Go to Settings on your Android device, select Printing, and enable the Epson plug-in.
4. Connect your Android device to the same wireless network as your product.

https://www.epson.com/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
https://www.epson.ca/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
https://www.epson.ca/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
http://www.google.com/cloudprint/learn/index.html
http://www.google.com/cloudprint/learn/apps.html
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5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu
icon and print whatever is on the screen.

Note: If you do not see your product, tap All Printers and select your product.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Using Fire OS Printing
You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product.
There is no software to download, no drivers to install, and no cables to connect. With just a few taps in
Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson
product.
1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.
3. Now you are ready to print. From your Amazon application, tap the print option and select your

product to print whatever is on the screen.

Note: If you see a message telling you that a plug-in is required, tap OK and tap Download. If your
Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria
Print Service app to print.

Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to
learn more about Fire OS Printing (one of many Epson Connect Partner Solutions) and check the
compatibility of your mobile device.
Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Using Windows 10 Mobile Printing
You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson
product. There is no software to download, no drivers to install, and no cables to connect. Look for the
print option in your Windows 10 application to send whatever is on the screen to an Epson product.
1. Connect your Epson product to your wireless network. See the link below.

https://www.epson.com/connect
https://www.epson.ca/connect
https://www.epson.com.jm/connect
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2. Connect your Windows 10 Mobile device to the same wireless network as your product.
3. Now you are ready to print. From your Windows 10 application, tap the print option and select your

product to print whatever is on the screen.
Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to
learn more about Windows 10 Mobile Printing (one of many Epson Connect Partner Solutions) and
check the compatibility of your mobile device.
Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Using Epson Print and Scan App with Windows Tablets
You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface
RT or Pro tablet with networked Epson products. Epson Print and Scan App allows you to scan and
capture images right to your tablet or to Microsoft OneDrive.

Note: The Epson Print and Scan App does not support Windows 10 Mobile printing.

1. Connect your Epson product to your wireless network. See the link below.
2. Download Epson Print and Scan App from the Microsoft Windows Store.
3. Connect your Windows tablet to the same wireless network as your product.
4. Open Epson Print and Scan App and select your Epson product.

Now you are ready to print photos or scan.
Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to
learn more about Epson Print and Scan App.
Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Using the Mopria Print Service
You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to
your Epson product or any Mopria-certified product from other manufacturers. You can download the
Mopria Print Service from Google Play.

https://www.epson.com/connect
https://www.epson.ca/connect
https://www.epson.com.jm/connect
https://www.epson.com/connect
https://www.epson.ca/connect
https://www.epson.com.jm/connect
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Note: For details on the Mopria Print Service, click here (U.S) or click here (Canada).

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Mopria Print Service from Google Play.

Note: On some Samsung Galaxy devices, Mopria may come preinstalled.

3. Go to Settings on your Android device, select Printing, and enable the Mopria Print Service.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu

icon and select Print. Then select All printers, select your Epson product, adjust your print settings,
and print.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Printing and Scanning with NFC from Your Android Device
You can easily connect your Android 4.0 or later device to your product using NFC (Near Field
Communication). Once connected, you can print and scan using Epson iPrint.
1. Make sure Epson iPrint is installed on your Android device.
2. Make sure Simple AP mode or Wi-Fi Direct is enabled on your product and that you are using the

default Wi-Fi Direct password.

Note: NFC printing and scanning will not work if you changed the default Wi-Fi Direct password.

3. Do one of the following:
• If you are going to print, make sure paper is loaded in the product.
• If you are going to scan, place your original on the product for scanning.

https://www.epson.com/epson-connect-wireless-printing-partner-solutions?pg=7#sn
https://www.epson.ca/epson-connect-wireless-printing-partner-solutions?pg=7#sn
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4. Touch the NFC antenna of your Android device to the NFC tag on your product.

Note: The location of your mobile device's NFC antenna varies. See your mobile device
documentation for details.

Epson iPrint opens on your device.

Note: If you do not have Epson iPrint installed, the app store page for the Epson iPrint app opens on
your device. Install Epson iPrint and repeat this step.

5. Touch the NFC antenna of your Android device to the product NFC tag on your product again.
The printer and Android device connect.

Note: If the Android device and product disconnect, try to print or scan a document. The Android
device and product should reconnect automatically.

6. If you are going to print, open the file you want to print in Epson iPrint.
7. Touch the NFC antenna of your Android device to the NFC tag on your product to start printing or

scanning.
Parent topic: Product Basics
Related tasks
Using the Epson iPrint Mobile App
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Wi-Fi or Wired Networking
See these sections to use your product on a Wi-Fi or wired network.
Network Security Recommendations
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Configuring Email Server Settings
Changing or Updating Network Connections

Network Security Recommendations
To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.
Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:
• Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

• Connect your product only to a network protected by a firewall
Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

• Change the default administrator password on your product
If your product has an option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi or Wired Networking
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Wi-Fi Infrastructure Mode Setup
You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2 Wireless router or access point
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings from the Control Panel
Parent topic: Wi-Fi or Wired Networking
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Selecting Wireless Network Settings from the Control Panel
You can select or change wireless network settings using your product control panel.
To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software by downloading it from the Epson website. The installer program guides you
through network setup.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

1. Press the home button, if necessary.

2. Press the icon.
You see a screen like this:

3. Select Router.
4. Select Start Setup, Change Settings, or Change to Wi-Fi Connection, depending on your current

connection settings.
5. Select Wi-Fi Setup Wizard.
6. Select the name of your wireless network or select Enter Manually to enter the name manually. Use

the displayed keypad to enter your network name.
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7. Select the Password field and enter your wireless password using the displayed keypad.

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

• To move the cursor, press the left or right arrows.

• To change the case of letters, press .

• To delete the previous character, press .

• To enter numbers and symbols, press .
• To enter a space, press Space.

8. Press OK when you finish entering your password.
9. Confirm the displayed network settings and select Start Setup to save them.
10. If you want to print a network setup report, select Print Check Report. (Otherwise, select OK.)
11. Press the home button to exit.

You see the icon on the LCD screen and should be able to connect to your product directly from
your computer or device, and then print. If you are printing from a computer, make sure you installed
the network software as described on the Start Here sheet.

Note: If you don't see the icon, you may have selected the wrong network name or entered the
password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Infrastructure Mode Setup



75

Related references
Status Icon Information
Related tasks
Entering Characters on the LCD Screen

Wi-Fi Direct Mode Setup
You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network
access point for up to 4 devices.

1 Epson product
2 Computer with a wireless interface
3 Other wireless device

Enabling Wi-Fi Direct Mode
Parent topic: Wi-Fi or Wired Networking

Enabling Wi-Fi Direct Mode
You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point.
1. Press the home button, if necessary.
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2. Press the icon.
You see a screen like this:

3. Select Wi-Fi Direct.
4. Scroll down and select Start Setup.
5. Select Start Setup again.

You see a screen like this:

6. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the
LCD screen, then enter the password shown.

7. Press the home button to exit.

You see the icon on the LCD screen and should be able to connect to your product directly
from your computer or device, and then print. If you are printing from a computer, make sure you
installed the network software as described on the Start Here sheet.
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Note: If you don't see the icon on the LCD screen, you may have selected the wrong network
name or entered the password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup
Related references
Status Icon Information
Related tasks
Entering Characters on the LCD Screen

Wi-Fi Protected Setup (WPS)
If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network
If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.
1. Press the home button, if necessary.

2. Press the icon.
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You see a screen like this:

3. Select Router, then select Start Setup, Change Settings, or Change to Wi-Fi connection,
depending on your current connection settings.

4. Select Push Button Setup (WPS).
5. Follow the instructions on the LCD screen to complete WPS setup.
6. Press the home button to exit.

You see the icon on the LCD screen and should be able to connect to your product directly from
your computer or device, and then print. If you are printing from a computer, make sure you installed
the network software as described on the Start Here sheet.

Note: If you don't see the icon, repeat these steps to try again.

Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet
You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.
1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.
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You see a screen like this:

4. Select Network Settings.
5. Select Network Status.
6. Select Print Status Sheet.
7. Select Print.
Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking

Configuring Email Server Settings
To use features such as scanning to email or forwarding faxes to email, you need to configure the email
server. You can select settings for the email server using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.
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You see a screen like this:

4. Select Network Settings.
5. Scroll down and select Advanced.
6. Select Email Server.
7. Select Server Settings.

You see a screen like this:

8. Select one of the options shown above, then select the settings you want to use. Contact your
internet service provider if necessary to confirm the authentication method for the email server.

9. Select Proceed to save your settings.
10. Select Close to exit.
11. Select Connection Check to verify the connection to the email server.
Parent topic: Wi-Fi or Wired Networking
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Related tasks
Scanning to Email
Forwarding Received Faxes

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.
Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features
Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility
You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: For more information on administration settings, see the Administrator's Guide.

1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web

browser.
4. Enter your product's IP address into the address bar.

You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.
1. Disconnect the USB cable from your product.
2. Uninstall your product software.

https://files.support.epson.com/docid/cpd5/cpd55701/index.html
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3. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection
If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.
1. Disable your product's Wi-Fi features.
2. Connect one end of an Ethernet network cable to the product's LAN port.
3. Connect the other end to any available LAN port on your router or access point.
4. Uninstall your product software.
5. Download and install your product software from the Epson website.
6. Follow the on-screen instructions to install the software.
7. When you see the Select Your Connection screen, select Wired network connection.
8. If you see a Select Setup Option screen, select Set up printer for the first time.
9. Continue following the rest of the on-screen instructions.
Parent topic: Changing or Updating Network Connections
Related tasks
Disabling Wi-Fi Features

Connecting to a New Wi-Fi Router
If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

1. Do one of the following:
• Windows: Uninstall your product software.
• Mac: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.
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Parent topic: Changing or Updating Network Connections
Related tasks
Uninstalling Product Software - Windows

Disabling Wi-Fi Features
You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the home button, if necessary.

2. Press the icon.
You see a screen like this:

3. Select Router.
4. Select Change Settings.
5. Select Others.
6. Select Disable Wi-Fi.
7. Select Yes to disable Wi-Fi.
Parent topic: Changing or Updating Network Connections
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Enabling Epson Universal Print Driver (PCL) or PostScript
Printing

Before enabling Epson Universal Print Driver (PCL) or PostScript printing on your product, make sure
you have installed the software as described on the Start Here sheet.
To download the Epson Universal Print Driver or PostScript drivers, visit epson.com/support (U.S.),
epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.
Installing the Epson Universal Print Driver - Windows
Installing the PostScript (PS3) Printer Software - Windows
Installing the PostScript (PS3) Printer Software - Mac
Selecting PDL (Page Description Language) Settings
Selecting Printer Language and Interface Settings
Printing a PCL or PS3 (PostScript) Status Sheet

Installing the Epson Universal Print Driver - Windows
The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and
can be installed on a Windows computer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software. Depending on your model, not all printer languages may be supported.

1. To download the EPSON Universal Print Driver file, visit epson.com/support (U.S.),
epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

2. Double-click the downloaded package.

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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3. Follow the on-screen instructions until you see this screen:

4. Select Yes: Network connection and click OK.

Note: Select the Set Default of Printer Control Language to PCL6 checkbox if you want to set the
default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-
R. (You can change this setting later as needed.)
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After the software finishes searching for products, you see a screen like this:

5. Do one of the following:
• If you are installing one product, make sure Add EPSON Universal Print Driver is selected and

continue with the next step.
• If you are installing more than one product, select Add found printers and go to step 9.

Note: You can customize and filter your product search results by clicking Display Settings.
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6. Open the Select a port to connect a printer menu and select an existing printer port, if necessary.
Otherwise, skip this option to create a new port automatically.

7. Select the product you want to install from the Found Printers list.

Note: Deselect the Set as default printer checkbox if you do not want the product to be set as your
default printer.

8. Click OK, then skip the remaining steps.
9. If you are installing more than one product, select the products from the Found Printers list and click

Add to Printer Folder.
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The selected products appear in the lower section of the screen.
10. Select the checkbox next to the product you want to make your default printer, if necessary.
11. Click OK.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Installing the PostScript (PS3) Printer Software - Windows
If you did not install the standard Epson printer software or Epson Universal Print Driver, you need to
install the PostScript (PS3) printer software before you can adjust the print settings and print to your
network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. To download the Drivers and Utilities Combo Package - PS3 PostScript file, visit
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and
select your product.

2. Double-click the downloaded package.
3. Click OK.
4. Click Accept.
5. Click Install.
6. Click Next and follow the on-screen instructions.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Installing the PostScript (PS3) Printer Software - Mac
If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. To download the Drivers and Utilities Combo Package - PS3 PostScript file, visit
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and
select your product.

2. Double-click the downloaded package.

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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3. Double-click EPSON.
4. Click Continue on the next two screens.
5. Click Agree.
6. Click Install.
7. If necessary, enter the administrator password.
8. Click Start and follow the on-screen instructions.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Selecting PDL (Page Description Language) Settings
You can select settings for PCL and PostScript printing using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Printer Settings.
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You see a screen like this:

5. Select PDL Print Configuration.
You see a screen like this:

6. Select one of the options shown above, then select the PDL print configuration options you want to
use.

7. When you are finished, press the home button to exit.
PDL Print Configuration Options
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

PDL Print Configuration Options
Select the PDL Print Configuration options you want to use for PCL or PostScript printing.



91

PDL Print Configuration
option

Available
settings

Description

Common Settings
Paper Size Various sizes Sets the default paper size for PCL or PostScript

printing
Paper Type Various paper

types
Sets the default paper type for PCL or PostScript
printing

Orientation Portrait Sets the default orientation for PCL or PostScript
printingLandscape

Quality Draft Sets the quality for PCL or PostScript printing
Standard
Best

Ink Save Mode On/Off Saves ink by reducing print density
Print Order Last Page on

Top
Starts printing from the first page of a file

First Page on
Top

Starts printing from the last page of a file

Number of Copies 1 to 999 Selects the number of copies to print
Binding Margin Left Edge Specifies the binding edge for double-sided documents

Top Edge
Auto Paper Ejection On/Off Ejects paper automatically when printing is stopped

during a print job
2-Sided Printing On/Off Selects duplex printing
PCL Menu
Font Source Resident Uses a font preinstalled on the printer

Download Uses a font you have downloaded
Font Number 1 to 111 Selects the default font number for the default font

source
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PDL Print Configuration
option

Available
settings

Description

Pitch 0.44 to 99.99 cpi Selects the default font pitch if the font is scalable and
fixed-pitch (availability depends on font source and
number settings)

Height 4.00 to 999.75 pt Selects the default font height if the font is scalable and
proportional (availability depends on font source and
number settings)

Symbol Set Various Selects the default symbol set. If the selected font is not
available for the selected symbol set, the font source
and number are replaced with IBM-US (the default
setting).

Form 5 to 128 lines Sets the number of lines for the selected paper size and
orientation. Changes the line spacing (VMI) stored in
the printer. Later changes in page size or orientation
cause changes in the Form value based on the stored
VMI.

CR Function CR Selects the carriage return and line feed commands
when printing with a driver from a specific operating
systemCR+LF

LF Function LF
CR+LF

Paper Source Assign 4 Makes the paper source select command compatible
with HP LaserJet 4

4K Makes the paper source select command compatible
with HP LaserJet 4000, 5000, and 8000

5S Makes the paper source select command compatible
with HP LaserJet 5S

PS3 Menu
Error Sheet On/Off Prints a sheet showing the status when errors occur

during PostScript or PDF printing
Coloration Color Selects the color mode for PostScript printing

Mono
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PDL Print Configuration
option

Available
settings

Description

Binary On/Off Enable when printing files that contain binary images
(available when the product is connected to the
network). Allows you to print binary images even if the
driver is set to ASCII.

PDF Page Size Various sizes Selects the paper size when printing a PDF file. If Auto
is selected, the paper size is determined based on the
size of the first page.

Parent topic: Selecting PDL (Page Description Language) Settings

Selecting Printer Language and Interface Settings
You can select printer language and interface settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Printer Settings.
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You see a screen like this:

5. To change interface settings, scroll down and select the interface options for your connection type.
6. To select printer language settings, select Printing Language and select the printing language for

your connection type.
7. When you are finished, press the home button to exit.
Printing Language and Interface Options
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Printing Language and Interface Options
Select the printing language and interface options you want to use.

Option Available
settings

Description

PC Connection via USB Enable Select whether to allow USB communication with the
productDisable

USB I/F Timeout Setting 0.5 to 300
seconds

Specify the length of time before ending USB
communication from a computer using the PCL or
PostScript driver. This setting is necessary to avoid
endless USB communication.
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Option Available
settings

Description

Printing Language Auto Select the language for the USB or network interface
PCL
PS3
PDF

Parent topic: Selecting Printer Language and Interface Settings

Printing a PCL or PS3 (PostScript) Status Sheet
You can print a PCL or PS3 (PostScript) status sheet to confirm the current font information.
1. Press the home button, if necessary.
2. Select Settings.

You see a screen like this:

3. Scroll down and select Print Status/Print.
4. Select Print Status Sheet.
5. Select PCL Font List or PS3 Font List.
6. Select Print to print the status sheet.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing
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Loading Paper
Before you print, load paper for the type of printing you will do.
Loading Paper in the Cassette
Loading Paper and Envelopes in the Rear Paper Feed Slot
Paper Loading Capacity
Double-sided Printing Paper Types
Available Epson Papers
Paper or Media Type Settings - Printing Software
Selecting the Paper Settings for Each Source - Control Panel
Selecting Default Paper Settings - Administrator

Loading Paper in the Cassette
You can load paper up to this size in the paper cassette: A3 (11.7 × 16.5 inches [297 × 420 mm])

Note: If the optional paper cassette units are installed, do not remove more than one cassette at a time.

1. Make sure the product is not operating and pull out the paper cassette.
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2. Slide the front edge guide outward all the way, then slide the side edge guides to the paper size you
are using.

3. Load paper with the printable side facedown and slide the front edge guide against the paper.

Note: Make sure the paper fits beneath the arrow mark inside the edge guides.
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4. Make sure the paper size label matches the size of the paper loaded in the paper cassette. If
necessary, remove the label holder and change the paper size indicated on the label.

5. Insert the paper cassette all the way into the product.

Note: If the Paper Size Auto Detect setting is enabled, your product will automatically detect the
size of the paper you loaded.

6. If necessary, press the Paper Setting button and select the size and type of paper you loaded
on the product LCD screen.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, no matter which way your document faces.
• Load the printable side facedown.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guides.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Specifications
Paper Loading Capacity
Related tasks
Loading Paper and Envelopes in the Rear Paper Feed Slot
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Loading Paper and Envelopes in the Rear Paper Feed Slot
You can print envelopes or documents in a variety of paper types and sizes in the rear paper feed slot.
1. Open the feeder guard and pull up the paper support.

2. Slide the edge guides outward.
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3. If you are inserting a stack of paper, fan the sheets and tap the stack on a flat surface to even the
edges.

Note: You can load one sheet of binder paper with holes on one of the long edges as shown. Do not
select automatic 2-sided printing for this type of paper.

4. Do one of the following:
• Insert paper, glossy or printable side up and short edge first, in the center of the slot.

Caution: To prevent paper feeding problems, make sure you do not load paper above the arrow
marks inside the edge guides.
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• Load envelopes short edge first, with the flap facing down and the flap edge to the left, in the
center of the slot.

5. Slide the edge guides against the paper, but not too tightly.

6. Press the Paper Setting button.
You see a screen like this:
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7. Select the size and type of paper you loaded.
Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, except when the long edge is set as the width of a user-defined paper

size.
• Load the printable side faceup.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guides.
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one

envelope at a time.
• If print quality declines when printing multiple envelopes, try loading one envelope at a time.
• Do not load envelopes that are curled, folded, or too thin.
• Do not use envelopes with adhesive surfaces on the flaps or window envelopes.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Specifications
Paper Loading Capacity
Related tasks
Loading Paper in the Cassette

Paper Loading Capacity
As described in the tables below, do not load paper in the paper cassettes above the arrow marks on the
side edge guides.

Standard and Thick Paper Capacity - Rear Paper Feed Slot
You can load up to the following number of standard paper (17 to 24 lb [64 to 90 g/m2]) sheets in the rear
paper feed slot:
• 85 sheets for available paper sizes* from A6 (4.1 × 5.8 inches [105 × 148 mm]) to Legal (8.5 × 14

inches [216 × 356 mm])
• 50 sheets for available paper sizes* 11 × 17 inches (279 × 432 mm) and larger
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• Load only 1 sheet for user-defined size paper from 2.16 x 5 inches (55 x 127 mm) to 12.95 x 47.24
inches (329 x 1200 mm) and 5.8 x 8.27 inches (148 x 210 mm) to 11.7 x 17 inches (297 x 431.8 mm)

• 10 envelopes

Note: Printing on user-defined paper sizes is available only when printing from a computer.

You can load up to the following number of thick paper (25 to 68 lb [91 to 256 g/m2]) sheets in the rear
paper feed slot:
• 10 sheets for available paper sizes* from A6 (4.1 × 5.8 inches [105 × 148 mm]) to A3 (11.7 × 16.5

inches [297 × 420 mm])
• Load only 1 sheet for user-defined size paper between 2.16 x 5 inches (55 x 127 mm) to 12.95 x 47.24

inches (329 x 1200 mm)
• Load only 1 sheet for user-defined size paper between 5.8 x 8.27 inches (148 x 210 mm) to 11.7 x 17

inches (297 x 431.8 mm); 25 to 40 lb (91 to 150 g/m2) only

Note: Double-sided printing is not available for thick paper between 41 to 68 lb (151 to 256 g/m2).
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Paper type Paper size Loading capacity
Cassette 1 Cassettes 2-4

(optional)
Plain paper
Letterhead paper
Recycled paper
Colored paper
Pre-printed paper
High-quality plain paper
Copier paper

Available paper sizes*
from Executive
(7.25 × 10.5 inches
[184 × 267 mm]) to A3
(11.7 × 16.5 inches
[297 × 420 mm])
User defined (5.8 × 8.27
inches [148 × 210 mm]
to 11.7 × 17 inches [297
× 431.8 mm])

Up to the arrow mark on the edge guide

Half Letter (5.5 × 8.5
inches [140 × 216 mm])
A6 (4.1 × 5.8 inches
[105 × 148 mm])
User defined (4.1 × 5.8
inches [105 × 148 mm]
to 11.7 × 17 inches [297
× 431.8 mm])

Up to the arrow mark on
the edge guide

—
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Paper type Paper size Loading capacity
Cassette 1 Cassettes 2-4

(optional)
Thick paper (25 to 53 lb
[91 to 200 g/m2])

Available paper sizes*
from Executive
(7.25 × 10.5 inches
[184 × 267 mm]) to A3
(11.7 × 16.5 inches
[297 × 420 mm])
User defined (5.8 × 8.27
inches [148 × 210 mm]
to 11.7 × 17 [297
× 431.8 mm])

120 200

Half Letter (5.5 × 8.5
inches [140 × 216 mm])
A6 (4.1 × 5.8 inches
[105 × 148 mm])
User-defined (4.1 × 5.8
inches [105 × 148 mm]
to 11.7 × 17 inches [297
× 431.8 mm])

120 —

* Select the paper specification link below to view the list of available paper sizes.

Note: Folio (8.5 × 13 inches [216 × 330 mm]) and Half Letter (5.5 × 8.5 inches [140 × 216 mm]) sizes are
not available when printing with the PostScript printer driver.

Epson Paper Capacity

Paper type Loading capacity
Cassette 1 Cassettes 2-4

(optional)
Rear paper feed slot

Epson Bright White
Paper

200 sheets 400 sheets 50 sheets
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Paper type Loading capacity
Cassette 1 Cassettes 2-4

(optional)
Rear paper feed slot

Epson Presentation
Paper Matte

— — 70 sheets: Letter (8.5 × 11
inches [216 × 279 mm]), A4
(8.3 × 11.7 inches
[210 × 297 mm])
50 sheets: 11 × 17 inches
(279 × 432 mm), A3
(11.7 × 16.5 inches
[297 × 420 mm])

Epson Premium
Presentation Paper
Matte

— — 20 sheets: Letter (8.5 × 11
inches [216 × 279 mm]), A4
(8.3 × 11.7 inches
[210 × 297 mm]), 8 × 10
inches (203 × 254 mm)
10 sheets: A3 (11.7 × 16.5
inches [297 × 420 mm]),
13 × 19 inches
(330 × 483 mm)

Epson Ultra Premium
Photo Paper Glossy

— — 20 sheets: Letter (8.5 × 11
inches [216 × 279 mm]), A4
(8.3 × 11.7 inches
[210 × 297 mm]), 8 × 10
inches (203 × 254 mm),
5 × 7 inches
(127 × 178 mm), 4 × 6
inches (102 × 152 mm)
10 sheets: A3 (11.7 × 16.5
inches [297 × 420 mm]),
13 × 19 inches
(330 × 483 mm)
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Paper type Loading capacity
Cassette 1 Cassettes 2-4

(optional)
Rear paper feed slot

Epson Premium Photo
Paper Glossy

— — 20 sheets: Letter (8.5 × 11
inches [216 × 279 mm]), A4
(8.3 × 11.7 inches
[210 × 297 mm]), 8 × 10
inches (203 × 254 mm),
5 × 7 inches
(127 × 178 mm), 4 × 6
inches (102 × 152 mm)
10 sheets: 11 × 17 inches
(279 × 432 mm), A3
(11.7 × 16.5 inches
[297 × 420 mm]), 13 × 19
inches (330 × 483 mm)

Epson Premium Photo
Paper Semi-gloss

— — 20 sheets: Letter (8.5 × 11
inches [216 × 279 mm]),
4 × 6 inches (102 × 152 mm)
10 sheets: 13 × 19 inches
(330 × 483 mm)

Epson Photo Paper
Glossy

— — 20 sheets: Letter (8.5 × 11
inches [216 × 279 mm]), A4
(8.3 × 11.7 inches
[210 × 297 mm]), 4 × 6
inches (102 × 152 mm)
10 sheets: 11 × 17 inches
(279 × 432 mm), 13 × 19
inches (330 × 483 mm)

Note: When printing at a user defined size on genuine Epson paper, you can only print at Standard or
Normal print quality. Even if the print driver allows you to choose a better print quality, the printer will
print using Standard or Normal print quality.

Parent topic: Loading Paper
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Related references
Paper Specifications

Double-sided Printing Paper Types
Check the table below to see which papers are available for printing double-sided.

Paper type Double-sided Printing
Plain paper
Copier paper
Letterhead paper
Recycled paper
Colored paper
Pre-printed paper
High quality plain paper
Thick paper 25 to 40 lb (91 to 150 g/m2)
Epson Bright White Paper

Yes

Epson Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss
Epson Photo Paper Glossy
Epson Premium Presentation Paper Matte
Epson Presentation Paper Matte
Thick paper 41 to 68 lb (151 to 256 g/m2)
Envelopes

No

Parent topic: Loading Paper
Related tasks
Selecting Double-sided Printing Settings - Windows
Selecting Double-sided Printing Settings - Mac
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Available Epson Papers
You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales),
epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from
an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S.
or 800-807-7766 in Canada.

Note: Paper/media availability varies by country.

Paper Type Size Part number Sheet count
Epson Bright White Paper Letter (8.5 × 11 inches

[216 × 279 mm])
S041586 500

Epson Presentation Paper Matte Legal (8.5 × 14 inches
[216 × 356 mm])

S041067 100

Letter (8.5 × 11 inches
[216 × 279 mm])

S041062 100

A3 (11.7 × 16.5 inches
[297 × 420 mm])

S041069-L 100

11 × 17 inches
(279 × 432 mm)

S041070 100

Epson Premium Presentation
Paper Matte

8 × 10 inches (203 × 254 mm) S041467 50
Letter (8.5 × 11 inches
[216 × 279 mm])

S041257
S042180

50
100

13 × 19 inches
(330 × 483 mm)

S041263 50

A3 (11.7 × 16.5 inches
[297 × 420 mm])

S041260 50

https://www.epson.com
https://www.epson.ca
https://epson.com.jm
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Paper Type Size Part number Sheet count
Epson Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809

S042038
50
100

Letter (8.5 × 11 inches
[216 × 279 mm])

S041141
S041649
S041271

20
50
100

A4 (8.3 × 11.7 inches
[210 × 297 mm])

S041140 20

11 × 17 inches
(279 × 432 mm)

S041156 20

13 × 19 inches
(330 × 483 mm)

S041143 20

Epson Premium Photo Paper
Glossy

4 × 6 inches (102 × 152 mm) S041727 100
5 × 7 inches (127 × 178 mm) S041464 20
8 × 10 inches (203 × 254 mm) S041465 20
Letter (8.5 × 11 inches
[216 × 279 mm])

S042183
S041667

25
50

11 × 17 inches
(279 × 432 mm)

S041290 20

A3 (11.7 × 16.5 inches
[297 × 420 mm])

S041288 20

13 × 19 inches
(330 × 483 mm)

S041289 20

Epson Ultra Premium Photo Paper
Glossy

4 × 6 inches (102 × 152 mm) S042181
S042174

60
100

5 × 7 inches (127 × 178 mm) S041945 20
8 × 10 inches (203 × 254 mm) S041946 20
Letter (8.5 × 11 inches
[216 × 279 mm])

S042182
S042175

25
50
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Paper Type Size Part number Sheet count
Epson Premium Photo Paper
Semi-gloss

4 × 6 inches (102 × 152 mm) S041982 40
Letter (8.5 × 11 inches
[216 × 279 mm])

S041331 20

13 × 19 inches
(330 × 483 mm)

S041327 20

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software
For this paper Select this Paper Type or Media Type setting
Plain paper
Epson Bright White Paper

Plain Paper / Bright White Paper

Letterhead paper Letterhead
Recycled paper Recycled
Colored paper Color
Pre-printed paper Preprinted
High-quality plain paper High Quality Plain Paper
Envelopes Envelope
Epson Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Glossy Premium Photo Paper Glossy
Epson Photo Paper Glossy Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
Epson Presentation Paper Matte
Epson Premium Presentation Paper Matte

Premium Presentation Paper Matte

Thick paper (25 to 40 lb [91 to 150 g/m2]) Card Stock 1
Thick paper (41 to 53 lb [151 to 200 g/m2]) Card Stock 2
Thick paper (54 to 68 lb [201 to 256 g/m2]) Card Stock 3
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Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper

Selecting the Paper Settings for Each Source - Control Panel
You can change the default paper size and paper type for each source using the control panel on the
product.
1. Press the Paper Setting button.

You see a screen like this:

2. Select the paper source you want to select settings for.
You see a screen like this:

3. Select Paper Size.
4. Select the paper size you loaded.



113

5. Select Paper Type.
6. Select the paper type for the paper you loaded.
7. Turn on the Paper Size Auto Detect setting to automatically detect the size of the paper loaded in

the paper source.
8. Select another paper source to change or press the home button to exit.
Paper Type Settings - Control Panel
Parent topic: Loading Paper

Paper Type Settings - Control Panel
Select a Paper Type setting that matches the paper you loaded.

Paper type loaded Paper Type setting
Plain paper
Epson Bright White Paper

Plain Paper

Letterhead paper Letterhead
Recycled paper Recycled
Colored paper Color
Pre-printed paper Preprinted
High-quality plain paper High Quality Plain Paper
Envelopes Envelope
Epson Ultra Premium Photo Paper Glossy Ultra Glossy
Epson Premium Photo Paper Glossy Prem. Glossy
Epson Photo Paper Glossy Glossy
Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss
Epson Presentation Paper Matte
Epson Premium Presentation Paper Matte

Prem. Matte

Thick paper up to 25 to 40 lb (91 to 150 g/m2) Card Stock 1
Thick paper up to 41 to 53 lb (151 to 200 g/m2) Card Stock 2
Thick paper up to 54 to 68 lb (201 to 256 g/m2) Card Stock 3
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Parent topic: Selecting the Paper Settings for Each Source - Control Panel

Selecting Default Paper Settings - Administrator
As an administrator, you can adjust default paper settings that apply to all print jobs sent to the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Selecting the Default Printer Settings
Selecting the Universal Print Settings
Parent topic: Loading Paper

Selecting the Default Printer Settings
You can change default printer settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Printer Settings.
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You see a screen like this:

5. Select one of these options for the Auto Error Solver setting:
• Turn on this setting to display a warning and print single-sided when a 2-sided printing error

occurs, or to print only what the printer could process when a full memory error occurs.
• Turn off this setting to display an error message and stop printing if an error occurs.

6. Select Paper Source Settings.
7. Select the Paper Source Settings options you want to use.
8. When you are finished, press the home button to exit.
Paper Source Settings Options
Parent topic: Selecting Default Paper Settings - Administrator

Paper Source Settings Options
Select the paper source options you want to use for your print jobs.

Paper Source
Settings option

Available settings Description

Paper Setting Various Select the paper size and type for each paper source
Rear Paper Feed
Priority

On Select On to give printing priority to paper loaded in the rear
paper feed slotOff

A4/Letter Auto
Switching

On Select On to switch the selected paper size to match the
loaded paper (Letter or A4) if the wrong size is selectedOff
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Paper Source
Settings option

Available settings Description

Auto Select
Settings

Copy Select On for any of these settings to automatically print on
paper from any source containing paper that matches your
paper settings

Note: More than one paper source needs to be set to On.

Fax
Other

Error Notice Paper Size Notice Select On for either of these settings to display an error
message when the selected paper type or size does not
match the loaded paperPaper Type Notice

Paper Setup
Auto Display

On Select On to automatically display a menu that lets you
select the paper size and type when you load paper in the
productOff

Parent topic: Selecting the Default Printer Settings

Selecting the Universal Print Settings
You can change the default universal print settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see this screen:
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4. Select Printer Settings.
You see this screen:

5. Select Universal Print Settings.
6. Adjust the settings as necessary.
7. When you are finished, press the home button to exit.
Universal Print Settings Options
Parent topic: Selecting Default Paper Settings - Administrator

Universal Print Settings Options
Select the universal print setting options you want to use for your print jobs.

Universal Print
Settings option

Available settings Description

Top Offset — Adjust the top or left margin
Left Offset
Top Offset in
Back

— Adjust the top or left margin of the back page when printing
double-sided

Left Offset in
Back
Check Paper
Width

On Select On to check the paper width before printing. This
prevents printing beyond the edges of the paper when the
paper size settings are incorrect, but may reduce the
printing speed.

Off
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Universal Print
Settings option

Available settings Description

Skip Blank Page On Select On to skip printing of blank pages automatically
Off

Parent topic: Selecting the Universal Print Settings
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Placing Originals on the Product
Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damaging it.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder

Placing Originals on the Scanner Glass
You can place originals up to this size on the scanner glass: A3 (11.7 × 16.5 inches [297 × 420 mm]).

Note: When originals are placed in the ADF and on the scanner glass, priority is given to the originals in
the ADF.

1. Open the document cover.
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2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the
original to the edges of the indicated corner.

Note: The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the
scanner glass.

3. Close the document cover gently to keep your original in place.

Caution: Do not push down on the document cover or scanner glass or you may damage the
product.

Remove your originals after scanning. If you leave the originals on the scanner glass for a long time, they
may stick to the glass surface.
Parent topic: Placing Originals on the Product
Related topics
Copying
Scanning
Faxing

Placing Originals in the Automatic Document Feeder
You can place single- or multi-page original documents in the Automatic Document Feeder (ADF). You
can also use the ADF to scan both sides of a 2-sided document. Make sure the originals meet the
Automatic Document Feeder specifications before loading them.
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Caution: Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or
other materials that could obstruct the feeder.

Caution: Do not place photographs or valuable artwork in the ADF. Place fragile or valuable originals on
the scanner glass to avoid wrinkling or damaging them.

Note: When originals are placed in the ADF and on the scanner glass, priority is given to the originals in
the ADF.

1. Slide the ADF edge guides outward.

2. Fan your stack of originals and tap them gently on a flat surface to even the edges.
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3. Insert the originals into the ADF faceup and top-edge first.
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Note: Do not load originals above the arrow mark on the ADF edge guide.

The ADF icon on the Copy, Scan, and Fax screens lights up.

Note: The ADF should automatically detect the size of your original. If the document size isn't
automatically detected, you need to manually select it.
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4. Slide the ADF edge guides against the originals, but not too tightly.
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Note: If you are copying two originals onto one sheet, make sure the originals are loaded as shown.
Select the link below to select the copy orientation setting that matches how you loaded your
original.

Parent topic: Placing Originals on the Product
Related references
Mac System Requirements
Copying Options
Related topics
Copying
Scanning
Faxing



126

Copying
See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying Options

Copying Documents or Photos
You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.
1. Place your original document or photo on the scanner glass, or place multi-page documents in the

ADF.
2. Load the paper you want to print on.
3. Press the home button, if necessary.
4. Select Copy.

You see a screen like this:

5. To print more than one copy, press a number key on the product's control panel, or select Copies
and use the displayed keypad to enter the number of copies.

6. Change any of the displayed settings as necessary.
7. Select Advanced to view and change additional copy settings, if necessary.
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8. Select Preview to preview your copy on the LCD screen.
9. Select Presets to save your copy settings.

Note: Presets can be locked by an administrator. If you can't access or change this setting, contact
your administrator for assistance.

10. When you are ready to copy, press the Copy icon.

Note: To cancel printing, press the stop button or select Cancel.

Parent topic: Copying
Related references
Copying Options
Related tasks
Using Presets
Related topics
Loading Paper
Placing Originals on the Product

Copying Options
Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Basic Settings

Copying option Available settings Description
B&W — Copies the document in black and white
Color — Copies the document in color
Paper Setting Various sources Select the paper source that you want to use. If you select

Auto, paper is fed automatically depending on the paper
settings you selected for the paper sources.

Original Size Various sizes Select the document size of your original
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Copying option Available settings Description
Density Varying levels Adjusts the lightness or darkness of copies
Reduce/Enlarge Reduce to Fit Paper Automatically decreases the size of the image by the

percentage you select
100% Copies the original at its full size
Auto Automatically sizes the image to fit the paper size you

selected
50%->200% and
other conversions

Automatically converts from one size to another

2-Sided 1>1-Sided Select to make 2-sided copies. When you select 1>2-Sided
or 2>1-Sided, scroll down and select the orientation and
binding edge for your originals or copies.2>2-Sided

1>2-Sided
2>1-Sided

Advanced settings

Copying option Available settings Description
Multi-Page Single Page Copies each page of the original onto an individual sheet

2-up Copies multiple page documents onto one sheet. Scroll
down and select the document orientation and layout order
settings as necessary.4-up

Original Type Text Specifies the document type of your originals and adjusts
the quality of your copiesText & Image

Photo
Text & Image(Best)
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Copying option Available settings Description
Finishing Group (Same

Pages)
Select to print multiple copies of a multi-page document in
unordered groups

Collate (Page
Order)

Select to print multiple copies of a multi-page document in
ordered sets

Mixed Size
Originals

Off Select On to copy originals of varying sizes in their original
sizesOn

Orientation
(Original)

Up Direction Specifies the orientation of your originals
Left Direction

Book>2Pages Off Select On to copy two pages of a book onto separate sheets
of paperOn

Image Quality Various settings Select advanced quality settings such as Saturation and
Sharpness

Binding Margin Off Select On to adjust the margin and orientation of the pages
when copying a bookOn

Reduce to Fit
Paper

Off Select On to automatically decrease the image by the
percentage you selectOn

Remove Shadow Off Select On to erase the shadows that appear in the center of
a document when copying a book or that appear around a
document when copying thick paperOn
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Copying option Available settings Description
Remove Punch
Holes

Off Select On to erase the binding holes on a document. Scroll
down and select the erasing position and orientation for your
originals or copies.On

ID Card Copy Off Select On to copy both sides of an ID card onto one side of
a sheet of paper. Select the orientation for your originals or
copies.On

Parent topic: Copying
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Printing from a Computer
Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with the Standard Epson Printer Software - Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing with the Epson Standard Printer Software - Mac
Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows
Printing with the PostScript (PS3) Printer Software - Mac
Cancelling Printing Using a Product Button

Printing with the Standard Epson Printer Software - Windows
You can print with the standard Epson printer software using any Windows printing program, as
described in these sections.
Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Locking Printer Settings - Windows
Entering a User ID and Password for Printing
Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing from a Computer
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Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:
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4. For the Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.
9. Select a Color option:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black or shades of gray, select the Black/Grayscale setting.

10. To print on both sides of the paper, select the 2-Sided Printing setting and select the options you
want.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the Copies options.
13. To preview your job before printing, select Print Preview.
14. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
15. To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the

Quiet Mode menu.

Note: Enabling Quiet Mode may reduce printing speed.

Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows
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Parent topic: Printing with the Standard Epson Printer Software - Windows
Related references
Double-sided Printing Paper Types
Paper or Media Type Settings - Printing Software
Related tasks
Entering a User ID and Password for Printing
Printing Your Document or Photo - Windows

Paper Source Options - Windows
You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Note: Paper Cassette 2 through Paper Cassette 4 are available only if you have installed the optional
cassettes.

Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette 1
Selects the paper in cassette 1 as the paper source.

Paper Cassette 2
Selects the paper in cassette 2 as the paper source.

Paper Cassette 3
Selects the paper in cassette 3 as the paper source.

Paper Cassette 4
Selects the paper in cassette 4 as the paper source.

Rear Paper Feed
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on plain paper.
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Standard
For everyday text and image printing.

High
For photos and graphics with high print quality.

Parent topic: Selecting Basic Print Settings - Windows
Multi-Page Printing Options - Windows

You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
• Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper

on the long edge.
• Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper

on the short edge.
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• Manual (Long-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the long edge to print the other side (recommended for
paper types that do not support automatic duplexing).

• Manual (Short-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the short edge to print the other side (recommended for
paper types that do not support automatic duplexing).

2. Click the Settings button.
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You see this window:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
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5. Click the Print Density button.
You see this window:

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.
8. Click OK to return to the Main tab.
9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options - Windows
Print Density Adjustments - Windows
Parent topic: Printing with the Standard Epson Printer Software - Windows
Related references
Double-sided Printing Paper Types
Related tasks
Selecting Basic Print Settings - Windows
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Double-sided Printing Options - Windows
You can select any of the available options on the Binding Settings window to set up your double-sided
print job.
Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.
Binding Margin Options

Select options that define a wider margin to allow for binding.
Start Page

Selects whether printing starts on the front or back page.
Create Folded Booklet Options

Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.
Parent topic: Selecting Double-sided Printing Settings - Windows

Print Density Adjustments - Windows
You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.
Print Density

Sets the level of ink coverage for double-sided printing.
Increase Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your

document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Color Correction options:
• Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation

for your image.
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• Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

• Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:

• Watermark: adds a visible watermark to your printout

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

• Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.
Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
Parent topic: Printing with the Standard Epson Printer Software - Windows
Related tasks
Printing Your Document or Photo - Windows
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Custom Color Correction Options - Windows
You can select any of the available options in the Color Correction window to customize the image colors
for your print job.

Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.
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ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options
Emphasize Text

Adjusts the weight of printed text to increase readability.
Emphasize Thin Lines

Adjusts the weight of printed lines to increase visibility.
Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Fix Red-Eye

Reduces or removes red-eye in photos.
Print Text in Black

Prints colored text in black.
For Color Text

Prints colored text on a background pattern or underlined.
For Color Graphs and Images

Prints colored graphics and images with overlay patterns.
For Color Text, Graphs, and Images

Prints colored text, graphics, and images with overlay patterns.
Enhancement Options

Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options
Rotate 180º

Prints the image rotated 180º from its original orientation.
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High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.

You can select to print the following information:
• User Name
• Computer Name
• Date
• Date/Time
• Document Name
• Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.
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Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
You see the available Printing Presets on the left:
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2. Place your cursor over one of the Printing Presets to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control

your printing presets.
4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with the Standard Epson Printer Software - Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.
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You see the maintenance options:

4. Click the Extended Settings button.
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You see this window:

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with the Standard Epson Printer Software - Windows

Extended Settings - Windows
You can select from these settings on the Extended Settings window.
Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.
Check Paper Width Before Printing

Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print
speed.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.
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Short Grain Paper
Prevents ink from smearing when you print on envelopes or other thick paper, and the Thick Paper
setting does not help.

Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Output documents for filing
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier
filing.

Barcode mode
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper,
preprinted paper, envelopes, and thick paper.

Always Use the Driver's Color Setting
Prioritizes color settings from the printer driver software.

Parent topic: Selecting Extended Settings - Windows
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Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.

You see your application's Print window, such as this one:

2. Click OK or Print to start printing.
Parent topic: Printing with the Standard Epson Printer Software - Windows

Locking Printer Settings - Windows
Windows administrators can lock access to some printer settings to prevent unauthorized changes.
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.
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• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click your product and select
Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product and select Properties.

2. Click the Optional Settings tab.

Note: You can prevent access to the Optional Settings tab by changing the user or group
permissions in the Security tab.

3. Click Driver Settings.
You see this window:

4. Select the checkbox for each setting you want to lock. To lock all print settings, select All Document
Settings.
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5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Locked Setting Options
Parent topic: Printing with the Standard Epson Printer Software - Windows

Locked Setting Options
Select the options you want to use for any locked print settings.

Setting Options Description
Anti-Copy
Pattern

Various data items Lets you select the data to use for the pattern or prohibit anti-
copy patterns

Add/Delete Lets you add or delete a customized anti-copy pattern
Settings Lets you select the arrangement, size, and other settings for

the custom anti-copy pattern
Watermark Various text

watermarks
Lets you select the text for the watermark or prohibit
watermarks

Add/Delete Lets you add or delete a customized text or image-based
watermark

Settings Lets you select the size, position, color and other watermark
settings

Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and

footers
Color Color Allows color printing

Grayscale Allows printing in black or shades of gray only
2-sided printing Off Allows printing on one side of the paper only

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper
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Parent topic: Locking Printer Settings - Windows

Entering a User ID and Password for Printing
If you enabled Access Control on the product, you must enter a user ID and password in the printer
driver to be able to print.

Note: If you do not know the user ID or password, contact your administrator for assistance.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click . Select Printer Settings and click the
Maintenance tab.

2. Click the Printer and Option Information button.
3. Select the Save Access Control Settings checkbox.
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4. Click the Settings button.
5. Enter your user name and password.
6. Click OK.
Parent topic: Printing with the Standard Epson Printer Software - Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
You see the printer settings window:
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Changing the Language of the Printer Software Screens
Parent topic: Printing with the Standard Epson Printer Software - Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
You see the printer settings window.

3. Click the Maintenance tab.
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You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Software Update Settings.
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You see this window:

3. Do one of the following:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with the Standard Epson Printer Software - Windows
Related tasks
Checking for Software Updates

Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as
described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your
product. To print with additional settings, download and install the Epson Print and Scan utility from the
Windows Store. You cannot download and install any Epson product software from the Epson website
for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S
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Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see a window like this:
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4. Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

5. Click the Advanced button.
You see a window like this:

6. Select the size of the paper you loaded as the Paper Size setting.
7. To print multiple copies, select or enter the number as the Copy Count setting.
8. To print multiple copies of multi-page documents in sets, select the Collated checkbox.
9. Click OK.

You return to the printing preferences window.
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10. Select the Layout tab.

11. Select the orientation of your document as the Orientation setting.
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12. To print double-sided, select one of the Print on Both Sides options, depending on how you want to
orient the page layout. The icon next to each option shows the layout.

13. Click OK to save your settings.
You see your application's Print window.

14. Click OK or Print to start printing.
Parent topic: Printing with the Built-in Epson Driver - Windows 10 S

Printing with the Epson Standard Printer Software - Mac
You can print with your product using any Mac printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
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Selecting Print Layout Options - Mac
Selecting Double-sided Printing Settings - Mac
Managing Color - Mac
Selecting Printing Preferences - Mac
Printing Your Document or Photo - Mac
Parent topic: Printing from a Computer
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Page Setup Settings - Mac

Selecting Basic Print Settings - Mac
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings from the pop-up menu.

You see these settings:
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9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.
Paper Source Options - Mac
Print Quality Options - Mac
Print Options - Mac
Parent topic: Printing with the Epson Standard Printer Software - Mac

Paper Source Options - Mac
You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Note: Cassette 2 through Cassette 4 are available only if you have installed the optional cassettes.

Auto Select
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Cassette 3
Selects the paper in cassette 3 as the paper source.

Cassette 4
Selects the paper in cassette 4 as the paper source.

Rear Paper Feed
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Mac
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Print Quality Options - Mac
You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.
Draft

For draft printing on plain paper.
Normal

For everyday text and image printing.
Fine

For text and graphics with good quality and print speed.
Best Quality

For the best print quality, but the slowest print speed.
Parent topic: Selecting Basic Print Settings - Mac

Print Options - Mac
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Grayscale

Prints text and graphics in black or shades of gray.
Mirror Image

Lets you flip the printed image horizontally.
Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.
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1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with the Epson Standard Printer Software - Mac

Selecting Print Layout Options - Mac
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with the Epson Standard Printer Software - Mac
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Selecting Double-sided Printing Settings - Mac
You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the Mac
OS version you are using.

1. Select one of the Two-sided Printing options.



169

2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options and Adjustments - Mac
Parent topic: Printing with the Epson Standard Printer Software - Mac
Related references
Double-sided Printing Paper Types

Double-sided Printing Options and Adjustments - Mac
You can select any of the available options in the Two-sided Printing Settings pop-up menu to set up
your double-sided print job.
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Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac

Managing Color - Mac
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or
turn off color management in your printer software.
1. Select Color Matching from the pop-up menu in the print window.

2. Select one of the available options.



171

3. Select Color Options from the pop-up menu in the print window.

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - Mac
Parent topic: Printing with the Epson Standard Printer Software - Mac

Color Matching and Color Options - Mac
You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer software or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.
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Color Options Settings
Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac

Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.
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You see a screen like this:

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac
Parent topic: Printing with the Epson Standard Printer Software - Mac

Printing Preferences - Mac
You can select from these settings on the Options or Driver tab.
Thick Paper and Envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
Quiet Mode

Lessens noise during printing but may decrease print speed.
Permit temporary black printing

Allows you to print using black ink when color ink is expended.
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High Speed Printing
Speeds up printing but may reduce print quality.

Output documents for filing
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier
filing.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Lower Cassette
Specifies whether the optional cassette is present.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - Mac
Parent topic: Printing with the Epson Standard Printer Software - Mac
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Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.

You see the print status window:

2. Select the following options as necessary for your Mac OS version:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document or Photo - Mac

Printing with the Epson Universal Print Driver - Windows
You can print with the Epson Universal Print Driver using any Windows printing program, as described in
these sections.
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Selecting Basic Print Settings - Epson Universal Print Driver - Windows
Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows
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Selecting Maintenance Options - Epson Universal Print Driver - Windows
Selecting Default Print Settings - Epson Universal Print Driver - Windows
Locking Printer Settings - Epson Universal Print Driver - Windows
Adding Network Printers - Epson Universal Print Driver - Windows
Parent topic: Printing from a Computer

Synchronizing Printer Settings - Epson Universal Print Driver - Windows
You may need to synchronize the printer driver with the product if the printer driver does not detect the
correct information or settings from the product.

Note: You must sync the printer driver before you can use any optional equipment installed on the
product, such as an optional cassette unit.

1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
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You see this window:

3. Make sure Acquire from Printer is selected and click Get.

Note: Select the Only Optional Information checkbox if you only want to enable optional
equipment, such as an optional cassette unit.

The product's settings and other information appears in the Current Printer Information area.
4. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
Related tasks
Enabling the Optional Paper Cassettes - Windows



178

Selecting Basic Print Settings - Epson Universal Print Driver - Windows
Select the basic settings for the document or photo you want to print.

Note: The names of settings on the universal print driver screens may vary slightly, depending on the
version of the print driver you have installed.

1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select EPSON Universal Print Driver as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see the Main tab of your printer settings window:

Note: For more information about a setting, right-click it and select Help.

4. For the Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.
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7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.
9. Select a Color option:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black or shades of gray, select the Grayscale setting.

10. To print on both sides of the paper, select one of the 2-Sided Printing settings.
11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select

one of the settings in the Multi-Page menu and select the printing options you want.
12. To print multiple copies and arrange their print order, select the Copies options.
13. To preview your job before printing, select Print Preview.
14. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
Parent topic: Printing with the Epson Universal Print Driver - Windows
Related references
Paper or Media Type Settings - Printing Software
Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows
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Selecting Additional Layout and Print Options - Epson Universal Print Driver -
Windows

You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.
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Note: For more information about a setting, right-click it and select Help.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your

document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:

• Watermark: adds a visible watermark to your printout.
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Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

• Header/Footer: adds information such as the date and time to the top or bottom of your printout.

Note: Click the Settings button to customize the text and location of the header or footer.

4. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.
Parent topic: Printing with the Epson Universal Print Driver - Windows
Related references
Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
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Selecting Maintenance Options - Epson Universal Print Driver - Windows
You can select maintenance and other optional settings on the Maintenance tab.

Note: For more information about a setting, right-click it and select Help.

• Nozzle Check lets you print a nozzle check pattern to check for clogged nozzles.
• Head Cleaning lets you clean the print head.
• Network printer search lets you search for and connect to a product on the network.
• Job Arranger Lite lets you save your print job as a project that can be modified and combined with

other print jobs.
• Extended Settings lets you change a variety of print settings.
• Print Queue displays all the print jobs in queue. You can also cancel or restart print jobs.
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• Printer and Option Information displays information on the printer settings and any optional
equipment installed.

• Language lets you change the language of the printer software screens.
Extended Settings - Epson Universal Print Driver - Windows
Parent topic: Printing with the Epson Universal Print Driver - Windows
Related concepts
Print Head Nozzle Check
Print Head Cleaning

Extended Settings - Epson Universal Print Driver - Windows
You can select from these settings on the Extended Settings window.

Printer Control Language
Lets you select the printer control language.

Graphics Mode
Lets you select the mode by which to output PDL commands to the product.

TrueType Font
Lets you select how you want to print TrueType fonts.
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Offset Settings
Lets you make fine-tune adjustments to the print position of data on your printout.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Uses the collate settings specified in the application
Prints using the collate setting in your application.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Collate Using Printer Driver
Prints and collates multi-page documents using the printer driver. Deselect this checkbox to use the
product to collate your print jobs instead. (This setting is automatically enabled if there is not enough
memory on the product to collate your print job.)

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Output documents for filing
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier
filing.

Always Use the Driver's Color Setting
Prints using the color setting in the printer driver, rather than the setting in your application.

Parent topic: Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
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1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printing Preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

• Windows 7: Click and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printing Preferences.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click EPSON Universal Print Driver, and select Printing Preferences.

You see the printer settings window:

Note: For more information about a setting, right-click it and select Help.
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2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Parent topic: Printing with the Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows
Administrators can lock some printer settings to prevent unauthorized changes.
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
3. Click Driver Settings.
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You see this window:

4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Epson Universal Print Driver Locked Setting Options
Parent topic: Printing with the Epson Universal Print Driver - Windows

Epson Universal Print Driver Locked Setting Options
Select the options you want to use for any locked print settings.
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Setting Options Description
Watermark Various text

watermarks
Lets you select the text for the watermark or prohibit
watermarks

Add/Delete Lets you add or delete a customized text or image-based
watermark

Settings Lets you select the size, position, color and other watermark
settings

Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and

footers
Color Color Allows color printing

Grayscale Allows printing in black or shades of gray only
2-sided printing Off Allows printing on only one side of the paper

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows
You can use the Epson Universal Print Driver to find and add network printers.
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.
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• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
You see this window:

3. Click Network printer search.
4. When you see the search results, select Add found printers.
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You see a screen like this:

5. Select the printer or printers you want to add.
6. Click Add to Printer Folder.

The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.
8. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Printing with the PostScript (PS3) Printer Software - Windows
You can print with the PostScript (PS3) printer software using any Windows printing program, as
described in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product.

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Selecting Basic Print Settings - PostScript Printer Software - Windows
Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
Selecting Default Print Settings - PostScript Printer Software - Windows
Parent topic: Printing from a Computer

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
If you installed optional paper cassette units, you need to enable the optional cassette units before you
can use them with the PS3 printer software.
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners . Select your
product name and select Manage > Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click your product name and select
Printer Properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product name, and select Properties.

2. Click the Device Settings tab.

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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You see a window like this:

3. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
4. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Basic Print Settings - PostScript Printer Software - Windows
Select the basic settings for the document or photo you want to print.
The PostScript printer software supports plain paper printing on these paper and envelope sizes:
• Letter (8.5 × 11 inches [216 × 279 mm])
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• A4 (8.3 × 11.7 inches [210 × 297 mm])
• B4 (13.9 × 9.84 inches [353 × 250 mm])
• Legal (8.5 × 14 inches [216 × 356 mm])
• A5 (5.8 × 8.2 inches [148 × 210 mm])
• B5 (7.2 × 10.1 inches [182 × 257 mm])
• A6 (4.1 × 5.8 inches [105 × 148 mm])
• B6 (5 × 7.2 inches [128 × 182 mm])
• Executive (7.25 × 10.5 inches [184 × 267 mm])
• A3 (11.7 × 16.5 inches [297 × 420 mm])
• 13 × 19 inches (330 × 483 mm)
• 11 × 17 inches (279 × 432 mm)
• No. 10 (4.1 × 9.5 inches [105 × 241 mm])
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use, and then click the
Preferences button.
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You see the Paper/Quality tab of your printer settings window:

4. Select the Paper Source that matches where you loaded the paper you want to print on.
5. Select Plain as the Media setting.
6. Select one of the following as the Color setting:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black only, select the Black & White setting.

7. Click the Layout tab.
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You see this window:

8. Select the orientation of your document.
9. To print on both sides of the paper, select one of the Print on Both Sides settings.
10. To change the printing order of the pages, select one of the Page Order settings.
11. To print multiple pages on one sheet of paper, adjust the Pages per Sheet setting.
12. To create a folded booklet out of your photo or document, select the Booklet option.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows
Related references
Paper Source Options - Windows
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Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
You can select a variety of additional layout and printing options for your document or photo by clicking
the Advanced button on the Paper/Quality tab.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the Print Quality option that matches the print quality you want to use.
3. To use the Windows Image Color Management system, set the ICM Method setting to one of the

ICM Handling options and select the ICM Intent setting you want to use.
4. Adjust the Scaling setting to reduce or enlarge your document or photo by a specific percentage.
5. Select the TrueType Font setting to determine font substitutes.
6. Enable the Advanced Printing Features setting to allow detailed settings for printing features.
7. Expand the PostScript Options heading to access the advanced PostScript printer software features.
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8. Select any of the remaining Printer Features options to customize your printouts.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Default Print Settings - PostScript Printer Software - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Print Preferences.

• Windows 7: Click and select Devices and Printers. Right-click your product name and select
Printing Preferences.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Printing Preferences.

2. Click the Layout tab.
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You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Printing with the PostScript (PS3) Printer Software - Mac
You can print with the PostScript (PS3) printer software using any Mac printing program, as described in
these sections.
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Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product.

Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac
Selecting Basic Print Settings - PostScript Printer Software - Mac
Selecting Page Setup Settings - PostScript Printer Software - Mac
Selecting Print Layout Options - PostScript Printer Software - Mac
Sizing Printed Images - PostScript Printer Software - Mac
Managing Color - PostScript Printer Software - Mac
Printing Your Document or Photo - PostScript Printer Software - Mac
Parent topic: Printing from a Computer

Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac
If you installed optional paper cassette units, you need to enable the optional cassette units before you
can use them with the PS3 printer software.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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You see a screen like this:

4. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
5. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Printing with the PostScript (PS3) Printer Software - Mac
Related tasks
Enabling the Optional Paper Cassettes - Mac

Selecting Basic Print Settings - PostScript Printer Software - Mac
Select the basic settings for the document or photo you want to print.
The PostScript printer software supports plain paper printing on these paper and envelope sizes:
• A4 (8.3 × 11.7 inches [210 × 297 mm])
• Letter (8.5 × 11 inches [216 × 279 mm])
• No. 10 (4.1 × 9.5 inches [105 × 241 mm])
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• A5 (5.8 × 8.2 inches [148 × 210 mm])
• B5 (7.2 × 10.1 inches [182 × 257 mm])
• A6 (4.1 × 5.8 inches [105 × 148 mm])
• B6 (5 × 7.2 inches [128 × 182 mm])
• Executive (7.25 × 10.5 inches [184 × 267 mm])
• Legal (8.5 × 14 inches [216 × 356 mm])
• A3 (11.7 × 16.5 inches [297 × 420 mm])
• 13 × 19 inches (330 × 483 mm)
• 11 × 17 inches (279 × 432 mm)
• B4 (13.9 × 9.84 inches [353 × 250 mm])
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

5. Select the Two-Sided, Copies, and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Paper Feed from the pop-up menu.

You see these settings:

9. Select All Pages From or First Page From and select the paper source you want to print from.
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10. Select Printer Features from the pop-up menu.

You see these settings:

11. Select Plain as the Media Type setting.
12. Select one of the following Print Quality options:

• For fast printing with reduced quality, select Fast.
• For printing text and graphics with good quality and print speed, select Fine.
• For the best printing with reduced speed, select Maximum.

13. Select Color from the Feature Sets pop-up menu.
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You see these settings:

14. Select a Color Mode option:
• To print a color document or photo, select the Color setting.
• To print text and graphics in black only, select the Monochrome setting.

15. Select any of the available print options.
Parent topic: Printing with the PostScript (PS3) Printer Software - Mac
Related tasks
Selecting Page Setup Settings - PostScript Printer Software - Mac
Selecting Print Layout Options - PostScript Printer Software - Mac
Printing Your Document or Photo - PostScript Printer Software - Mac

Selecting Page Setup Settings - PostScript Printer Software - Mac
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.
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1. Select the size of the paper you loaded as the Paper Size setting. You can also select a custom
setting to create a custom paper size.

2. Select the orientation of your document or photo as shown in the print window.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with the PostScript (PS3) Printer Software - Mac
Related tasks
Selecting Basic Print Settings - PostScript Printer Software - Mac

Selecting Print Layout Options - PostScript Printer Software - Mac
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To print on both sides of the page, select one of the Two-Sided settings.
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• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Sizing Printed Images - PostScript Printer Software - Mac
You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu
on the Print window.

• To print only selected pages in a multi-page document, select an option from the Pages to Print pop-
up menu.

• To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.
• To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and

select a paper size from the Destination Paper Size pop-up menu.
Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Managing Color - PostScript Printer Software - Mac
You can adjust the Color Matching settings to fine-tune the colors in your printout.
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1. Select Color Matching from the pop-up menu in the print window.

2. Do one of the following:
• To print using standard color profiles for your product and paper to help match image colors,

select ColorSync. Select one of the available Profile options to change the active color profile.
• To use the product's default color matching, select In printer.

Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Printing Your Document or Photo - PostScript Printer Software - Mac
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - PostScript Printer Software - Mac
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Parent topic: Printing with the PostScript (PS3) Printer Software - Mac
Checking Print Status - PostScript Printer Software - Mac

During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.

You see the print status window:

2. Select the following options as necessary for your Mac OS version:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document or Photo - PostScript Printer Software - Mac

Cancelling Printing Using a Product Button
If you need to cancel printing in progress, press the stop button.
To cancel stored jobs or jobs waiting to print, follow the instructions below.
1. Press the Job/Status button.
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2. Select Active on the Job Status tab.
3. Select the job you want to cancel and select Cancel.
Parent topic: Printing from a Computer
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Scanning
You can scan your originals and save them as digital files.
Starting a Scan
Scanning with Document Capture or Document Capture Pro
Scanning in Epson Scan 2
Scanning Special Projects

Starting a Scan
After placing your originals on your product for scanning, start scanning using one of these methods.

Note: You can also scan using Document Capture Pro (Windows) or Document Capture (Mac).

Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smart Device
Entering a User ID and Password for Scanning
Parent topic: Scanning
Related topics
Scanning with Document Capture or Document Capture Pro
Placing Originals on the Product

Starting a Scan Using the Product Control Panel
You can scan an image to a variety of destinations using your product's control panel.
1. Make sure you installed the product software and connected the product to your computer or

network.

Note: Restart your computer after installing the product software to enable scanning from the control
panel.
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2. Place your original on the product for scanning.

Note: To scan a double-sided or multi-page document, place your originals in the ADF.

3. Press the home button, if necessary.
4. Select Scan.

You see a screen like this:

5. Select one of the following Scan to options:
• Network Folder/FTP saves your scan file to a specified folder on a network.
• Email lets you send scanned files through a pre-configured email server.
• Document Capture Pro lets you scan over a network using your saved job settings in Document

Capture Pro or Document Capture.

Note: You cannot use this option to scan an image to Document Capture or Document Capture
Pro when your product is connected to your computer's USB port.

• Memory Device saves your scan file on a USB device inserted in your product's external USB
port and lets you select the file format, quality, and other settings.

• Cloud sends your scanned files to a destination that you have registered with Epson Connect.
• Computer (WSD) lets you manage network scanning in Windows. To use this feature on

Windows 7 or Windows Vista, you must first set up WSD (Web Services for Devices) on the
computer.

6. Follow the instructions in the links below to complete your scan.
Scanning to a Network Folder or FTP Server



215

Scanning to Email
Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Adding and Assigning Scan Jobs with Document Capture - Mac
Scanning to a Memory Device
Scanning to the Cloud
Scanning Using Web Services for Devices (WSD) - Windows
Control Panel Scanning Options
Parent topic: Starting a Scan
Related tasks
Scanning to the Cloud
Entering Characters on the LCD Screen
Using Presets
Related topics
Placing Originals on the Product

Scanning to a Network Folder or FTP Server
You can scan an image and save it to a network folder using your product's control panel. You can either
enter the folder path directly on the product's control panel or select a folder from the Contacts list.

Note: Make sure the date and time are set correctly before using this feature.

1. Place your original on the product for scanning.

Note: To scan a double-sided or multi-page document, place your originals in the ADF.

2. Press the home button, if necessary.
3. Select Scan.
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You see a screen like this:

4. Select Network Folder/FTP.
You see a screen like this:

5. Do one of the following:
• Select from any displayed frequent contacts.
• Select Keyboard, select the Communication Mode field, and select Network Folder (SMB) or

FTP. Then select the Location field and enter the folder location, and select OK. Enter other
information as necessary.
Enter the folder path name for the Location setting in one of the following formats depending on
the Communication Mode setting you selected:
• SMB: \\host name\folder
• FTP: ftp://host name/folder name
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• Select Contacts and choose a saved folder from the Contacts list.
6. Select Scan Settings.
7. Select File Format to choose the file format for your scan.
8. Scroll down and change the File Name setting, if necessary.
9. Select any additional scan settings as necessary.
10. Select Presets to save your scan settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

11. Select the Save icon.
Your product scans your original and saves it in the selected location.

Parent topic: Starting a Scan Using the Product Control Panel
Related tasks
Entering Characters on the LCD Screen
Selecting the Date and Time
Related topics
Placing Originals on the Product

Scanning to Email
You can scan an original and email the scanned file using your product's control panel. You need to
have a preconfigured email server before you can scan to email. You can either enter the email address
directly on the product's control panel or select an address from the Contacts list. Make sure the date
and time are set correctly so the time stamps on your emails are accurate.

Note: You can also use the Scan to Document Capture Pro function to scan and email the scanned file.

1. Place your original on the product for scanning.

Note: To scan a double-sided or multi-page document, place all of the pages in the ADF.

2. Press the home button, if necessary.
3. Select Scan.
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You see a screen like this:

4. Select Email.
You see a screen like this:

5. Do one of the following:
• Select from any displayed frequent contacts.
• Select Keyboard to use the displayed keyboard to enter the address for the recipient and select

OK.
• Select Contacts and choose an email address from the Contacts list.
• Select History to choose an email address from your recent scan history.

6. Select Scan Settings.
7. Select File Format to choose the file format for your scan.
8. Scroll down and change the Subject and File Name settings, if necessary.
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9. Select any additional scan settings as necessary.
10. Select Presets to save your scan settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

11. Press the Send icon.
Your product scans your original and emails the scanned file.

Parent topic: Starting a Scan Using the Product Control Panel
Adding and Assigning Scan Jobs with Document Capture Pro - Windows

You can use Document Capture Pro to create, edit, and delete scan jobs. Scan jobs allow you to save
commonly-used scanning options. You can also determine which scan jobs are listed when you scan to
Document Capture Pro using the control panel on your product.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
2. If you see a Switch to Simple View button in the upper right corner of the window, click it.
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You see a window like this:

3. Click the Job Settings button.

Note: If you do not see the button, click the < symbol in the Job bar.
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You see a window like this:

4. To add a scan job, click the New Job icon, enter a name for the new job, select settings as
necessary, and click OK.
You can now use the new scan job when you scan with Document Capture Pro.

Note: See the Help information in Document Capture Pro for details.

5. To add the scan job to the list of selectable jobs when scanning to Document Capture Pro from the

control panel, click the Button Assignment icon.

6. Select the job that you want to add to the list from the drop-down list.

Note: You can assign scan jobs to each available button assignment. The order of the assigned
scan jobs is also the order in which the scan jobs appear on the control panel.

7. Click OK, then click OK again.
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You can now select the assigned scan job when you scan to Document Capture Pro using your
product's control panel.

Parent topic: Starting a Scan Using the Product Control Panel
Related topics
Placing Originals on the Product

Adding and Assigning Scan Jobs with Document Capture - Mac
You can use Document Capture to create, edit, and delete scan jobs. Scan jobs allow you to save
commonly-used scanning options. You can also determine which scan jobs are listed when you scan to
Document Capture using the control panel on your product.
1. Start Document Capture on a computer connected to the product.

2. Click the Manage Job icon from the toolbar at the top of the window.
You see a window showing the current scan job list.

3. To add a scan job, click the + icon, enter a name for the new job, select settings as necessary, and
click OK.
You can now use the new scan job when you scan with Document Capture.

Note: See the Help information in Document Capture for details.

4. To add the scan job to the list of selectable jobs when scanning to Document Capture from the
control panel, click the icon at the bottom of the window and click Event Settings.

5. Select the job that you want to add to the list from the 1 drop-down list.

Note: You can assign scan jobs to each available button assignment. The order of the assigned
scan jobs is also the order in which the scan jobs appear on the control panel.

6. Click OK, then click OK again.
You can now select the assigned scan job when you scan to Document Capture using your product's
control panel.

Parent topic: Starting a Scan Using the Product Control Panel
Scanning to a Memory Device

You can scan an original and save the scanned image to a external USB device connected to your
product.
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1. Insert a external USB device into the product's USB port.
2. Place your original on the product for scanning.

Note: To scan a double-sided or multi-page document, place all of the pages in the ADF.

3. Press the home button, if necessary.
4. Select Scan.

You see a screen like this:

5. Select Memory Device.
You see a screen like this:

6. Select Basic Settings options as necessary.
7. Select the Advanced tab and select options as necessary.
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8. Select Presets to save your scan settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

9. Select the Save icon.
Your product scans your original and saves the scanned file to a memory device.

Parent topic: Starting a Scan Using the Product Control Panel
Scanning to the Cloud

You can use the control panel to send your scanned files to a destination that you have registered with
Epson Connect.

Note: Make sure to set up your product using Epson Connect before using this feature.

1. Place your original on the product for scanning.

Note: To scan a double-sided or multi-page document, place all of the pages in the ADF.

2. Press the home button, if necessary.
3. Select Scan.

You see a screen like this:

4. Select Cloud.
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You see a screen like this:

5. Press the + icon and select a cloud destination.
6. Select Basic Settings options as necessary.
7. Select the Advanced tab and select options as necessary.
8. Select Presets to save your scan settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

9. Press the Upload icon.
Your product scans your original and saves the scanned file to the selected destination.

Parent topic: Starting a Scan Using the Product Control Panel
Scanning Using Web Services for Devices (WSD) - Windows

You can scan originals to a computer from the product control panel using WSD (Web Services for
Devices) for network scanning in Windows.

Note: To use this feature on Windows 7 or Windows Vista, you must first set up WSD on the computer.
See Windows help for instructions.

1. Make sure you installed the product software and connected the product to your computer or
network.

2. Place your original on the product for scanning.
3. Press the home button, if necessary.



226

4. Select Scan.
5. Select Computer (WSD).
6. Select a computer.
7. Select the Save icon.

The scanned image is transferred to the selected computer.
Parent topic: Starting a Scan Using the Product Control Panel

Control Panel Scanning Options
Select the options you want to use for scanning.

Note: Not all options or settings may be available, depending on the Scan to option selected.

Scan to setting Available options Description
Destination menu
Keyboard Communication

Mode
Lets you select Network Folder (SMB) or FTP

Location Lets you enter a folder path in which to save
scanned images

User Name Lets you enter a user name for the selected
folder path

Password Lets you enter a password for the selected folder
path

Connection Mode Lets you select the connection mode
Port Number Lets you enter a port number

Contacts — Select an email address or folder path to send or
save scanned images

History — Select from previous recipients to send scanned
images to

Scan Settings menu
Color Mode Color Select whether to scan images in color or black

and whiteB&W
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Scan to setting Available options Description
File Format JPEG Select for photos. You can also select the

Compression Ratio.
PDF Select for documents. You can also select the

Compression Ratio and PDF Settings.
TIFF (Single Page) Select for scanned files that you can print from a

device. Multi Page TIFF documents are scanned
in black and white.TIFF (Multi Page)

Resolution 200dpi Select for documents
300dpi Select for photos
600dpi Select for highest quality printing

2-Sided 1-Sided
2-Sided

Lets you scan 2-sided originals placed in the
ADF. If you select 2-Sided, you can also select
the Binding (Original) setting.

Orientation
(Original)

Lets you specify the direction of text on the
scanned originals.

Binding (Original) Lets you specify which side of the scanned
original is bound.

Scan Area Auto Detect Select to automatically adjust the scan area
Various sizes Select the page size for documents
Auto Cropping Select for photos with dark edges
Max Area Select for most photos

Original Type Text Specifies the type of original you are scanning
Text & Image
Photo

Mixed Size Originals On Scans originals at their actual size if originals are
combinations of A3 and A4 or B4 and B5 size.
Place originals in the ADF and align their widths
to match.

Off

Density –4 to +4 Adjusts the lightness or darkness of scanned
images.
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Scan to setting Available options Description
Remove Shadow On Select On, then select settings for Center to

erase the shadows that appear in the center of a
document when copying a book or Surround to
remove the shadows that appear around a
document when copying thick paper.

Off

Remove Punch Holes On Erases the binding holes on a document. Select
the side of the original with the binding holes and
select the orientation of the original (Up
Direction or Left Direction). Enter the distance
in mm to erase from the edge of the original in
the Erase Amount field.

Off

Subject — Lets you enter a subject for your email
Attached File Max Size Various sizes Lets you select the maximum file size that can

be attached to an email
File Name — Lets you enter a prefix, the date, and the time to

the file name for your scanned file

Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan Using the Epson Scan 2 Icon
You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

• Windows 10: Click and select EPSON > Epson Scan 2.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan
Related tasks
Entering a User ID and Password for Scanning
Starting a Scan from a Scanning Program
Related topics
Placing Originals on the Product

Starting a Scan from a Scanning Program
You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; it will not work correctly.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan
Related tasks
Entering a User ID and Password for Scanning
Related topics
Placing Originals on the Product

Starting a Scan from a Smart Device
You can start a scan from a smart device using the Epson iPrint app. You can save the scanned
document to your device or a cloud service, e-mail it, or print it.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Note: Your device must be connected to the same wireless network as your Epson product. If you have
an NFC-enabled device, you can also scan with the Epson iPrint app by placing the device against the
NFC tag on the front of the product.

1. Download the Epson iPrint app from your device's app store or from Epson's website.
2. Place your original on the product for scanning.
3. Open the Epson iPrint app and select your product.
4. Select the scan settings and scan your original.
5. Save your scanned image to a file or cloud location.
Parent topic: Starting a Scan
Related tasks
Using the Epson iPrint Mobile App
Related topics
Placing Originals on the Product

Entering a User ID and Password for Scanning
If you enabled Access Control on your product, a user ID and password may be required to scan. You
can enter the user ID and password in Epson Scan 2.
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Note: If you do not know the user ID or password, contact your administrator for assistance.

1. Start Epson Scan 2.
2. Select Settings from the Scanner drop-down list.

You see this window:

3. Select Access Control.
4. Enter your user name and password.
5. Click OK.
Parent topic: Starting a Scan

Scanning with Document Capture or Document Capture Pro
Follow the instructions in these sections to scan using Document Capture (Mac) or Document Capture
Pro (Windows).

Note: The Document Capture (Mac) or Document Capture Pro (Windows) software must be installed on
your computer.

Setting the Operation Mode on the Product Control Panel
Scanning with Document Capture Pro in Simple View - Windows
Scanning with Document Capture Pro in Standard View - Windows



234

Scanning with Document Capture - Mac
Parent topic: Scanning
Related topics
Placing Originals on the Product

Setting the Operation Mode on the Product Control Panel
Before scanning to Document Capture Pro, set the operation mode on the control panel.
1. Make sure you installed the product software and connected the product to your computer or

network.
2. Press the home button, if necessary.
3. Select Settings.
4. Select General Settings > Scan Settings > Document Capture Pro.

5. Choose from the following Operation Mode options:
• Select Client Mode if Document Capture Pro is installed on a Windows or Mac computer.
• Select Server Mode if Document Capture Pro is installed on a Windows Server computer. Enter

the server address.
6. Click OK.
Parent topic: Scanning with Document Capture or Document Capture Pro

Scanning with Document Capture Pro in Simple View - Windows
You can use Document Capture Pro in Simple View to quickly select options and scan.
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Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window. (You may see a screen asking you to select your
scanner first; if you do, select your product.)

3. If you see a Switch to Simple View button in the upper right corner of the window, click it.
You see a window like this:

4. Click Select Scanner and select your scanner from the scanner list, if necessary.
5. If you want to use a scan job, click one of the job icons in the Job section of the window to complete

and send your scan with one click.

Note: If you do not see any icons, click the < symbol in the Job bar.
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6. If you want to select scan settings for a particular destination, click the Scan Settings button, select
any displayed settings you want to use, and click OK.

Note: See the help information in Document Capture Pro for details. If you do not see the Scan
Settings button, click the < symbol in the Scan and... bar.

7. Click one of the destination icons in the Scan and... section of the window. Your product starts
scanning and you see the settings window.

8. Select any destination settings as necessary and click OK.

Note: See the help information in Document Capture Pro for details.

9. Confirm your settings and click OK.
Parent topic: Scanning with Document Capture or Document Capture Pro
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Scanning with Document Capture Pro in Standard View - Windows
You can use Document Capture Pro in Standard View to select settings, preview, and change the
scanned file settings as necessary.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window. (You may see a screen asking you to select your
scanner first; if you do, select your product.)

3. If you see a Switch to Standard View button in the upper right corner of the window, click it.
You see a window like this:
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4. Select Scan Settings from the Scan Setting Name list (or select Scan > Scan Settings from the
menu bar).
You see a window like this:

5. Select any displayed settings you want to use and click OK.

Note: See the help information in Document Capture Pro for details.

6. Click Scan.
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You see a preview of your scan in the Document Capture Pro window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
Pro window.

7. If you would like to scan additional originals and add them to the current captured images, click the

Add Page(s) icon and follow the instructions on the screen.
8. Check the scanned images and edit them as necessary.

Note: See the help information in Document Capture Pro for details.

9. Click one of the Destination icons to choose where to send your scanned files. (If you cannot see all
of the icons below, click the arrows next to the icons.)

10. Depending on the destination you chose, click OK or Send to complete the scan.
Parent topic: Scanning with Document Capture or Document Capture Pro
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Scanning with Document Capture - Mac
When you scan with Document Capture, the program automatically saves your scanned file on your
computer in the folder you specify. You can select settings, preview, and change the scanned file
settings as necessary.

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture for details.

1. Open the Applications folder, open the Epson Software folder, and select Document Capture.
You see a window like this:

Note: You may need to select your scanner from the scanner list.

2. Click the Scan icon.
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You see a window like this:

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the Start Job button, and skip the rest of these steps.

3. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

4. If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

5. Click the Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

6. Click Scan.
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You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

7. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

8. Check the scanned images and edit them as necessary.
9. Click one of the Destination icons to choose where to send your scanned files. (If you cannot see all

of the icons below, click the arrow next to the icons.)

10. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning with Document Capture or Document Capture Pro
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Scanning in Epson Scan 2
Epson Scan 2 automatically scans your document and saves the scanned file in PDF format in your
operating system's Documents or My Documents folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Start Epson Scan 2.
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You see this window:
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2. Select the Document Source setting that matches where you placed your original, or select Auto
Detect to have Epson Scan 2 automatically detect the size.

3. Select the Scanning Side setting if you are scanning from the ADF.
4. Select the Document Size setting that matches the size of your original, or select Auto Detect to

have Epson Scan 2 automatically detect the size. You can select Customize to enter a custom size,
if necessary.

5. Select the image type of your original and how you want it scanned as the Image Type setting.
6. Select the Resolution setting you want to use for your scan.
7. Click the Preview button.

Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

8. Reinsert your original into the ADF, if necessary.
9. Select any of the additional settings that you want to use on the Main Settings tab.
10. Click the Advanced Settings tab and select any settings that you want to use.
11. Select the format in which you want to save your scanned file as the Image Format setting. If

necessary, select Options and select any desired format options.
12. Enter the file name for your scanned file in the File Name field. If necessary, select Settings to

modify the file name settings.
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13. Select the location in which you want to save your scanned file as the Folder setting. If necessary,
select Select to create a new folder.

14. Click Scan.
The product scans your original and saves the scanned file in the location you specified.

Available Document Source Settings
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
Saving Scanned Documents as a Searchable PDF
Image Format Options
Scan Resolution Guidelines
Parent topic: Scanning
Related topics
Placing Originals on the Product

Available Document Source Settings
You can select these Document Source options in Epson Scan 2:
Auto Detect

Automatically detects where the originals are placed on your product for scanning.
ADF

Selects the Automatic Document Feeder as the location where the originals are placed on your
product for scanning.

Scanner Glass
Selects the scanner glass as the location where the originals are placed on your product for scanning.

Parent topic: Scanning in Epson Scan 2

Additional Scanning Settings - Main Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Stitch Images

When scanning double-sided originals, lets you lay out images from both sides of the original onto
one scanned page.
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Rotate
Rotates the original image clockwise to the desired angle before scanning it. Select Auto to allow
your product to automatically rotate the image based on the orientation of the text (may take longer to
scan).

Correct Document Skew
Corrects skewed originals, image contents, or both.

Add or edit pages after scanning
Lets you add, remove, or edit the pages in a job, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.

Skip Blank Pages
If the scanner detects marks from the other side of a blank page and adds the marks to the scanned
image, adjust this setting to prevent this.

Parent topic: Scanning in Epson Scan 2

Additional Scanning Settings - Advanced Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Remove Background

Removes the background of the originals.
Text Enhancement

Sharpens the appearance of letters in text documents.
Auto Area Segmentation

Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.
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Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Dual Image Output
Scans the original image twice using different output settings (Windows only).

Parent topic: Scanning in Epson Scan 2

Saving Scanned Documents as a Searchable PDF
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is
recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

Note: The required Epson Scan 2 OCR Component is installed automatically when you install your
product software as instructed on the Start Here sheet. If you install your scanner software programs
individually, be sure to also install this component if you want to perform OCR.

1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click Preview and adjust the area you want to scan, if necessary.
5. If you are using the ADF, reload the ejected original.
6. Select Searchable PDF as the Image Format setting.
7. Select Options from the Image Format list.
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You see this window:

8. Select any of the options on the General tab.
9. Select the Text tab.
10. Make sure the language used in the document text is selected as the Text Language setting.
11. Click OK.
12. Confirm the File Name setting and select a Folder setting for your document.
13. Click Scan.

The scanned image is saved as a searchable PDF.
Parent topic: Scanning in Epson Scan 2
Related topics
Placing Originals on the Product
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Image Format Options
You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.
Bitmap (*.bmp)

A standard image file format for most Windows programs.
JPEG (*.jpg)

An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned
document can be searched.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines
The Resolution setting, measured in dpi (dots per inch), controls the amount of detail captured in your
scans. Increasing the resolution raises the amount of detail captured but comes with the following
disadvantages:
• Larger file sizes
• It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
• The image may become too large to fit on your display or print on paper
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If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the
resolution setting you need:
• You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same
amount you will increase the image size to retain a high image quality. For example, if the resolution is
300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600
dpi.

• You will scan the image at 100% or smaller size.
Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
• Email/view on a computer screen/post on the web: 96 to 200 dpi
• Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

Parent topic: Scanning in Epson Scan 2

Scanning Special Projects
Your product's scanning software offers various options to help you quickly complete special scan
projects.
Scanning to a SharePoint Server or Cloud Service - Windows
Scanning to a SharePoint Server or Cloud Service - Mac
Scanning Multi-Page Originals as Separate Files
Parent topic: Scanning

Scanning to a SharePoint Server or Cloud Service - Windows
You can use Document Capture Pro to upload scanned images to a SharePoint server or a cloud
service.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.
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• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. If you see a Switch to Simple View button in the upper right corner of the window, click it.
You see a window like this:

4. Click the Scan Settings button.

Note: If you do not see the button, click the < symbol in the Scan and... bar.
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You see a window like this:

5. Select any displayed settings you want to use and click OK.

Note: See the help information in Document Capture Pro for details.

6. Click one of the cloud server or service destination icons in the Scan and... section of the window.
Your product starts scanning and you see the settings window.

Note: If you cannot see all of the icons, the service software may not be installed or the service may
not be available on your platform.

7. Enter any required information to set up the destination. You may need to log in to your cloud service
to authenticate the connection and allow Document Capture Pro to access the cloud service. If you
have previously created a saved setting for the destination, select it from the drop-down list.
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8. Adjust any settings and click OK.

Note: See the help information in Document Capture Pro for details.

Your originals are uploaded to the indicated server or cloud service.
Parent topic: Scanning Special Projects

Scanning to a SharePoint Server or Cloud Service - Mac
You can use Document Capture to upload scanned images to a SharePoint server or a cloud service.
1. Open the Applications folder, open the Epson Software folder, and select Document Capture.

You see a window like this:

Note: You may need to select your scanner from the scanner list.

2. Click the Scan icon.
3. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

4. Click Scan.
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You see a preview of your scan in the Document Capture window.
5. Click one of the cloud service Destination icons to choose where to save your scanned file. (If you

cannot see all of the icons, the service software may not be installed, the service may not be
available on your platform, or you need to click the arrow next to the icons.)
You see the Transfer Settings window.

6. Enter any required information to set up the destination. You may need to log in to your cloud service
to authenticate the connection and allow Document Capture to access the cloud service. If you have
previously created a saved setting for the destination, select it from the drop-down list.

7. Adjust any save settings, then click OK or Send, depending on the destination.
Your originals are scanned and uploaded to the indicated server or cloud service.

Parent topic: Scanning Special Projects

Scanning Multi-Page Originals as Separate Files
You can use Document Capture Pro to scan multi-page originals as separate scanned files. You indicate
how the separate files are created by defining a maximum page count per file or by inserting blank
pages, barcodes, or characters that can be detected by the software as separation markers.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your multi-page original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
3. If you see a Switch to Simple View button in the upper right corner of the window, click it.
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You see a window like this:

4. Click the Scan Settings button.

Note: If you do not see the button, click the < symbol in the Scan and... bar.
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You see a window like this:

5. Select any displayed settings you want to use and click OK.

Note: See the help information in Document Capture Pro for details.

6. Click one of the destination icons (except Print) in the Scan and... section of the window. Your
product starts scanning and you see the settings window.

7. Select the Apply job separation checkbox.
8. Click Separation Settings.
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You see a window like this:

9. Select the method you used to separate the originals as the Separator setting.

Note: See the help information in Document Capture Pro for details.

10. If necessary, select Create Folder and select a folder name.
11. Select any other folder naming settings you want and click OK, then click OK again.

Your originals are saved into separate files and folders as specified.
Parent topic: Scanning Special Projects
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Faxing
See these sections to fax using your product.

Note: This product allows you to store names, telephone numbers, and fax data in its memory even
when the power is turned off. Make sure you restore all of the default settings if you give away or dispose
of the product. This will erase all of your network settings and fax data.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can fax using the printer buttons or the utilities included with the standard Epson printer software. To
download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support
(Canada), or epson.com.jm/support (Caribbean) and select your product.

Connecting a Telephone or Answering Machine
Setting Up Fax Features
Setting Up Contacts and Contact Groups
Sending Faxes
Receiving Faxes
Checking Fax Status
Printing Fax Reports

Connecting a Telephone or Answering Machine
You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the
same telephone line to receive calls, you can connect a telephone or answering machine to your product
using an additional phone cable.

Note: If you do not connect a telephone to your product, make sure Receive Mode is set to Auto.
Otherwise, you cannot receive faxes.

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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1. Connect a phone cable to your telephone wall jack and to the LINE port on your product.

Note: If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN
terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your
product. Contact your DSL or ISDN provider for the necessary equipment.
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2. If you are connecting a telephone or answering machine to your product using a second phone
cable, remove the cap from the EXT port on your product.
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3. Connect a second phone cable to your telephone or answering machine and to the EXT port on your
product.

Note: If you connect an answering machine and Receive Mode is set to Auto, set the number of
rings before your product answers a call to a number that is higher than your answering machine's
setting for the number of rings.
Any phone or answering machine must be connected to the EXT port for your product to detect an
incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VoIP,
cable phone systems, or fiberoptic digital services such as FIOS.

Parent topic: Faxing
Related references
Cannot Receive Faxes with a Telephone Connected to Your Product



264

Related tasks
Using the Fax Setting Wizard
Receiving Faxes Automatically

Setting Up Fax Features
Before faxing with your product, set up your fax header and select the fax features you want to use.

Note: If you leave your product unplugged for a long period of time, you may need to reset the date and
time settings for faxes.

Setting Up Basic Fax Features
Selecting Advanced Fax Settings
Setting Up the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - Mac
Parent topic: Faxing

Setting Up Basic Fax Features
See these sections to select the basic settings you need to use the product's fax features.
Using the Fax Setting Wizard
Selecting the Line Type
Setting the Number of Rings to Answer
Parent topic: Setting Up Fax Features

Using the Fax Setting Wizard
You can setup the product's basic fax settings using the Fax Setting Wizard. This wizard is automatically
displayed when the product is turned on for the first time. You can also change these settings individually
from the Fax Settings menu.
1. Press the home button, if necessary.
2. Select Settings > General Settings > Fax Settings > Fax Setting Wizard.
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You see the following screen:

3. Connect your phone line and select Proceed.
4. On the next screen, use the displayed keypad to enter the sender name for your fax source, such as

your name or a business name. You can enter up to 40 characters. Select OK when complete.
5. On the next screen, use the displayed keypad to enter your fax number, up to 20 characters. Select

OK when complete.

Note: The name and phone number in the fax header identifies the source of the faxes you send.

6. On the Distinctive Ring Setting screen, do one of the following:
• If you have subscribed to a distinctive ring service from your telephone company, select Proceed.

Select the ring pattern to be used for incoming faxes. If you select All, skip to step 7. Otherwise,
skip to step 9.

• If you do not have a distinctive ring service, select Skip and skip to step 9.

Note: Distinctive ring services allows you to have several phone numbers on one phone line. Each
number is assigned a different ring pattern. You can use one number for voice calls and another for
fax calls. Select the ring pattern assigned to fax calls in the Distinctive Ring Setting. If you select a
ring pattern other than All, Receive Mode is automatically set to Auto.

7. On the Receive Mode Setting screen, do one of the following:
• If you have connected an external telephone or answering machine to the product, select Yes.
• If you did not connect an external telephone or answering machine, select No and skip to step 9.

(Receive Mode is automatically set to Auto; otherwise you cannot receive faxes.)
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8. On the next Receive Mode Setting screen, select Yes to receive faxes automatically or select No to
receive faxes manually.

Note: If you connect an external answering machine and select to receive faxes automatically, make
sure the Rings to Answer setting is correct. If you select to receive faxes manually, you need to
answer every call and operate the product’s control panel or your phone to receive faxes.

9. On the Proceed screen, confirm the displayed settings and select Proceed, or press the back arrow
to change the settings.

10. On the Run Check Fax Connection screen, select Start Checking and follow the on-screen
instructions to check the fax connection and print a report of the check result. If there are any errors
reported, try the solutions on the report and run the check again.

If the Select Line Type screen appears, select the correct line type.
If the Select Dial Tone Detection screen appears, select Disable. However, disabling the dial tone
detection function may drop the first digit of a fax number and send the fax to the wrong number.
Parent topic: Setting Up Basic Fax Features
Related tasks
Entering Characters on the LCD Screen

Selecting the Line Type
If you connect the product to a PBX phone system or terminal adapter, you must change the product's
line type. PBX (Private Branch Exchange) is used in office environments where an external access code
such as “9” must be dialed to call an outside line. The default Line Type setting is PSTN (Public Switched
Telephone Network), which is a standard home phone line.
1. Press the home button, if necessary.
2. Select Settings > General Settings > Fax Settings > Basic Settings > Line Type > PBX.

You see a screen like this:
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3. Select Access Code and select Use.
4. Select the Access Code field and use the displayed keypad to enter the access code, such as 9.

Then select OK.
5. Select OK to exit.
Parent topic: Setting Up Basic Fax Features

Setting the Number of Rings to Answer
If you connect an external answering machine and select to receive faxes automatically, make sure the
Rings to Answer setting is correct. The number of rings should be higher than the number of rings your
answering machine is set to for answering a call.
1. Press the home button, if necessary.
2. Select Settings > General Settings > Fax Settings > Basic Settings > Rings to Answer.

You see a screen like this:

3. Select the number of rings and select OK. Make sure to select a number higher than the number of
rings your answering machine is set to for answering a call.

Note: An answering machine picks up every call faster than the product, but the product can detect fax
tones and start receiving faxes. If you answer the phone and hear a fax tone, check that the product has
started receiving the fax, then hang up the phone.

Parent topic: Setting Up Basic Fax Features

Selecting Advanced Fax Settings
You can select a variety of advanced fax settings.
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1. Press the home button, if necessary.
2. Select Settings > General Settings > Fax Settings.

You see a screen like this:

3. If you want to create shortcuts for up to three fax operations, select Quick Operation Button and
select a setting and a shortcut button.

Note: These shortcuts are displayed on the Fax Settings tab in the main Fax screen.

4. Select the group of settings you want to change.
Send Settings - Fax
Receive Settings - Fax
Report Settings - Fax
Basic Settings - Fax
Security Settings - Fax
Parent topic: Setting Up Fax Features

Send Settings - Fax
Select the send options you want to use for outgoing faxes.

Setting Options Description
Auto Rotation Off Sends an A4 or letter-size document that is placed

long edge first into the ADF as an A3-size faxOn
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Setting Options Description
Quick Memory Send Off Sends the first page of a multi-page document as

soon as it finishes scanning. Select this option to
decrease the amount of time it takes to fax a
document.

On

Batch Send Off Sorts outgoing faxes by recipient in the product's
memory, and then sends them as a batchOn

Save Failure Data Off Saves faxes that failed to be sent in the product’s
memory. You can resend the faxes from the product's
Status Menu.On

Parent topic: Selecting Advanced Fax Settings
Receive Settings - Fax

Select the save/forward or print options you want to use for incoming faxes.
Save/Forward Settings

Setting Options Description
Unconditional
Save/Forward

Save to Inbox Saves received faxes in product's inbox
Save to Computer Converts received faxes to PDFs and saves them on

a computer connected to the product
Save to Memory
Device

Converts received faxes to PDFs and saves them on
an external memory device connected to the product

Forward Forwards received faxes to another fax machine, or
converts them to PDFs and forwards them to a shared
folder on a network or an email address. Forwarded
faxes are deleted from the product.

Email Notifications Sends an email notification after a fax is received,
printed, saved, or forwarded

Conditional
Save/Forward

— Sets up conditions to save, forward, or print received
faxes. Select the arrow icon to enter conditions and
other settings. Select Enable to enable a condition.
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Setting Options Description
Common Settings Inbox Settings Sets up what happens when the fax memory is full, or

sets up a password for the inbox
Forward Settings Specifies a subject when forwarding a fax to an email

address

Print Settings

Setting Options Description
Auto Reduction On Select to reduce the size of large received faxes to fit

on the paper size in the selected paper source
Off Select to print large incoming faxes at their original

size on multiple sheets, if necessary
Split Page Settings Delete Print Data

After Split
Select how to split large incoming faxes across
multiple sheets

Overlap When
Split

Acting Print On (Split to Pages) Select to split large incoming faxes across multiple
sheets

On (Reduce to Fit) Select to reduce the size of large received faxes to fit
on the paper size in the selected paper source

Off Select to print large incoming faxes at their original
size on multiple sheets, if necessary

Auto Rotation On If you have loaded A5-size paper, select On to rotate
landscape-oriented incoming faxes so that they print
correctly on the paperOff

Add Reception
Information

On Select On to include the date, time, the sender's
information, and a page number in the header of your
incoming faxesOff

2-Sided On Select On to print incoming faxes double sided. You
can also select the Binding Margin.Off
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Setting Options Description
Print Start Timing All Pages

Received
Select to print incoming faxes after the product
receives all of the pages of the document

First Page
Received

Select to print incoming faxes as soon as the product
receives the first page of the document

Collation Stack On Select On to print incoming faxes so that the pages
are stacked in the correct page order. (When the
product is low on memory, this option may not be
available.)

Off

Print Suspend Time Off Select On to set a time period to stop automatic
printing of faxes or reports and save received faxes in
the product’s memory. (Make sure there is enough
free memory before using this function.)

On
Time to Stop
Time to Restart

Quiet Mode On Select On to reduce noise during printing. (Printing
speed may be reduced.)Off

Parent topic: Selecting Advanced Fax Settings
Report Settings - Fax

Select the options you want to use for fax reports.

Setting Options Description
Forwarding Report Print on Error Prints a report after forwarding a received document

only if an error occurs
Print Prints a report after forwarding a received document
Do Not Print Does not print a report after forwarding a received

document
Back Up Error Report On Select On to print a report when a backup error for

sending faxes occursOff



272

Setting Options Description
Fax Log Auto Print Off Does not print a fax log

On(Every 30) Prints a fax log after every 30 fax jobs are completed
On(Time) Prints a fax log at a specified time. If the number of

completed fax jobs exceeds 30, the fax log prints
before the specified time.

Attach Fax image to
report

Off Does not include an image on the Transmission
Report

On(Large Image) Prints a Transmission Report that includes the upper
part of the first page of the sent document

On(Small Image) Prints a Transmission Report that includes a reduced
size of the entire first page of the sent document

Report Format Simple Prints a simple fax report
Detail Prints a fax report that includes error codes

Output Method Print Prints fax reports
Save to Memory
Device

Saves fax reports to a memory device

Forward Forwards fax reports to a specified destination

Parent topic: Selecting Advanced Fax Settings
Basic Settings - Fax

Select the basic options you want to use for incoming and outgoing faxes.

Setting Options Description
Fax Speed Fast(33,600bps) Sets the speed at which you send and receive faxes

Medium(14,400bps)
Slow(9,600bps)



273

Setting Options Description
ECM On Turns on Error Correction Mode (ECM) to

automatically correct errors in sent or received fax
data

Off Turns off Error Correction Mode (ECM); color faxes
cannot be sent or received

Dial Tone Detection On Automatically dials the number you enter for faxing
when the product detects a dial tone

Off Turns off automatic dial tone detection, which may
be necessary if the product is connected to a PBX
(Private Branch Exchange) or a TA (Terminal
Adapter). However, turning this setting off may cause
the product to drop the first digit of a fax number.

Line Type PSTN Selects a standard phone line (Public Switched
Telephone Network)

PBX Selects Private Branch Exchange, the type of phone
line used in office environments where an access
code such as 9 must be used to call an outside line

Header Your Phone
Number

Select to enter the header information and your
phone number for inclusion on outgoing faxes

Fax Header
Receive Mode Manual Lets you confirm whether an incoming fax should be

printed; a telephone must be connected to the
product

Auto Automatically receives and prints faxes
Distinctive Ring All If you are using a Distinctive Ring Service on your

phone line, your telephone company can assign two
or more phone numbers to the same line and assign
different ring patterns to each. If you use this service,
select the number of rings for your fax number so
your product can receive faxes on the correct
number of rings. Select All for phones lines that do
not use this service.

Single
Double
Triple
Double&Triple
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Setting Options Description
Rings to Answer 1 to 9 Sets the number of rings before your product

receives a fax. If Receive Mode is set to Auto and an
answering machine is connected to the product,
make sure this setting is set higher than the number
of rings your answering machine is set to answer a
call.

Remote Receive Off Lets you start receiving faxes using your phone
instead of operating the product (if the Receive Mode
is set to Auto). When you select On, you must also
set a Start Code. If you are using a cordless handset
with its base connected to the product, you can start
receiving the fax by entering the code using the
handset.

On
Start Code

Rejection Fax Various Lets you automatically reject faxes from blocked
numbers, with blank headers, or from unrecognized
contacts

Receiving Paper Size A4/Letter Select the maximum paper size for faxes that the
product can receive.B4

A3/11x17
Auto

Parent topic: Selecting Advanced Fax Settings
Security Settings - Fax

Select the security options you want to use for fax data.

Setting Options Description
Direct Dialing
Restrictions

Off Does not restrict dialed fax numbers
On Allows faxing only to numbers stored in the contacts

list or history
Enter Twice Requires you to enter fax numbers twice to prevent

errors
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Setting Options Description
Confirm Address List Off Selects whether or not to display a recipient

confirmation screen before a fax is sentOn
Backup Data Auto Clear Off Automatically erases sent or received fax data from

your product's memoryOn
Clear Backup Data — Deletes all sent or received fax data remaining in your

product's memory; run this function if you are giving
away or disposing of your product

Parent topic: Selecting Advanced Fax Settings

Setting Up the Fax Utility - Windows
You can set up the FAX Utility for Windows for use with your product.

Note: Before using the FAX Utility for Windows, make sure you have set up the fax features on your
product using the product control panel. Also first confirm that you can send and receive faxes using the
control panel.

1. Do one of the following:

• Windows 10: Click and select EPSON Software.
• Windows 8.x: Navigate to the Apps screen.

• Windows (other versions): Click or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
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The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click Return to the main window at the bottom of the window.
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You see this window:

4. Click Select Printer and follow the on-screen instructions to transfer your product's fax settings to
the FAX Utility.

Note: For detailed information, click Help or Open Online Help.

Parent topic: Setting Up Fax Features

Setting Up Fax Features Using the Fax Utility - Mac
You can set up your fax header and select your fax settings using the FAX Utility for Mac.
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1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select the FAX option for your product, and select Options & Supplies.
Select Utility and select Open Printer Utility.

2. Double-click FAX Utility, if necessary.
You see this window:

3. Select your FAX product in the Printer list.
4. Select Fax Settings.
5. Follow the prompts that appear on the screen to enter your fax header information and select your

fax settings.

Note: For detailed information, select the FAX Utility ? icon.

Parent topic: Setting Up Fax Features

Setting Up Contacts and Contact Groups
You can set up a list of contacts and their fax numbers so you can quickly select them for faxing. You
can also set up contact groups to send a fax message to multiple contacts.
Setting Up Contacts Using the Product Control Panel
Importing Contacts Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac
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Parent topic: Faxing
Related tasks
Importing Contacts Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac

Setting Up Contacts Using the Product Control Panel
You can set up your contacts and contact groups using the control panel on your product.

Note: Contacts can be locked by an administrator. If you cannot access or change contacts, contact
your administrator for assistance.

Creating a Contact
Editing or Deleting a Contact
Creating a Contact Group
Editing or Deleting a Contact Group
Parent topic: Setting Up Contacts and Contact Groups

Creating a Contact
You can create a list of contacts to save frequently used fax numbers.

Note: You can create up to 200 contacts and contact groups combined.

1. Press the home button, if necessary.
2. Select Fax.

You see a screen like this:
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3. Select Contacts.
You see a screen like this:

4. Select the icon.
5. Select Add Contact.

You see a screen like this:

6. Select the registry number you want to use for the contact you are adding.
7. Select the Name field, use the displayed keyboard to enter the contact name (up to 30 characters),

and select OK.
8. Select the Index Word field, use the displayed keyboard to enter a word to use when searching for

an entry (up to 30 characters), and select OK. (This field is optional.)
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9. Select the Fax Number field, use the numeric keypad on the LCD screen or the buttons on the
product to enter the fax number, and select OK. You can enter up to 64 characters.

Note: If necessary, enter an outside line access code (such as 9) at the beginning of the fax number.
If the access code has been set up in the Line Type setting, enter the # pound sign instead of the
code.

10. If you are sending a fax to a confidential box or relay box, enter a sub-address and password in the
Subaddress (SUB/SEP) and Password (SID/PWD) fields.

11. Select any additional settings as necessary.
12. Select OK to save the entry.
Parent topic: Setting Up Contacts Using the Product Control Panel

Editing or Deleting a Contact
You can edit or delete any of the contacts on your list.
1. Press the home button, if necessary.
2. Select Fax.

You see a screen like this:

3. Select Contacts.
4. Select the tab containing the first letter of the contact name, then select the > icon next to the contact

you want to edit or delete.
5. Do one of the following:

• To delete the contact, select Delete and select Yes on the confirmation screen.
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• To edit the contact, select Edit, select the item you want to change, enter the correct information,
and select OK. When you are finished editing, select OK.

Parent topic: Setting Up Contacts Using the Product Control Panel
Creating a Contact Group

You can create a group of contacts so that you can easily send faxes to multiple recipients.

Note: You can create up to 200 contacts and contact groups combined. You must create a contact
before creating a contact group.

1. Press the home button, if necessary.
2. Select Fax.

You see a screen like this:

3. Select Contacts.

4. Select the Add Contact icon.
5. Select Add Group.
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You see a screen like this:

6. Select the registry number you want to use for the group you are adding.
7. Select the Group Name field, use the displayed keyboard to enter the group name (up to 30

characters), and select OK.
8. Select the Index Word field, use the displayed keyboard to enter a word to use when searching for a

group (up to 30 characters), and select OK. (This field is optional.)
9. Select the Contact(s) Added to the Group field.

You see your contacts list.
10. Select each contact you want to include in your group.

A check mark appears next to each selected contact.
11. Select Close when complete.
12. Select Assign to Frequent Use to list the group on the Recipient tab.
13. Select OK to save the group.
Parent topic: Setting Up Contacts Using the Product Control Panel

Editing or Deleting a Contact Group
You can edit an existing contact group to add or delete entries. You can also delete the entire contact
group.
1. Press the home button, if necessary.
2. Select Fax.



284

You see a screen like this:

3. Select Contacts.
4. Select the > icon next to the group you want to edit or delete.

You see a screen like this:

5. Do one of the following:
• To delete the group, select Delete and select Yes on the confirmation screen.
• To edit the group, select Edit and change the group name or contacts included as necessary.

6. Select OK when complete.
Parent topic: Setting Up Contacts Using the Product Control Panel

Importing Contacts Using the Fax Utility - Windows
You can edit contacts stored in your product and import contacts from your Windows Address Book to
the PC-FAX Phone Book in the FAX Utility for Windows.



285

1. Do one of the following:

• Windows 10: Click and select EPSON Software.
• Windows 8.x: Navigate to the Apps screen.

• Windows (other versions): Click or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.

The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click Return to the main window at the bottom of the window.



286

You see this window:

4. To edit the contacts list on your product, click Contacts.
5. Do one of the following:

• To edit a contact, select it in the list and click the icon.

• To delete a contact, select it in the list and click the icon.
6. To import fax numbers from your Windows Address Book into the FAX Utility PC-FAX Phone Book,

select Edit PC-FAX Phone Book.
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You see this window:

7. Select File > Import From Windows Address Book.
8. Select the contacts you want to import and click OK.

Note: For detailed information, select Help or Open Online Help.

Parent topic: Setting Up Contacts and Contact Groups
Related topics
Setting Up Contacts and Contact Groups

Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac
You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import
fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select the FAX option for your product, and select Options & Supplies.
Select Utility and select Open Printer Utility.

2. Double-click FAX Utility, if necessary.
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You see this window:

3. Select your FAX product in the Printer list.
4. Select Speed Dial/Group Dial List.

You see this window:

5. To add an entry, double-click an empty entry.

Note: To edit an entry, select it and change the information. To delete an entry, select it and press
the Delete key on your keyboard.
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6. Do one of the following:
• To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.
• To create a group dial entry, select Group Dial, enter a name, select your desired fax numbers,

and click OK.
7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.

8. To import entries from your MacAddress book, click the icon.

9. When you are finished, click the icon to save the entries to your product's memory.
Parent topic: Setting Up Contacts and Contact Groups
Related topics
Setting Up Contacts and Contact Groups

Sending Faxes
See these sections to send faxes using your product.
Sending Faxes from the Product Control Panel
Sending Faxes Using the Fax Utility - Windows
Sending Faxes Using the Fax Utility - Mac
Parent topic: Faxing

Sending Faxes from the Product Control Panel
See these sections to send faxes using the product's control panel.
Sending a Fax Using the Keypad, Contact List, or History
Fax Sending Options
Sending a Fax at a Specified Time
Sending a Fax on Demand
Sending a Stored Fax
Dialing Fax Numbers from a Connected Telephone
Parent topic: Sending Faxes

Sending a Fax Using the Keypad, Contact List, or History
You can send a fax from your product control panel by entering the fax number, or selecting the number
from either the contact list or fax history.
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Note: You can send a black-and-white fax to up to 100 contacts or 99 groups at a time, or send a color
fax to one recipient at a time. If your recipient's fax machine does not print in color, your fax is
automatically sent in black-and-white.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.

You see a screen like this:

Note: To fax a double-sided document, place your document in the ADF and turn on the ADF 2-
Sided setting. (You cannot fax double-sided documents in color.)

4. Do one of the following to select fax recipients:
• Manually enter a fax number: Select Keypad, enter a fax number, and select OK. To add

another fax number, repeat the same steps. You can also use the numeric keypad on the control
panel to enter a fax number.

Note: If direct dialing has been restricted, you can only select the number from the contact list or
fax history. If necessary, enter an outside line access code (such as 9) at the beginning of the fax
number. If the access code has been set up in the Line Type setting, enter the # pound sign
instead of the code. If your fax number requires a brief pause, select the - icon to insert a pause
symbol (–).

• Select from the contact list: Select Contacts to display the contact list. Select one or more
contacts (select the contacts again to deselect it). You can also select the Search for Contacts
field to search for recipients by name, index name, or entry number. Select Close when you are
finished.
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• Select from the sent fax history: Select Recent to display the sent fax history. Select a recipient
from the list.

Note: To delete entered recipients, select the Select Recipient field, select the recipient you want to
delete, and select Remove.

5. If you need to change any fax settings, select Fax Settings and select your settings.

6. If you want to preview your fax in black-and-white on the LCD, press the icon. (If the preview
looks incorrect, select Retry, reposition the document or change the fax settings, and repeat this
step.) You cannot send the fax in color after previewing it.

Note: If you do not touch the preview screen for 20 seconds, your product sends the fax
automatically. You cannot preview images when the Direct Send setting is turned on.

7. If you want to save your fax settings for later use, select Presets and add a new entry.
8. Press the Send icon.

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: Your product does not save sent color faxes to its memory. If the Settings > General Settings >
Fax Settings > Send Settings > Save Failure Data setting is enabled, faxes that failed to send are
stored to the product's memory and you can resend them from the Status Menu screen.

Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
Related tasks
Using Presets
Selecting the Line Type
Related topics
Setting Up Contacts and Contact Groups
Placing Originals on the Product
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Fax Sending Options
While sending a fax, you can select Fax Settings and select these options.

Setting Options Description
Original Size (Glass) Various sizes Sets the size for a document placed on the scanner

glass
Original Type Text Specifies the document type of your originals and

adjusts the quality of your copiesText & Image
Photo

Color Mode B&W Select whether to scan images in black and white or
colorColor

Resolution Standard Adjusts the scan resolution and print quality of
outgoing faxesFine

Super Fine
Ultra Fine

Density Varying levels Lets you select from various density levels
Remove Background Auto Automatically removes any background color on

scanned images
Varying levels
available

Lets you select from various levels of background
color adjustment

Sharpness Varying levels
available

Lets you adjust the sharpness level of outgoing faxes

ADF 2-Sided Off Select On to enable 2-sided faxing from the ADF. The
Direct Send option and color faxing are disabled when
you turn on this setting.On
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Setting Options Description
Continuous Scan (ADF) Off Select On to have the product to prompt if you want to

scan another page after a document in the ADF has
finished scanning.
If you leave the product with the prompt displayed for
20 seconds, the product starts sending the document.
If you load multiple sizes of documents in a single
batch, they are sent at the size of the largest
document. To send them at their original size, do not
mix sizes in the ADF.

On

Direct Send Off Select On to send black-and-white faxes to a single
recipient as soon as the connection is made, without
saving the scanned image to memory. You cannot
use this setting when sending a color fax or sending a
fax to multiple recipients.

On

Priority Send Off Select On to send the current fax before other faxes
waiting to be sentOn

Send Fax Later Off Select On to send the current fax at a selected time
On

Add Sender Information Off Lets you include a header, your phone number, or a
destination list in the selected location on your
outgoing faxesOutside of Image

Inside of Image
Notify Send Result Off Sends a notification to the selected email address

when an outgoing fax is sentOn
Transmission Report Print on Error Lets you select when to print transmission reports

Print
Do Not Print

Backup Off Saves a copy of the scanned fax to the selected email
address or network folder/FTP locationOn

Parent topic: Sending Faxes from the Product Control Panel
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Sending a Fax at a Specified Time
You can send a fax at a time of your choice.

Note: Make sure the product's date and time settings are correct. You can only send faxes in black-and-
white when you use this option.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.

You see a screen like this:

4. Enter a fax number or select a number from the Contacts or Recent lists.
5. Select Fax Settings.
6. Select Send Fax Later.
7. Select On.
8. Select Time, use the displayed keypad on the LCD screen to enter your desired time, and select

OK.
9. Select Send.

Note: To cancel faxing, select Cancel.

After scanning your originals, your product dials the number and sends the fax at the specified time.

Note: If the product is turned off at the specified time, the fax is sent when it is powered on.
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Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
Related tasks
Selecting the Date and Time
Related topics
Placing Originals on the Product
Setting Up Contacts and Contact Groups

Sending a Fax on Demand
You can store up to 10 scanned documents (up to 100 black-and-white pages) and have them sent
automatically when another fax machine requests them. Other fax users can receive the document by
calling your fax number and using the polling receive function on their fax machines.

Note: If you try to store more than 10 jobs or 100 pages, they overwrite previously stored documents. Be
sure to check how many fax jobs are stored before storing additional jobs.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax Box.

You see a screen like this:

4. Select Polling Send/Board.
5. Select Polling Send.
6. If you need to change any fax settings, select the icon, select Settings, and change the settings.
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7. Select Add Document.

8. Select Store.
Your document is scanned and stored until you overwrite it or delete it.

Note: To display the stored job, press the Job/Status button.

Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
Related topics
Placing Originals on the Product

Sending a Stored Fax
You can store up to 10 scanned documents (up to 100 black-and-white pages) and send them whenever
necessary.

Note: If you try to store more than 10 jobs or 100 pages, they overwrite previously stored documents. Be
sure to check how many fax jobs are stored before storing additional jobs by running a Fax Report.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.

You see a screen like this:

4. Select the icon.
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5. Select Extended Fax.
6. Select Store Fax Data to turn on the setting and select Close.
7. Select any other fax settings as necessary and select Close.
8. Select Store.
9. When you are ready to send the document, press the home button if necessary and select Fax

Box.
10. Select Stored Documents.
11. Select the stored fax job you want to send.
12. Select Start Sending.
Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
Related topics
Placing Originals on the Product

Dialing Fax Numbers from a Connected Telephone
If you connected a telephone to the EXT port on your product, you can send a fax by dialing the fax
number from the connected telephone. If the recipient's phone number and fax number are the same,
you can speak to the recipient before sending the fax.
1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Dial the fax number from the connected telephone. Speak to the recipient if necessary.

Note: If you are using a pre-paid calling card, enter the number and password required to use the
card before entering the destination fax number.

4. Select Fax on the LCD screen.
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You see this screen:

5. Select Fax Settings and select settings as necessary.

Note: Your product now communicates with the recipient's fax machine. Do not hang up the
telephone.

6. When you hear a fax tone, select Send to start sending the fax.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

7. Hang up the telephone.
Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
Related topics
Placing Originals on the Product

Sending Faxes Using the Fax Utility - Windows
You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time,
including a cover sheet.
1. Open the file you want to fax and select the print command.
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You see a window like this:

2. Select your product with the FAX option as the printer.
3. To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the

Preferences or Properties button, then click OK.

Note: If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties
on the next screen. For more information about selecting fax print settings, click Help.

4. Select the Page Range as necessary. (Leave the Number of copies set to 1.)
5. Click Print or OK.
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If you’re faxing for the first time, you see a window like this one:

6. Enter your sender information so that recipients can identify the origin of the fax. Then click OK to
save the sender information.
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You see a window like this:

7. Enter the recipient's name and fax number or select a recipient from the phonebook, then click Next.

Note: For detailed instructions on using the Epson FAX Utility, click Help.

8. Select a cover sheet and enter a subject and message, then click Next.
9. Click Send to transmit your fax.
Parent topic: Sending Faxes

Sending Faxes Using the Fax Utility - Mac
You can send a fax from a Mac printing program using the FAX Utility. You can fax up to 100 pages at a
time, including a cover sheet.
1. Open the file you want to fax.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product FAX option as the Printer setting.
4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the

print window.
5. Select the number of pages you are faxing as the Pages setting.

Note: Leave the Copies setting set to 1.

6. Select Recipient Settings from the pop-up menu.
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You see this window:

7. Do one of the following to choose your recipient:
• Select a name or group from the Recipient List.
• Enter a name, company, and fax number and click the + button.

• Click the icon and select a recipient from your address book.
8. Select Fax Settings from the pop-up menu.
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You see this window:

9. Select the Color and Image Quality settings you want to use for your fax.
10. Click Fax.
Parent topic: Sending Faxes

Receiving Faxes
See these sections to receive faxes with your product.
Fax Reception
Receiving Faxes Automatically
Receiving Faxes Manually
Forwarding Received Faxes
Receiving a Fax by Polling
Saving Faxes to an External USB Device
Saving and Viewing Received Faxes
Selecting Received Fax Options Using the Fax Utility - Windows
Parent topic: Faxing

Fax Reception
Your product will automatically receive and print faxes when you set the Receive Mode to Auto.
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If you connected a telephone to your product so you can use the same phone line for faxes and voice
calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone
using the telephone and press a button on your product to receive the fax.
Make sure to load paper in your product and select your fax settings before receiving a fax.

Note: If you run out of paper during fax printing, load more paper and press the button indicated on your
product's LCD screen to continue.

Parent topic: Receiving Faxes

Receiving Faxes Automatically
To receive faxes automatically, make sure Receive Mode is set to Auto (the default setting for the
product).
To change the Receive Mode if necessary, select Settings > General Settings > Fax Settings > Basic
Settings > Receive Mode.
If an answering machine is connected, make sure the product's Rings to Answer setting is set higher
than the number of rings your answering machine is set to answer a call. For example, if the answering
machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.
Parent topic: Receiving Faxes
Related references
Basic Settings - Fax
Related tasks
Receiving Faxes Manually

Receiving Faxes Manually
You can set up your product to receive faxes manually by setting the Receive Mode to Manual. This lets
you check for a fax tone on the connected telephone before receiving a fax.
1. To change the Receive Mode, select Settings > General Settings > Fax Settings > Basic

Settings > Receive Mode and select Manual.
2. When the connected telephone rings, answer the call.
3. If you hear a fax tone, select Fax on the LCD screen.
4. Select Send/Receive.
5. Select Receive.
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6. Select Receive again to start receiving the fax.
7. Hang up the telephone.
Parent topic: Receiving Faxes
Related references
Basic Settings - Fax
Related tasks
Receiving Faxes Automatically

Forwarding Received Faxes
You can forward received faxes to another fax machine, or convert the faxes into PDF documents and
forward them to a shared folder on the network or to an email address. Forwarded faxes are deleted
from the product's memory.
Before using this feature, make sure the date and time are set correctly, the forwarding destination is set
up in the contact list, and the email server settings are configured.
1. Press the home button, if necessary.
2. Select Settings > General Settings > Fax Settings > Receive Settings > Save/Forward Settings

> Unconditional Save/Forward > Forward.
3. Select Yes.

Note: If you want to print the fax automatically before forwarding it, select Yes and Print.

4. Select Add Entry, select the forwarding destination from the contacts list, and select Close.
5. Confirm the displayed forwarding destinations and select Close.
6. Under Options When Forwarding Failed, select whether you want to print the faxes or save them in

the printer's inbox if forwarding the received fax fails.
Parent topic: Receiving Faxes

Receiving a Fax by Polling
You can use polling to receive a fax from another fax machine (such as a fax information service).

Note: You cannot use polling to receive a fax from a fax information service that uses audio guidance.

1. Press the home button, if necessary.
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2. Select Fax.
You see a screen like this:

3. Select the icon.
4. Select Extended Fax.
5. Select Polling Receive to turn on the setting and select Close.
6. Select Close.
7. Enter the fax number you expect to receive the fax from.
8. Select Polling to start receiving the fax.
Parent topic: Receiving Faxes

Saving Faxes to an External USB Device
You can save incoming faxes to an external USB device connected to your product.
1. Insert an external USB device into the product's USB port.
2. Press the home button, if necessary.
3. Select Settings > General Settings > Fax Settings > Receive Settings > Save/Forward Settings

> Unconditional Save/Forward.
4. Select Save to Memory Device
5. Select Yes to save the fax or Yes and Print to save and print the fax.
Parent topic: Receiving Faxes
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Saving and Viewing Received Faxes
You can save received faxes in your product's memory and view them on the LCD screen. The inbox
and confidential boxes can hold a maximum of 200 faxes in total.

Note: The inbox can be locked by an administrator. If you cannot access the inbox, contact your
administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings > General Settings > Fax Settings.
3. To save received faxes, select Receive Settings > Save/Forward Settings > Unconditional

Save/Forward.
4. Select Save to Inbox to turn on the setting.
5. Press the home button again.
6. Select Fax Box.

You see a screen like this:

7. Do one of the following to view stored faxes:
• Select Inbox/Confidential to view received faxes.
• Select Stored Documents to view saved faxes that have not been sent (available only when

Store Fax Data is turned on).
• Select Polling Send/Board to view faxes that are stored for fax polling or stored in a bulletin

board.
8. Select the fax you want to view.
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The LCD screen displays the fax contents.
9. If you want to print or forward a stored fax, select the icon.
10. Select one of the printing or forwarding options, and follow the on-screen instructions.

Note: Delete faxes after you print or view them to free up the product's memory. When the memory is
full, you can only forward or print incoming faxes.

Parent topic: Receiving Faxes

Selecting Received Fax Options Using the Fax Utility - Windows
You can select options for use with received faxes using the FAX Utility for Windows.
1. Do one of the following:

• Windows 10: Click and select EPSON Software.
• Windows 8.x: Navigate to the Apps screen.

• Windows (other versions): Click or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
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The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click Close at the bottom of the window.



311

You see this window:

4. To save faxes received by your product on your computer, select Save received faxes on this
computer.

5. Select the destination folder and other options, and click OK.
You return to the FAX Utility window.

6. To receive notifications when received faxes arrive in the selected destination folder on your
computer, select Notify me if new faxes exist in forwarding folders.
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7. Select how often you want to be notified of received faxes and click OK.

Note: For detailed information, click Help or Open Online Help.

Parent topic: Receiving Faxes

Checking Fax Status
You can check the status of fax jobs on the product control panel.
1. Press the home button, if necessary.
2. Select Fax.

You see a screen like this:

3. Select the icon.
4. To check the history of faxes that have been sent or received, select Transmission Log and select

the job you want to check.

Note: If you see a numbered icon above the icon on your product's LCD screen or the
Received Fax light is flashing, received faxes have been temporarily saved to the product's

memory.

5. To check the status of a fax in progress, press the Job/Status button.
Parent topic: Faxing
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Printing Fax Reports
You can print several types of fax reports whenever necessary. You can also print the fax log
automatically by turning on Fax Log Auto Print.
1. Press the home button, if necessary.
2. Select Fax.

You see a screen like this:

3. Press the icon.
4. Select Fax Report.
5. Select the fax report you want to print.
Fax Report Options
Parent topic: Faxing

Fax Report Options
Select the fax report or list you want to print.
Last Transmission

Print a report on the fax that was previously sent or received through polling.
Fax Log

Print a report on recent fax transmissions.
Stored Fax Documents

Print a list of the fax jobs currently stored in the product's memory.
Fax Settings List

Print a list of the current fax communication settings.
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Conditional Save/Forward List
Print a list of the current conditional save/forward settings.

Protocol Trace
Print a detailed report for the previously sent or received fax.

Parent topic: Printing Fax Reports
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Using External USB Devices with Your Product
Follow the instructions here to work with an external USB device connected to your product.
Connecting a USB Device
Disconnecting a USB Device
Viewing and Printing from the LCD Screen
Transferring Files on a USB Device

Connecting a USB Device
Connect a USB device or its USB cable to the USB port on the front of the product.

Note: Epson cannot guarantee the compatibility of your device. Make sure the files on the device are
compatible with the product.

USB Device Photo File Specifications
Parent topic: Using External USB Devices with Your Product
Related tasks
Disconnecting a USB Device

USB Device Photo File Specifications
You can use USB devices with your product containing files that meet these specifications.

File format JPEG with the Exif version 2.3 standard taken by digital cameras
with the DCF (Design Rule for Camera File system) version 1.0 or
2.0 standard
TIFF 6.0-compliant uncompressed images: RGB full-color or binary
(not CCITT-encoded)
PDF version 1.7 compliant data

Image size 80 × 80 pixels to 10200 × 10200 pixels
File size Up to 2GB
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Number of files JPEG: Up to 9990*
TIFF: Up to 999
PDF: Up to 999

* If the number of files exceeds 999, the files are displayed in groups.
Parent topic: Connecting a USB Device

Disconnecting a USB Device
After you finish working with a USB device, follow these steps to remove it.
1. If your product is connected to your computer using a USB cable, do one of the following:

• Windows: Open the My Computer, Computer, This PC, or Windows Explorer utility. Then
right-click the name of your USB device (listed as a removable disk) and select Eject.

• Mac: Drag the removable disk icon for your USB device from the desktop into the trash.

Caution: Do not remove a USB device before completing the procedure above or you may lose data
from the flash drive.

2. Pull the USB device or cable out of the USB port on the front of the product.
Parent topic: Using External USB Devices with Your Product

Viewing and Printing from the LCD Screen
See these sections to view and print photos or other files displayed on your product's LCD screen.
Printing JPEG Photos
Printing TIFF and PDF Files
Print Setting Options - Device Mode
Parent topic: Using External USB Devices with Your Product

Printing JPEG Photos
You can select JPEG photos for printing as you view them on the LCD screen.
1. Press the home button, if necessary.
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2. Select Memory Device.

3. Select JPEG.

Note: If you have more than 999 JPEG images on your device, the images are divided into groups,
and you must first select the group you want to display.

4. Do one of the following to select your photos:
• In Tile View, select the thumbnail images of the photos you want to print.
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• In Single View, select the image of the photo you want to print, then select the left or right arrow
buttons to scroll through and select additional photos, or select Tile View to return to the
thumbnail image view and select additional photos.

• To select all photos, select the menu icon and select Select All Images.
5. Select Proceed to Print.
6. To change the print settings, select Basic Settings and select the necessary settings.
7. To adjust the photos (adjustments modify only your printed copies, not the original files), select

Advanced and make the necessary adjustments.
8. Use the numeric keypad on the control panel or select Copies on the LCD screen and use the

numeric keypad on the screen to select the number of copies (up to 99).

9. When you are ready to print, select the Print icon.

Note: To cancel printing, press the stop button or select Cancel on the LCD screen, then select
Cancel again to confirm.

Parent topic: Viewing and Printing from the LCD Screen
Related references
Print Setting Options - Device Mode

Printing TIFF and PDF Files
You can select and print TIFF or PDF files from a USB flash drive.
1. Press the home button, if necessary.
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2. Select Memory Device.
3. Select TIFF or PDF.

You see a list of the available files.
4. Select the file you want to print.

You see information about the file.
5. Do the following as necessary:

• To print more than one copy, use the numeric keypad on the control panel or select Copies on the
LCD screen and use the numeric keypad on the screen to select the number of copies (up to 99).

• To change the print settings, select Basic Settings or Advanced and select the necessary
settings.

6. When you are ready to print, select the Print icon.

Note: To cancel printing, press the stop button or select Cancel on the LCD screen, then select
Cancel again to confirm.

Parent topic: Viewing and Printing from the LCD Screen
Related references
Print Setting Options - Device Mode

Print Setting Options - Device Mode
Select the print settings you want to use when printing from a USB device.

Note: Not all options or settings may be available, depending on the file format.

Basic Settings

Print settings Available options Description
Paper Setting Various paper size

and type settings
Indicates the source that contains the paper size and type
you want to print on

Color Mode B&W Prints the photo in black and white
Color Prints the photo in color
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Advanced settings

Print settings Available options Description
Layout 1-up Print one photo per page

20-up Print 20 photos per page
Index Print numbered photo thumbnails with date information

Fit Frame On Automatically crops the photo to fit into the selected photo
layout

Off Turns off automatic cropping
Quality Standard Provides good quality for most prints

Best Provides the highest quality for special prints
Date Various date formats Prints the date the photo was taken on the photo in the

format you select
Fix Photo Auto Optimizes the Fix Photo adjustments for specific types of

photos; select the option that best matches your photo
contentPeople

Landscape
Night Scene
Enhance Off

Fix Red-Eye On Automatically fixes the red-eye effect in photos
Off

2-Sided On Select On to print a document double sided. You can also
select the binding margin.Off

Print Order Last Page on Top Select the printing order for multi-page documents.
First Page on Top

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Viewing and Printing from the LCD Screen
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Transferring Files on a USB Device
You can transfer files to and from a USB device inserted into the USB port on the front of your product.
Setting Up File Sharing for File Transfers from Your Computer
Transferring Files from a USB Device to Your Computer
Parent topic: Using External USB Devices with Your Product

Setting Up File Sharing for File Transfers from Your Computer
Before you transfer files from a computer to a USB device inserted into the USB port on the front of your
product, you may need to set up your product's file sharing settings.

Caution: Remove the USB device before you change this setting or you may lose data from the device.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.

You see a screen like this:

4. Select Printer Settings.
5. Select Memory Device Interface.
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You see a screen like this:

6. Make sure Memory Device is set to Enable.
7. Select File Sharing.
8. Select the way your computer is connected to the product: either USB or Network.
Parent topic: Transferring Files on a USB Device
Related tasks
Disconnecting a USB Device

Transferring Files from a USB Device to Your Computer
You can transfer files to and from a USB device inserted into the USB port on the front of your product
and a computer connected to your product.

Note: Do not transfer files to and from a USB device while you are printing from the device.

1. Make sure your product is connected to a computer.
2. Insert a USB device or its USB cable into the USB port on the front of your product.
3. Do one of the following to access your USB device files from your computer:

• Windows: Open the My Computer, Computer, This PC, or Windows Explorer utility, then
select the removable disk icon.

• Mac with a USB connection: Look for the removable disk icon on your desktop, then select it.
• Mac with a network connection: Select the hard drive icon on your desktop or select Computer

from the Go menu, select your product in the SHARED section of the sidebar (you may need to
widen the sidebar to see the name), and select the USBSTORAGE icon.
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4. Select the folder that contains your files.
5. Drag the files you want to transfer to the desired folder on your computer or on your USB device.

Note: Your product's LCD screen does not update to display new information about your USB device
after you copy files to it or delete files from it. Remove and insert the USB device to update the
information.

Parent topic: Transferring Files on a USB Device
Related tasks
Connecting a USB Device
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Replacing Ink Cartridges, Maintenance Boxes, and Cassette
Rollers

When ink is expended, or the maintenance box and cassette rollers are at the end of their service life,
you need to replace them. The maintenance box stores ink that gets flushed from the system during print
head cleaning.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly
and in accordance with local requirements. If you would like to return your used ink cartridges and
maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing Ink Cartridges
Printing with Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows
Maintenance Box Replacement
Replacing the Rollers for Paper Cassette 1
Replacing the Rollers for Paper Cassettes 2 to 4
Resetting the Roller Counter on the LCD Screen

Check Cartridge and Maintenance Box Status
Your product and its software will let you know when an ink cartridge is low or expended, or when the
maintenance box needs to be replaced.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can check ink cartridge and maintenance box status by using the printer buttons or the utilities
included with the standard Epson printer software. To download the standard Epson printer software,
visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and
select your product.

Checking Ink Status on the LCD Screen
Checking Ink and Maintenance Box Status – Windows
Checking Cartridge and Maintenance Box Status - Mac
Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

http://www.epson.com/recycle
http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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Checking Ink Status on the LCD Screen
When one of your ink cartridges is low or expended, you see a message on the LCD screen. Tap How
To and follow the steps on the LCD screen to replace the ink cartridge.
You can also check the status of the ink cartridges and maintenance box from the product control panel.

Note: You can still print when you see the low ink warning message. Replace the ink cartridges when
required.

1. Press the home button, if necessary.

2. Select the icon.
You see a screen like this:

The ink and maintenance box levels are displayed at the bottom of the screen.

Note: The displayed ink and maintenance box levels are approximate.

3. For more information, select the ink images at the bottom of the screen.
Parent topic: Check Cartridge and Maintenance Box Status
Related concepts
Maintenance Box Replacement
Related tasks
Removing and Installing Ink Cartridges
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Checking Ink and Maintenance Box Status – Windows
You can check your ink or maintenance box status at any time using a utility on your Windows computer.

1. To check your status, access the Windows Desktop and double-click the icon for your product in
the right side of the Windows taskbar, or click the up arrow and double-click . Then click Details.
You see this window:
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2. Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

Note: If any of the ink cartridges installed in the product is broken, incompatible with the product
model, or improperly installed, Epson Status Monitor will not display an accurate ink status.

3. To disable promotional offers, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
You see this window:
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4. Deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge and Maintenance Box Status
Related concepts
Maintenance Box Replacement
Related tasks
Removing and Installing Ink Cartridges

Checking Cartridge and Maintenance Box Status - Mac
You can check the status of your ink cartridges and maintenance box using a utility on your Mac.
1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
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You see this window:

3. Do the following as necessary:
• You can update the ink cartridge and maintenance box status by clicking Update.
• Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge and Maintenance Box Status
Related concepts
Maintenance Box Replacement
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Related tasks
Removing and Installing Ink Cartridges

Purchase Epson Ink Cartridges and Maintenance Box
You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales),
epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from
an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S.
or 800-807-7766 in Canada.

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.
The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge Part Numbers
Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

Ink Cartridge Part Numbers
Use these part numbers when you order or purchase new ink cartridges.
Maintenance box part number: T6714

Ink color Part number
Standard capacity High-capacity Extra High-capacity

Black T912 T912XL T912XXL
Cyan T912 T912XL T912XXL
Magenta T912 T912XL T912XXL
Yellow T912 T912XL T912XXL

Parent topic: Purchase Epson Ink Cartridges and Maintenance Box

https://www.epson.com
https://www.epson.ca
https://epson.com.jm
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Removing and Installing Ink Cartridges
Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

1. Turn on your product.
2. If an ink cartridge is low or expended, a message appears on your product and on your computer

screen. Note which cartridges need to be replaced.
3. Open the front cover.
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4. Push the ink cartridge in, then pull it out of the slot.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.
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5. Remove the new cartridge from the package.

Caution: Do not touch the green chip on the cartridge. Install the new cartridge immediately after
removing the old one; if you do not, the print head may dry out and be unable to print.

6. Gently shake the ink cartridge horizontally about fifteen times.

Caution: Do not remove any labels or seals, or ink will leak.
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7. Insert the new cartridge into the holder and push it in until it clicks into place.

8. When you are finished, close the front cover.

The product starts charging the ink and returns to its previous state when finished.

Note: Do not turn off the printer during ink replacement.

Caution: If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as the printer. The valve in the ink supply port is designed to contain
any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with
the label facing up; do not store cartridges upside-down.

Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers
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Related concepts
Purchase Epson Ink Cartridges and Maintenance Box

Printing with Black Ink and Expended Color Cartridges
When a color ink cartridge is expended, you can temporarily continue printing from your computer using
black ink. Replace the expended color cartridge as soon as possible for future printing.

Note: You cannot print with expended color ink cartridges using your product's control panel.

Printing with Expended Color Cartridges - Windows
Printing with Expended Color Cartridges - Mac
Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

Printing with Expended Color Cartridges - Windows
If you see a message during printing telling you that you can temporarily print in black ink with an
expended color cartridge, you can cancel your print job and select settings to print on plain paper or on
an envelope.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Note: To use this feature, Epson Status Monitor must be enabled.

1. Click Cancel or Cancel Print to cancel your print job.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

2. Load plain paper or an envelope in your product.
3. Access the print settings in your print application.
4. Click the Main tab.
5. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
6. Select the Black/Grayscale Color setting.
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7. Click OK.
8. Print your document.

Epson Status Monitor 3 displays a print message.
9. Click Print in Black to print your document.
Parent topic: Printing with Black Ink and Expended Color Cartridges

Printing with Expended Color Cartridges - Mac
If printing stops, you can cancel your print job and select settings to temporarily print with only black ink
on plain paper or on an envelope.
1. Click the printer icon in the Dock.
2. If you see a message telling you that you can temporarily print with only black ink, click the Delete or

button to cancel your print job. If you see an error message, click OK.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

3. In the Apple menu or the Dock, select System Preferences.
4. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
5. Select Driver or Options.
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You see a screen like this:

6. Select On as the Permit temporary black printing setting.
7. Click OK.
8. Close the utility window.
9. Load plain paper or an envelope in your product.
10. Access the print settings in your print application.
11. Select Print Settings from the pop-up menu.
12. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
13. Select the Grayscale option.
14. Click Print to print your document.
Parent topic: Printing with Black Ink and Expended Color Cartridges



338

Conserving Low Black Ink with Windows
The following window appears when black ink runs low and there is more color ink.

Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper
type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor
must be enabled.

• Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink
for the document you are printing.

• Click Disable this feature to continue using the remaining black ink.

Note: If you disable this feature, it remains disabled until you install a new black ink cartridge.

Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

Maintenance Box Replacement
The maintenance box stores surplus ink that gets collected during printing or print head cleaning. When
you see a message on the LCD screen, follow the on-screen instructions to replace the maintenance
box.
Note the following precautions when replacing the maintenance box:
• Do not remove the maintenance box during printing or ink may leak.
• Do not touch the green chip on the side of the maintenance box.
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• Do not remove the film on the top of the box or ink may leak.
• Do not tilt the maintenance box after removing it or ink may leak.
• Do not touch the openings in the maintenance box or you may get ink on you.
• Do not drop the maintenance box or subject it to strong shocks.
• Do not store the maintenance box in high or freezing temperatures.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for a long period.
Keep the maintenance box away from direct sunlight.

Note: The maintenance box is a user-replaceable part and is not covered by the product warranty.

Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers
Related concepts
Purchase Epson Ink Cartridges and Maintenance Box

Replacing the Rollers for Paper Cassette 1
When the rollers in paper cassette 1 need to be replaced, you see a message on the LCD screen. There
are three rollers for paper cassette 1: two on the back of the product and one on the cassette.

Note: Check that the arrows on the rollers point clockwise before installing them in paper cassette 1.
There are different rollers for paper cassette 1 and the other paper cassettes.

1. Turn off the product.
2. Wait for the power light to turn off, then unplug the power cord.
3. Remove the replacement rollers from their package.

Caution: If there is any dirt or dust on the rollers, clean them with a soft, moist cloth. Using a dry
cloth can damage the surface of the roller.
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4. Pull out paper cassette 1.

5. Open rear cover 1 (D1).
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6. Pull out rear cover 2 (D2).

7. Remove the roller cover inside the product.
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8. Pull up the roller tabs and slide the rollers to the left to remove them.

9. Insert the replacement rollers and slide them to the right until they click into place.

10. Replace the roller cover as shown and press it down until it clicks into place.

11. Insert rear cover 2 (D2).
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12. Close the rear cover 1 (D1).
13. On paper cassette 1, pull up on the lever as shown to release the roller.

14. Slide the roller towards the lever and lift it out of the cassette.
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15. Insert the pointed end of the replacement roller's shaft into the hole in the cassette and gently slide
the roller into the slot with the flat side of the shaft facing toward the front of the cassette.

16. Press down on the lever as shown to lock the roller in place.

17. Insert the paper cassette all the way into the product.
Reset the maintenance roller counter for paper cassette 1 to keep track of roller usage.
Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

Replacing the Rollers for Paper Cassettes 2 to 4
When the rollers in paper cassettes 2 to 4 need to be replaced, you see a message on the LCD screen.
There are three rollers for each paper cassette: two on the back of the product and one on the cassette.
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Note: Check that the arrows on the rollers point counterclockwise before installing them in paper
cassettes 2 to 4. There are different rollers for paper cassette 1 and the other paper cassettes.

1. Turn off the product.
2. Wait for the power light to turn off, then unplug the power cord.
3. Remove the replacement rollers from their package.

Caution: If there is any dirt or dust on the rollers, clean them with a soft, moist cloth. Using a dry
cloth can damage the surface of the roller.



346

4. Pull out the paper cassette.
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5. Open the rear cover (E) that matches with the paper cassette you removed.
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6. Use a screwdriver to remove the three screws on the inner cover and remove the cover.

7. Pull down the roller tabs and slide the rollers to the right to remove them.
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8. Insert the replacement rollers and slide them to the left until they click into place.

9. Use a screwdriver to secure the inner cover to the printer with the three screws you removed.
10. Close the rear cover (E).
11. On the paper cassette you removed, pull up on the lever as shown to release the roller.

12. Slide the roller towards the lever and lift it out of the cassette.
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13. Insert the pointed end of the replacement roller's shaft into the hole in the cassette and gently slide
the roller into the slot with the flat side of the shaft facing toward the front of the cassette.

14. Press down on the lever as shown to lock the roller in place.

15. Insert the paper cassette all the way into the product.
Reset the maintenance roller counter for the paper cassette to keep track of roller usage.
Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

Resetting the Roller Counter on the LCD Screen
You must reset the roller counter after replacing the cassette rollers to clear the roller replacement
message and to keep track of roller usage correctly.
1. Press the home button, if necessary.
2. Select Settings.
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3. Select Maintenance.
You see a screen like this:

4. Scroll down and select Maintenance Roller Information.
5. Select Reset Maintenance Roller Counter.
6. Select the paper cassette in which you replaced the rollers.
7. Select Yes.
8. Select Yes again to confirm the reset.
9. If you want to feed a sheet of paper to check the roller installation, select Yes. (Otherwise, select

No.)
10. Press the home button to exit.
Parent topic: Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can clean the print head, adjust the print quality, and run a nozzle check by using the printer buttons
or the utilities included with the standard Epson printer software. To download the standard Epson
printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support
(Caribbean) and select your product.

If running these utilities does not solve the problem, you may need to replace the ink cartridges.
Print Head Maintenance
Print Head Alignment
Print Quality Adjustment
Cleaning the Paper Guide

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning
Parent topic: Adjusting Print Quality
Related topics
Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility
Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.

You see a screen like this:

6. Select Print Head Nozzle Check.
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You see a screen like this:

7. Select Start.
The nozzle pattern prints.

8. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

9. Do one of the following:

• If there are no gaps, select .

• If there are gaps or the pattern is faint, select and continue.
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10. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the
process as necessary.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges
may be old or damaged and needs to be replaced.
Parent topic: Print Head Nozzle Check
Related concepts
Print Head Cleaning
Related topics
Loading Paper

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
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You see a window like this:

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

7. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
Related concepts
Print Head Cleaning
Related topics
Loading Paper

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance
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Related tasks
Removing and Installing Ink Cartridges

Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.

You see a screen like this:

6. Select Print Head Cleaning.
You see a screen like this:
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7. Select Start to clean the print head.
When the cleaning cycle is finished, you see a message on the screen.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

8. Select Yes.
9. Select Start to confirm that the print head is clean.
If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges
may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related topics
Loading Paper

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
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You see a window like this:

5. Click Start to begin the cleaning cycle.
The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.
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7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges
may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related topics
Loading Paper

Print Head Alignment
If your printouts become grainy or blurry or you notice misalignment of vertical lines, you may need to
align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Parent topic: Adjusting Print Quality
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Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings > Maintenance > Ruled Line Alignment.
5. Follow the on-screen instructions to print an alignment sheet.

Note: Do not cancel printing while you are printing head alignment patterns.

6. Check the printed patterns on the alignment sheet and select the number representing the pattern
with the least misaligned vertical line on the LCD screen:

7. Select Done.
Parent topic: Print Head Alignment
Related topics
Loading Paper

Print Quality Adjustment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to adjust the print quality.

Note: Banding may also occur if your print head nozzles need cleaning.

Adjusting the Print Quality Using the Product Control Panel



363

Adjusting the Quality for Each Paper Type
Parent topic: Adjusting Print Quality

Adjusting the Print Quality Using the Product Control Panel
You can adjust the print quality using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.

You see a screen like this:

6. Select Print Quality Adjustment.
7. Follow the on-screen instructions to print an alignment sheet.

Note: Do not cancel printing while you are printing head alignment patterns.
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8. Check the printed patterns on the alignment sheet and select the following on the LCD screen:
• For patterns 1 and 2, select the number representing the pattern with the least misaligned vertical

line.

• For patterns 3 and 4, select the number representing the pattern with the least amount of
separation or overlap.

9. Select Done.
Parent topic: Print Quality Adjustment
Related topics
Loading Paper

Adjusting the Quality for Each Paper Type
If you still notice dark or light bands in your printouts after adjusting the print quality, you can adjust the
quality for each paper type.
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1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.

You see a screen like this:

6. Scroll down and select Print Quality Adjustment per Paper.
7. Select one of the following options:

• Print Pattern to adjust the paper type for your printer
• Enter Set Value to enter paper type alignment information for use on multiple printers of the same

model
8. Select a paper type.
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9. If you printed a pattern, check the printed patterns on the alignment sheet and select the following on
the LCD screen:
• For patterns 1 and 2, select the number representing the pattern with the least misaligned vertical

line.

• For patterns 3 and 4, select the number representing the pattern with the least amount of
separation or overlap.

10. Select Done.
Parent topic: Print Quality Adjustment
Related topics
Loading Paper
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Cleaning the Paper Guide
If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink. If
paper does not feed correctly from the rear paper feed slot, you can use a cleaning sheet to clean the
rollers.
1. If printouts are smeared or scuffed, load plain paper in the paper source that you want to clean in this

size: A3 (11.7 × 16.5 inches [297 × 420 mm]).
2. Press the home button, if necessary.
3. Select Settings.
4. Select Maintenance.

You see a screen like this:

5. Scroll down and select Paper Guide Cleaning.
6. Select the paper source you want to clean then select Start.
7. Repeat these steps as necessary until the paper comes out clean. If you are using a cleaning sheet,

repeat these steps up to 3 times.

Note: If the paper is not clean after cleaning several times, try cleaning the other paper sources.

Parent topic: Adjusting Print Quality
Related topics
Loading Paper
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Cleaning and Transporting Your Product
See these sections if you need to clean or transport your product.
Cleaning Your Product
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Wait for the power light to turn off, then unplug the power cord.
3. Disconnect any connected cables.
4. Remove all the paper from the product.
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5. Clean the scanner glass and the glass area on the left with a soft, lint-free cloth (microfiber is
recommended) moistened with a little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.

Note: If lines appear on the printout or in scanned images, carefully clean the scanner glass on the
left.
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6. Raise the lever and open the ADF cover (F).

7. Use a soft, moist, lint-free cloth (microfiber is recommended) to clean the rollers and the interior of
the ADF.



371

8. Pull out the paper cassette.

9. Use a soft, moist cloth to clean the cassette roller.

Caution: Using a dry cloth can damage the surface of the roller.

10. Insert the paper cassette all the way into the printer.
11. Repeat steps 8 through 10 for any additional paper cassettes.
12. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
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Parent topic: Cleaning and Transporting Your Product

Transporting Your Product
If you need to store your product or transport it a long distance, prepare it for transportation as described
here.
Caution: During transportation and storage, follow these guidelines:
• Because the product is heavy, two or more people should lift and carry it using the hand position

shown:

• Avoid tilting the product, positioning it vertically, or turning it upside down; otherwise ink may leak.
• Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent

the product from printing.
• Leave the maintenance box installed; otherwise ink may leak.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.
2. Remove all the paper from the product.
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3. Wait for the power light to turn off, then unplug the power cord.
4. Disconnect any connected cables and external storage devices.
5. Close the rear paper support and remove the output tray.

Note: Do not place the output tray on top of the product. The output tray can fall while the product is
being moved and you can be injured.

6. Remove the optional cabinet and paper cassettes (if they are installed) before lifting the product.

Note: If the optional cabinet is installed, you can use the casters on the cabinet to roll the product
instead of lifting it. Remove the cabinet stands and unlock the casters before moving the product. Do
not roll the product over uneven or rough surfaces to avoid harsh impacts to the product.

7. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product. Make sure the box adequately protects the product control panel.

Parent topic: Cleaning and Transporting Your Product
Related concepts
Print Head Cleaning
Print Quality Adjustment
Related tasks
Removing and Installing Ink Cartridges
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Checking for Software Updates
Product Status Messages
Job Status Error Codes
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving PostScript Printing Problems
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Solving Faxing Problems
Solving USB Device Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates
Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and
select your product.
• Windows: Your printer software automatically checks for updates. You can also manually update the

software by selecting Software Update here:

• Accessing the Windows Desktop and right-clicking the icon for your product in the right side of
the Windows taskbar, or clicking the up arrow and right-clicking .

• On the Maintenance tab in the printer settings window

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

• OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

• macOS 10.12.x or 10.13.x: You can manually update the software by opening the App Store,
selecting Updates, searching for a software update option for Epson Software, and selecting Update.

Parent topic: Solving Problems

Product Status Messages
You can often diagnose problems with your product by checking the messages and status icons on its
LCD screen. You can also check for errors by pressing the Job/Status button and selecting Printer
Status.

Note: If the screen is dark, press the screen to wake the product from sleep mode.

LCD screen message Condition/solution
Printer error. Turn the power off and
on again. If the problem persists,
contact Epson Support.

Turn the product off and then back on again. If the error persists,
check for and remove any jammed paper or protective materials
from the product. If the error still persists, contact Epson for
support.
If you see any of the following error codes, make sure you have
not exceeded the loading capacity for any paper source:
• 000181
• 000184
• 000201
• 000204
• 000221
• 000224

Printer error. Contact Epson Support.
Non-printing features are available.

The product may be damaged, but features such as scanning
are still available. Contact Epson for support.

Printer error. For details, see your
documentation.

The product may be damaged. Contact Epson for support.
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LCD screen message Condition/solution
Paper out in XX. Load Paper. Paper
Size: XX/Paper Type: XX

Load the size and type of paper in the paper source indicated.

Too many paper cassette units are
installed. Turn the power off and
uninstall the extra units. See your
documentation for details.

You can install up to three optional paper cassette units.
Remove any extra units.

Unsupported Paper Cassette Units
have been installed. Turn the power
off and uninstall. For details, see
your documentation.

Unsupported optional paper cassette units are installed.
Remove the unsupported units.

Cannot print because XX is out of
order. You can print from another
cassette.

Turn the product off and then back on again. Reinsert the
indicated paper cassette. If the error persists, contact Epson for
support.

Maintenance Roller in XX is nearing
the end of its service life.

The maintenance rollers need to be replaced periodically for
optimal performance. (Paper may not feed correctly from the
paper cassette or rear paper feed when a maintenance roller is
near the end of its service life.)

Maintenance Roller in XX is at the
end of its service life. Replace it and
reset the maintenance roller counter.

Replace the maintenance rollers and reset the maintenance
roller counter for the paper cassette for which you replaced the
maintenance rollers.

You need to replace Ink Cartridge(s). Replace the indicated ink cartridges.
The time for maintenance is
approaching. Contact Epson
Support.

Do not attempt to perform maintenance on your own. Contact
Epson for support.

This printer may need service to
keep print quality. Contact Epson
Support.

Do not attempt to perform maintenance on your own. Contact
Epson for support.

Paper Setup Auto Display is set to
Off. Some features may not be
available. For details, see your
documentation.

AirPrint is not available when the Paper Setup Auto Display
setting is disabled. Set the Paper Setup Auto Display setting to
On.
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LCD screen message Condition/solution
No dial tone is detected. Make sure the phone cable is connected correctly and the

phone line works. If you connected the product to a PBX (Private
Branch Exchange) phone line or Terminal Adapter, change the
Line Type setting to PBX. If you still cannot send a fax, turn off
the Dial Tone Detection setting. (Turning off the Dial Tone
Detection setting may cause the product to drop the first digit of
a fax number.)

Failed to receive faxes because the
fax data capacity is full. Touch the
Job/Status at the bottom of the Home
Screen for details.

Press the Job/Status button, select Printer Status, and
resolve any printer errors that prevented faxes from printing.
Make sure the product is connected to a computer or that a USB
device is connected to the product.

The combination of the IP address
and the subnet mask is invalid. See
your documentation for more details.

There is a problem with the network connection to your product.
Set up your product on the network again.

To use cloud services, update the
root certificate from the Epson Web
Config utility.

Access the Web Config utility and update the cloud service root
certificate.

Check that the printer driver is
installed on the computer and that
the port settings for the printer are
correct.

Make sure the printer port is correctly configured. In Windows,
make sure the port is set to a USBXXX setting for a USB
connection or EpsonNet Print Port for a network connection.

Recovery mode An error has occurred during firmware updating. Connect your
product using a USB cable and try downloading the Firmware
Update from the Epson support site. If you still need help,
contact Epson for support.

Parent topic: Solving Problems
Related references
Where to Get Help
Related tasks
Removing and Installing Ink Cartridges
Selecting the Line Type
Accessing the Web Config Utility
Checking for Software Updates
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Connecting a Telephone or Answering Machine
Related topics
Wi-Fi or Wired Networking

Job Status Error Codes
If a job does not complete successfully, you can check the error code for the reason. Press the

Job/Status button, select Job Status > Log, and select the incomplete job to display the error code
and additional information.

Code Condition/solution
001 The product was turned off by a power failure.
101 Memory is full. Reduce the size of the print job.
102 Collated printing has failed due to a lack of available memory. Clear fonts and macros

from the product's memory using the PDL Font, Macro option from the Settings >
General Settings > System Administration > Clear Internal Memory Data menu,
reduce the size of the print job, or print one copy at a time.

103 Print quality was decreased due to a lack of available memory. If the quality of the printout
is unacceptable, try changing the format setting or simplifying the page by reducing the
number of graphics or the number and size of the fonts.

104 Reverse printing has failed due to a lack of available memory. Clear fonts and macros
from the product's memory using the PDL Font, Macro option from the Settings >
General Settings > System Administration > Clear Internal Memory Data menu or
reduce the data size of the print job.

106 Cannot print from the computer due to access control settings. Contact your product
administrator.

107 User authentication failed and the job has been canceled. Contact your product
administrator.

108 Confidential job data was deleted when the product was turned off.
109 The received fax was already deleted.
110 The job was printed 1-sided because the loaded paper does not support 2-sided printing.

Load paper that supports 2-sided printing.
111 Available memory is running low. Reduce the size of the print job.
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Code Condition/solution
120 Cannot communicate with a server using an open platform. Check the server or network

for errors.
201 The product's memory is full. You can send pages individually, or print received faxes and

delete them to free up memory space.
202 The line was disconnected by the recipient's fax machine. Wait a moment, then try again.
203 The product cannot detect a dial tone.

Make sure the phone cable is connected correctly and the phone line works. If you
connected the product to a PBX (Private Branch Exchange) phone line or Terminal
Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the
Dial Tone Detection setting. (Turning off the Dial Tone Detection setting may cause the
product to drop the first digit of a fax number.)

204 The recipient's fax machine is busy. Wait a moment, then try again.
205 The recipient's fax machine does not answer. Wait a moment, then try again.
206 The phone cable is incorrectly connected to the product's LINE and EXT. ports. Connect

the phone cable correctly.
207 The phone cable is not connected. Connect the phone cable.
208 The fax could not be sent to some of the specified recipients.

Print a fax log or Last Transmission report to check which recipients failed to receive the
fax. If the Save Failure Data setting is turned on, you can resend a fax from Job Status in
the Job/Status Menu.

301
401

There is not enough storage space available to save the data in the external memory
device. Clear space on the device, reduce the number of documents, or use a different
device.

302
402

The external memory device is write-protected. Disable write protection.

303 No folder is available for saving the scanned file. Create a folder or use a different
memory device.

304
404

An external memory device has been removed. Reinsert the device.
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Code Condition/solution
305
405

An error occurred while saving data to an external memory device. Reinsert the memory
device or use a different device.

306
327

The product's memory is full. Wait until current jobs are finished processing.

311
321
411
421

A DNS error has occurred. Check the DNS settings for the server, computer, or access
point. DNS settings for the server can be checked from the DNS Server option in the
Setup menu. If you cannot clear the problem, contact your product administrator.

312
412

An authentication error has occurred. Check the Server Settings in the Settings menu. If
you cannot clear the problem, contact your product administrator.

313
413

A communication error has occurred. Print a network connection report to check if the
product is connected to the network. Check the email server settings. The authentication
method of the settings and email server may not match. If the authentication method is
disabled, set the authentication method of the email server to None.

314 The data size exceeds the maximum size for the attached files. Increase the Attached
File Max Size setting in the scan settings or lower the file size of the scanned image.

315 The memory is full. Retry after other ongoing jobs have finished.
322 An authentication error occurred. Check the Location settings.
323 A communication error has occurred. Check the Location settings or the network

connection.
324 A file with the same name already exists in the specified folder. Delete the duplicate file or

change the file name prefix in File Settings.
325
326

There is not enough storage space available in the specified folder. Increase the storage
space in the specified folder, delete unnecessary files, or lower the file size of the
scanned image.

328 The destination was wrong or the destination does not exist. Check the Location
settings.

331 A communication error occurred. Print a network status report to check the product's
network connection.
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Code Condition/solution
332 There is not enough space available for saving the scanned files in the specified folder.

Reduce the number of documents or delete unnecessary files from the specified folder.
333 The destination could not be found because the destination information was uploaded to

the server before sending the scanned data. Select the destination again.
334 An error occurred while sending the scanned data.
341 A communication error has occurred. Make sure the product is connected to the computer

or network correctly. Make sure you have installed Document Capture Pro or Document
Capture. If you cannot clear the problem, contact your product administrator.

422 An authentication error has occurred. Make sure the settings are correct for the
Destination folder selected in Save/Forward Settings in the Receive Settings menu.

423 A communication error has occurred. It is also possible that a file with the same name is
open or the file is a read-only file.
Check the network connection, make sure the settings are correct for the Destination
folder selected in Save/Forward Settings in the Receive Settings menu. If you cannot
clear the problem, contact your product administrator.

425 There is not enough storage space available in the forwarding destination folder. Increase
the storage space in the destination folder.

428 The destination was wrong or the destination does not exist. Make sure the settings are
correct for the Destination folder selected in Save/Forward Settings in the Settings
menu.

Parent topic: Solving Problems
Related tasks
Connecting a Telephone or Answering Machine
Selecting the Line Type
Entering a User ID and Password for Printing
Saving and Viewing Received Faxes
Selecting Advanced Fax Settings
Setting User Feature Restrictions (Access Control)
Related topics
Wi-Fi or Wired Networking
Sending Faxes
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Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.

You see a screen like this:

6. Select Print Head Nozzle Check.
You see a screen like this:

7. Select Start.
The nozzle pattern prints.
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8. Do one of the following, depending on the results of the product check:
• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

• If the page prints but the nozzle check pattern has gaps, clean the print head.
• If the page does not print, the product may have a problem. Check the other solutions in this

manual. If they do not work, contact Epson.
Parent topic: Solving Problems
Related concepts
Print Head Cleaning
Print Quality Adjustment
Uninstall Your Product Software
Related references
Where to Get Help

Resetting Control Panel Defaults
If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
3. Select General Settings.
4. Scroll down and select System Administration. Enter the administrator password, if necessary.
5. Scroll down and select Restore Default Settings.
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You see a screen like this:

6. Select one of these options:
• Network Settings: Resets all network settings
• Copy Settings: Resets all settings for copying
• Scan Settings: Resets all settings for scanning
• Fax Settings: Resets all settings for faxing
• Clear All Data and Settings: Resets all control panel settings including the contacts list
You see a confirmation screen.

7. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Product Does Not Turn On or Off
Noise After Ink Installation
Software Installation Problems
Parent topic: Solving Problems

Product Does Not Turn On or Off
If you cannot turn the product on or off, try these solutions:
• If you cannot turn on your product, make sure the power cord is securely connected and hold down

the power button a little longer.
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• If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off
your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Parent topic: Solving Setup Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:
• The first time you install ink cartridges, the product must charge its print head. Wait until charging

finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the power light stops flashing.

• If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and any necessary cables are securely connected at both ends. If

you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your system administrator.

• If you are printing over a network, make sure your product is set up properly on the network.
Parent topic: Solving Setup Problems
Related references
Windows System Requirements
Mac System Requirements
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Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in Mac Printer Window
Cannot Print Over a Network
Cannot Scan Over a Network
Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your

product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

• Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
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obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems
Related concepts
Wi-Fi Direct Mode Setup
Related tasks
Selecting Wireless Network Settings from the Control Panel
Printing a Network Status Sheet
Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify connection using your

product control panel.
• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-

ASCII characters.
• Make sure your product is not connected to a guest network.
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• If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.
2. Windows only: Uninstall your product software.
3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing detection of your device over the network. See your router or access point documentation
for instructions on disabling the Privacy Separator function.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in Mac Printer Window
If your product does not appear in the Mac printer window, try these solutions:
• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your

product's LCD screen is not lit, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.
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• If you are connecting the product wirelessly via EpsonNet Setup and you do not see the Wi-Fi antenna
icon with connection bars on your LCD screen, make sure your product software was installed
correctly. If necessary, reinstall your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Print a network status sheet and verify that the network settings are correct. If the network status is

Disconnected, check any cable connections and turn your product off and then on again.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your

network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place

your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

• Check if there are any paused print jobs.
• Make sure your printer is selected as the default printer.
• Check if the selected printer port is correct.
• Check to see if your wireless router or access point has an enabled Privacy Separator function that is

preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.
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• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

• Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:
• Make sure the Ethernet cable is securely connected to your product and to your router, access

point, switch, or hub.
• Try connecting your product to a different port or a different router, access point, switch, or hub.
• Try connecting with a different Ethernet cable.
• Try printing to your product from another computer on the network.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

• If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the
LCD screen, make sure your product software was installed correctly. If necessary, reinstall your
software.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related tasks
Printing a Network Status Sheet
Related topics
Wi-Fi or Wired Networking

Cannot Scan Over a Network
If you cannot start Epson Scan 2 for scanning over a network, try these solutions:
• If you cannot scan from your product control panel, make sure you restarted your computer after

installing the product software. Make sure the Event Manager program is not being blocked by your
firewall or security software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
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Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few
seconds, and restart it. If Epson Scan 2 cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan 2 again.

• Check the scanner setting and reset the connection if necessary using Epson Scan 2 Utility:

Windows 10: Click and select EPSON > Epson Scan 2 Utility. Make sure your product is
selected. If necessary, select the Other tab and click Reset.
Windows 8.x: Navigate to the Apps screen, select EPSON, and select Epson Scan 2 Utility. Make
sure your product is selected. If necessary, select the Other tab and click Reset.

Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility. Make sure your product is selected. If necessary, select the Other
tab and click Reset.
Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure your product is selected. If necessary, select the Other tab and click Reset.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Parent topic: Solving Network Problems
Related tasks
Entering a User ID and Password for Scanning
Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan 2 Icon

Solving Copying Problems
Check these solutions if you have problems copying with your product.
Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Originals Do Not Feed From the Automatic Document Feeder
Parent topic: Solving Problems
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Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product

software is installed correctly.
• Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems
Related concepts
Print Head Cleaning
Print Head Nozzle Check

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Originals Do Not Feed From the Automatic Document Feeder
If your originals do not feed when placed in the ADF, try these solutions:
• Make sure the ADF icon lights up on the Copy, Fax, or Scan screen on the LCD screen. If not, reload

the originals.
• Make sure the size, weight, and number of your originals are supported by the ADF.
• Make sure the originals are loaded correctly.
• Make sure the document is not curled or creased.
• Try cleaning the inside of the ADF.
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• Do not load originals above the arrow mark on the ADF edge guide.

Parent topic: Solving Copying Problems
Related references
Paper Feeding Problems
Paper Jams Inside the Printer
Related tasks
Placing Originals in the Automatic Document Feeder
Cleaning Your Product

Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
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Paper Jams Inside the Printer
Paper Ejection Problems
Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust

the edge guides. Make sure the paper stack is not above the arrow mark on the edge guides inside the
cassette or rear feed slot.

• Place the product on a flat surface and operate it in the recommended environmental conditions.
• Be sure to insert the paper cassette all the way into your product.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• Do not load more than the recommended number of sheets. For plain paper, do not load paper above

the arrow mark on the edge guides.
• Make sure your paper meets the specifications for your product.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure the paper size and paper type settings are correct for the paper source.
• Run the paper guide cleaning utility to clean the paper path.
• If paper does not feed correctly after replacing the maintenance rollers, make sure you installed the

maintenance rollers correctly.
• If you installed an optional paper cassette unit, be sure to enable the cassette unit in the printing

software.
• If your product pauses during printing, make sure the front cover is closed.
• The maintenance rollers may be at the end of their service life. Check the maintenance roller status

and replace them if necessary.
• Do not use short-grain paper with a width less than .413 inches (105 mm).
• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the cassette printable side down.
• Do not load binder paper with holes in the cassette.
• Follow any special loading instructions that came with the paper.



395

• Use long-grain paper. If you are not sure what type of paper you are using, check the paper
packaging or contact the manufacturer to confirm the paper specifications.

Parent topic: Solving Paper Problems
Related references
Paper Jams Inside the Printer
Paper Loading Capacity
Paper Specifications
Related tasks
Cleaning the Paper Guide
Related topics
Loading Paper

Paper Jams Inside the Printer
If you see a message that paper has jammed in the product, follow the on-screen instructions to locate
and remove the jammed paper.
Take the following precautions when removing jammed paper from the printer:
• Remove the jammed paper carefully. Using too much force may damage the printer.
• Unless specifically instructed, avoid tilting the printer, placing it on its side, or turning it upside down,

as ink may spill.

Warning: Never touch the buttons on the control panel while your hand is inside the product. If the
product starts operating, it may cause an injury. Do not touch any protruding parts inside the product.

Parent topic: Solving Paper Problems
Related topics
Loading Paper

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select

the correct paper type setting when you reprint.
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Parent topic: Solving Paper Problems
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Cancelling Printing Using a Product Button
Related topics
Loading Paper

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: For problems while printing with the Epson Universal Print Driver or PostScript (PS3) printer
software, see the sections covering that software in this manual.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,

connect your product directly to your computer instead of the hub.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product

software is installed correctly.
• In Windows, make sure your product is selected as the default printer.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in

the printer settings window, and cancel any stalled print jobs.
• On a Mac, make sure the printer is not paused.
Parent topic: Solving Problems Printing from a Computer
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Related tasks
Running a Product Check
Entering a User ID and Password for Printing
Using AirPrint

Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select Printing Preferences, and select
your product name again if necessary.

• Windows 7: Click and select Devices and Printers. Right-click your product name, select
Printing Preferences, and select your product name again if necessary.

• Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

2. Click the Maintenance tab.
3. Click the Extended Settings button.
4. Select Enable EPSON Status Monitor 3 and click OK.
5. Click the Monitoring Preferences button.
6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.
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• If you are using Windows 7, close the Devices and Printers window before you print.
• Make sure Quiet Mode is turned off.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have

automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

• If using the PostScript printer driver, set the Print Quality setting to Fast.
For the fastest printing, select the following settings in your product software:
• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Make sure the ink drying time has not been increased for double-sided printing.
• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,

and select the following settings:
• Always Spool RAW Datatype
• Page Rendering Mode
• Print as Bitmap

• Windows: Select Printer Properties, click the More Options tab and make sure the High Speed
setting is enabled.

• Mac: Select System Preferences , select Printers & Scanners, then select your product. Select
Options & Supplies, then select Options (or Driver) and enable the High Speed Printing setting.

• Enable the Bidirectional setting in Settings > General Settings > Printer Settings.
If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select Computer or My Computer. Double-click the C: drive and open these folders:
ProgramData > EPSON > PRINTER.

Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and
search options. In the window that appears, click the View tab, select Show hidden files, folders,
and drives in the Advanced settings list, and click OK.
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2. Right-click the EPAUDF01.AUD file and select Delete.
3. Restart your computer and try printing again.
Parent topic: Solving Problems Printing from a Computer
Related references
Windows System Requirements
Mac System Requirements
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Extended Settings - Windows

Solving PostScript Printing Problems
Check these solutions if you have problems using the PostScript printing software.
Nothing Prints Using the PostScript Printing Software
Documents Print Incorrectly Using the PostScript Printing Software
Accessing Printer Properties - PostScript - Windows
Parent topic: Solving Problems

Nothing Prints Using the PostScript Printing Software
If your document doesn't print, try these solutions:
• Make sure your product is turned on and connected to your computer.
• Make sure the Printer Settings > Printing Language setting is set to Auto or PS3.
• Make sure your product is selected as the printer in your printing program.
• In Windows, the product may not print if a large number of print jobs are sent. Try selecting Print

directly to the printer on the Advanced tab in the printer properties.
Parent topic: Solving PostScript Printing Problems
Related topics
Enabling Epson Universal Print Driver (PCL) or PostScript Printing
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Documents Print Incorrectly Using the PostScript Printing Software
If your document does not print correctly, try these solutions:
• If the file you are printing was created in an application that allows you to change the data format, such

as Adobe Photoshop, make sure the settings in the application match the printer software settings.
• EPS files created in binary format may not print correctly. Try creating the file in ASCII format instead.
• In Windows, the product cannot print binary data if it is connected to the computer using a USB cable.

Try selecting ASCII or TBCP as the Output Protocol setting on the Device Settings tab in the printer
properties.

• In Windows, select the appropriate substitution fonts on the Device Settings tab in the printer
properties.

• In Windows, if the printed colors are incorrect, try adjusting the Color Mode setting on the Advanced
tab of the printer software.

• In Windows, if printing is slow, try selecting Fast as the Print Quality setting on the Advanced tab of
the printer software.

Parent topic: Solving PostScript Printing Problems
Related tasks
Accessing Printer Properties - PostScript - Windows

Accessing Printer Properties - PostScript - Windows
You can access the printer properties to view and change product settings for PostScript printing.
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click the postscript driver for your product, and select Printer
properties.

• Windows 7: Click and select Devices and Printers. Right-click the postscript driver for your
product and select Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click the postscript driver for your product and select Properties.

2. Click any tab to view and change the printer property settings.
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Parent topic: Solving PostScript Printing Problems

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.
Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
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Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software, if available.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Cleaning
Print Head Nozzle Check
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Extended Settings - Windows
Selecting Printing Preferences - Mac

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the product.
• When placing originals on the scanner glass, align the corner of the original with the corner indicated

by the arrow. If the edges of the copy are cropped, move the original slightly away from the corner.
• Clean the scanner glass and the document cover. If there is dust or stains on the glass, the copy area

may extend to include the dust or stains.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
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Selecting Basic Print Settings - Mac
Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in

the printer settings window, and cancel any stalled print jobs.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If your computer entered sleep mode the last time you printed, the next print job after your computer

exits sleep mode may contain garbled characters. Print your document again.
• Windows or Mac: Make sure you are using the printer software for this product. Check the product

name at the top of the driver window.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure you selected the correct paper size on the control panel.
• Make sure your paper is positioned correctly for feeding into the printer.
• Slide the edge guides against the edges of the paper.
• Clean the scanner glass and document cover.
• If the edges of a copy are cropped, slightly move the original away from the edges of the scanner

glass.
• Make sure you selected the correct margins for your paper size in your printing program.
• Be sure to select the correct Original Size setting for your original in the Copy settings.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
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Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Additional Layout and Print Options - Windows
Cleaning Your Product
Selecting Page Setup Settings - Mac

Slanted Printout
If your printouts are slanted, try these solutions:
• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
• Adjust the print quality.
• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Loading Paper

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.
White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors
Parent topic: Solving Problems
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White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Turn off any high speed settings in your product software.
• Align the print head.
• Adjust the print quality in the product software.
• If you continue to see horizontal bands or streaks in your printouts after cleaning the print head and

adjusting the print quality, make print quality adjustments for each paper type.
• You may need to replace the ink cartridges.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Nozzle Check
Print Quality Adjustment
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac
Related topics
Loading Paper
Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Slide the edge guides to the edges of the paper.
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• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel

or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this
setting on will decrease print speed.)

• In Windows, if the paper is still smeared after selecting the Thick Paper and Envelopes setting,
select the Short Grain Paper setting in the Extended Settings of the printer software.

• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Make sure the ink has dried before reloading the paper to print on the other side. Adjust the Print
Density and/or Increase Ink Drying Time settings.

• If printed copies are smeared, lower the copy density setting on the product control panel.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.
• Do not press too hard on the original or the document cover when you are scanning originals on the

scanner glass.
• Clean the scanner glass.
• Clean the ADF.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems
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Related concepts
Print Quality Adjustment
Print Head Cleaning
Related references
Paper Specifications
Available Epson Papers
Related tasks
Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Quality Adjustment
Print Head Nozzle Check
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
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Cleaning the Paper Guide
Related topics
Loading Paper
Replacing Ink Cartridges, Maintenance Boxes, and Cassette Rollers

Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• Adjust the print quality.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

• If you enlarged the image size in an image-editing program, you need to increase the image resolution
setting to retain a high image quality. Increase the image resolution by the same amount you increase
the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the
image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Quality Adjustment
Print Head Nozzle Check
Print Head Alignment
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Related tasks
Selecting Basic Print Settings - Mac
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac
Related topics
Loading Paper

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
• Make sure the paper type setting matches the paper you loaded.
• Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors

may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.

• Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

• Try turning off the PhotoEnhance setting in Windows.
• If using the PostScript printer driver, try adjusting the Color Mode setting on the Advanced tab of the

printer software.
• For best results, use genuine Epson ink and paper.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related references
Available Epson Papers
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Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Additional Layout and Print Options - Windows
Managing Color - Mac

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.
Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your

operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, make sure your product is listed as a valid device in the Scanners and Cameras control

panel.
Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Related tasks
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:
• Make sure your product is turned on and any interface cables are securely connected at both ends.
• If your product is connected to a USB hub, connect it directly to your computer instead.



411

• If you scan at a high resolution over a network, a communication error may occur. Lower the
resolution.

• If you are scanning with the ADF, check that the document cover and ADF cover are closed.
• Make sure Epson Scan 2 is selected as your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart Epson Scan 2.
• Check the connection setting and test the connection using Epson Scan 2 Utility:

Windows 10: Click and select EPSON > Epson Scan 2 Utility. Make sure the correct product is
selected. If necessary, select the Other tab and click Reset.
Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility. Make sure the correct
product is selected. If necessary, select the Other tab and click Reset.

Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson Scan
2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other
tab and click Reset.
Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure the correct product is selected. If necessary, select the Other tab and click Reset.

• Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both
versions and install one version.

• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
• If the user restriction feature (Access Control) is enabled, a user ID and password are required to

scan. If you do not know the user ID or password, contact your administrator for assistance.
Parent topic: Solving Scanning Problems
Related tasks
Entering a User ID and Password for Scanning
Starting a Scan Using the Epson Scan 2 Icon

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.
Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
Image is Distorted or Blurry
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Image Colors are Patchy at the Edges
Image is Too Dark
Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image
Scanned Image Colors Do Not Match Original Colors
Scanned Image Edges are Cropped
Parent topic: Solving Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
• Make sure you placed your original for scanning facing the correct way.
• If you are scanning using the Epson Scan 2 Black & White setting, adjust the Threshold setting and

scan again.
• Do not press on the original or the document cover with too much force.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Advanced Settings Tab
Related topics
Placing Originals on the Product

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free
cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not
recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

If you are scanning from the ADF, try cleaning the ADF and scan again.
Parent topic: Solving Scanned Image Quality Problems
Related tasks
Cleaning Your Product
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Straight Lines in an Image Appear Crooked
If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.
If you are scanning from the ADF, try cleaning the ADF and scan again.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Placing Originals on the Product

Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:
• Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the

scanner glass.
• Do not move your original or your product during scanning.
• Your product will not operate properly while tilted at an angle. Place your product on a flat, stable

surface that extends beyond its base in all directions.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:

• Increase the Resolution setting.
• If the Image Type setting is Black & White, adjust the Threshold setting.
• Select the Unsharp Mask setting.
• If the Image Type setting is Black & White, select Text Enhancement. If the Image Type setting is

Color or Grayscale, change the Text Enhancement setting to High.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Advanced Settings Tab

Image Colors are Patchy at the Edges
If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.
Parent topic: Solving Scanned Image Quality Problems
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Image is Too Dark
If your scanned image is too dark, try these solutions:
• Select the Advanced Settings tab in Epson Scan 2 and adjust the Brightness setting.
• Check the brightness and contrast settings of your computer monitor.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Advanced Settings Tab

Back of Original Image Appears in Scanned Image
If an image from the back of a thin original appears in your scanned image, try these solutions:
• Place a piece of black paper on the back of the original and scan it again.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the Advanced Settings tab and adjust the Brightness setting.
• If the Image Type is set to Black & White, select Text Enhancement. If the Image Type is set to

Color or Grayscale, change the Text Enhancement setting to High.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Advanced Settings Tab

Ripple Patterns Appear in an Image
You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:
• Select the Descreening setting.
• Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Advanced Settings Tab
Additional Scanning Settings - Main Settings Tab
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Scanned Image Colors Do Not Match Original Colors
Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).
Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.
To adjust the colors in your scanned image, adjust these Epson Scan 2 settings (if available) and try
scanning again:
• If the Image Type setting is Color or Grayscale, adjust the Contrast setting.
• If the Image Type setting is Black & White or Grayscale, adjust the Color Enhance setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Advanced Settings Tab
Additional Scanning Settings - Main Settings Tab

Scanned Image Edges are Cropped
If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Placing Originals on the Product

Solving Faxing Problems
Check these solutions if you have problems faxing with your product.
Cannot Send or Receive Faxes
Cannot Receive Faxes with a Telephone Connected to Your Product
Fax Memory Full Error Appears
Sent Fax Quality is Poor
Sent Fax is Received in an Incorrect Size
Received Fax Quality is Poor
Received Fax is Not Printed
Parent topic: Solving Problems
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Cannot Send or Receive Faxes
If you cannot send or receive faxes, try these solutions:
• If an error code is displayed on the control panel, try the solutions suggested in the error code list.
• If you are faxing from a computer, use the Epson FAX Utility to send your fax.
• Make sure the recipient's fax machine is turned on and working.
• Make sure paper is loaded correctly in your product.
• Make sure you have set up your header information and have not blocked your caller ID. Otherwise,

your faxes might be rejected by the recipient's fax machine.
• If user restriction has been enabled, you may need to enter a user name and password. Contact your

administrator for assistance.
• If you did not connect a telephone to your product, set the Receive Mode setting to Auto so you can

receive faxes automatically.
• Check that the cable connecting your telephone wall jack to your product's LINE port is secure.
• Print a fax connection report using your product control panel or fax software to help diagnose the

problem.
• Verify that the telephone wall jack works by connecting a phone to it and testing it.
• If there is no dial tone and you connected the product to a PBX (Private Branch Exchange) phone line

or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the
product's dial tone detection setting. (Turning off the dial tone setting may cause the product to drop
the first digit of a fax number.)

• Check the Line Type setting and set it to PBX. If your phone system requires an external access code
to reach an outside line, register the code to the printer and add a # (hash) to the beginning of the
phone number when dialing.

• If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to
enable faxing over the line. Contact your DSL provider for the necessary filter.

• If you are connected to a DSL phone line, connect the product directly to a telephone wall jack and
send a fax. If it works, the problem may be caused by the DSL filter. Contact your DSL provider.

• If your telephone line has static, turn off your product's error correction mode fax communication
setting and try faxing again.

• Try lowering your product's fax speed setting.
• Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a

color fax.
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• If your telephone line uses call waiting and you have trouble receiving faxes, turn off call waiting to
prevent disruption of incoming faxes.

• If you have subscribed to a call forwarding service, the product may not be able to receive faxes.
Contact your service provider for assistance.

• Check your inbox and delete faxes after reading or printing them. If the inbox is full, the product cannot
receive faxes.

• When sending faxes using the subaddress feature, ask the recipient if their fax machine can receive
faxes using this feature. Check that the subaddress and password are correct, and that they match
with the recipient subaddress and password. Check this when receiving faxes as well.

• When receiving faxes using the subaddress feature, make sure the fax rejection settings are not
rejecting the fax.

• If you cannot send faxes at a specified time, make sure the date and time are set correctly on the
product.

• If you cannot receive A3-size faxes, make sure you selected the correct paper size setting for the
paper source containing the A3-size paper. Also, be sure to enable the paper source to receive faxes
as the Auto Select Settings option.

• If you are receiving faxes using the FAX Utility, check that your product is registered as a fax product
in your operating system:
Windows: Make sure the product appears in Devices and Printers, Printer, or Printers and Other
Hardware. If the product does not appear, uninstall and re-install the FAX Utility.
Mac: Select System Preferences > Printers & Scanners (or Print & Scan or Print & Fax) and make
sure your product appears. If your product does not appear, click + and add your product. If the
product does appear, double-click it and make sure it is not paused.

Note: If your product is connected to a VoIP (Voice over Internet Protocol) phone line, keep in mind that
fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax
transmission will work when using VoIP.
If your phone line includes voice mail answering services, calls or faxes may be inadvertently received
by your voice mail service.

Parent topic: Solving Faxing Problems
Related references
Job Status Error Codes
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Related tasks
Selecting the Line Type
Printing Fax Reports
Receiving Faxes Automatically
Connecting a Telephone or Answering Machine
Selecting Advanced Fax Settings
Saving and Viewing Received Faxes
Setting Up the Fax Utility - Windows
Related topics
Loading Paper

Cannot Receive Faxes with a Telephone Connected to Your Product
If you cannot receive faxes when a telephone is connected to your product, try these solutions:
• Make sure your telephone is connected to your product's EXT port.
• Make sure the Receive Mode is set to Manual.

Note: When answering a call that is a fax, wait until the product's LCD screen displays a message that a
connection has been made before you hang up.

Parent topic: Solving Faxing Problems

Fax Memory Full Error Appears
If you see an error message telling you that the product's fax memory is full, try these solutions:
• If you set the product to save received faxes in the product's memory or inbox, delete any faxes you

have already read.

Note: Your product can store up to 100 faxes before its inbox is full.

• If you set the product to save received faxes on a computer, turn on the selected computer. Once the
faxes are saved on the computer, they are deleted from the product's memory.

• If you set the product to save received faxes on a USB device, connect the selected USB device
containing the save fax folder to the product. Once the faxes are saved on the USB device, they are
deleted from the product's memory.
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Note: Make sure the USB device has enough available memory and is not write protected.

• If the memory is full, try sending a monochrome fax using the Direct Send feature, sending your fax
by using the On Hook feature, sending your faxes by dialing from the external phone device, or
sending your faxes in smaller batches.

• If the product cannot print a received fax due to a product error, such as a paper jam, the memory full
error may appear. Clear any product errors, then ask the sender to resend the fax.

Parent topic: Solving Faxing Problems
Related references
Fax Sending Options
Related tasks
Saving and Viewing Received Faxes

Sent Fax Quality is Poor
If the sent fax quality is poor, try these solutions:
• Clean the scanner glass.
• Clean the ADF.
• Try changing the resolution or density setting on the control panel.
• Try changing the original type setting on the control panel.
• If you are sending a monochrome fax to a single recipient, try sending the fax using the Direct Send

feature.

Note: If you send a high-resolution monochrome fax without using the Direct Send feature, the
product may automatically lower the resolution.

• Try enabling the error correction mode (ECM) setting.
Parent topic: Solving Faxing Problems

Sent Fax is Received in an Incorrect Size
If your recipient receives a fax in an incorrect size, try these solutions:
• If you are trying to fax an A3-size document, make sure the recipient's fax machine supports the paper

size. If the message OK (Reduced Size) appears in the fax transmission report, the recipient's fax
machine does not support A3-size documents.
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• If you are sending a fax using the scanner glass, make sure your original is placed correctly and that
the correct paper size is selected on the control panel.

• Clean the scanner glass and document cover.
Parent topic: Solving Faxing Problems
Related tasks
Cleaning Your Product
Placing Originals on the Scanner Glass

Received Fax Quality is Poor
If you receive a poor quality fax, try these solutions:
• Try enabling the error correction mode (ECM) setting.
• Contact the fax sender and ask them to send the fax in a higher resolution.
• Try reprinting the received fax.
Parent topic: Solving Faxing Problems
Related references
Fax Sending Options
Basic Settings - Fax
Related tasks
Cleaning Your Product

Received Fax is Not Printed
If a received fax is not printed, try these solutions:
• Make sure the product is free of errors. The product cannot print received faxes if an error has

occurred with the product, such as a paper jam.
• If the product has been set to save received faxes in the product's memory or inbox, received faxes

are not automatically printed. Check the Receive Settings options on the product control panel and
change them, if necessary.

Parent topic: Solving Faxing Problems
Related references
Receive Settings - Fax
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Solving USB Device Problems
Check these solutions if you have problems using USB devices with your product.
Cannot View or Print from a USB Device
Cannot Save Files on a USB Device
Cannot Transfer Files To or From a USB Device
Parent topic: Solving Problems

Cannot View or Print from a USB Device
If you cannot view or print photos or documents from a USB device connected to your product, try these
solutions:
• Make sure memory devices are enabled on the product.
• Make sure your device is compatible with the product.
• Make sure the files on your device are in the correct format.
Parent topic: Solving USB Device Problems
Related references
External USB Device Specifications
Interface Specifications
Related tasks
Transferring Files from a USB Device to Your Computer
Related topics
Viewing and Printing from the LCD Screen

Cannot Save Files on a USB Device
If you cannot save files on a USB device connected to your product, try these solutions:
• To save faxes on a USB device, create a folder in the Fax Output settings on the product control

panel.
• Make sure the device is not write-protected.
• Make sure the device has enough available space.
• Make sure memory devices are enabled on your product.
• Make sure the device is compatible with the product.
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Parent topic: Solving USB Device Problems
Related references
Interface Specifications
Receive Settings - Fax
Related tasks
Transferring Files from a USB Device to Your Computer

Cannot Transfer Files To or From a USB Device
If you have problems transferring files to or from a USB device connected to your product, try these
solutions:
• Make sure your device is compatible with the product.
• Make sure the device is not write-protected.
• Make sure your product is securely connected to your computer.
• Make sure that the file sharing setting for your product is enabled.
Parent topic: Solving USB Device Problems
Related references
Interface Specifications
Related topics
Transferring Files on a USB Device

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac
Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
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3. Do one of the following:

• Windows 10: Click and select (Settings) > Apps > Apps & features. Then select the
program you want to uninstall and select Uninstall.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:

• Windows 10/8.x: Select Epson Event Manager and click Uninstall.
• Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and

Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

5. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:
• Windows 10: Select Epson Scan 2 and click Uninstall.
• Windows 8.x/Windows 7/Windows Vista: Select Epson Scan 2 and click Uninstall/Change.

6. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - Mac
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.
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Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product.

2. Click Downloads.
3. Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.
4. Run the file you downloaded.
5. Double-click the Uninstaller icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to

uninstall.
7. Click Uninstall.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product for solutions to common problems. You can
download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your
questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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• Computer configuration
• Description of the problem
Then call: (866) 212-8743, 6 AM to 6 PM, Pacific Time, Monday through Friday.
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at epson.com (U.S. sales), epson.ca (Canadian sales),
or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.
Parent topic: Solving Problems

https://www.epson.com
https://www.epson.ca
https://epson.com.jm
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Technical Specifications
These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Automatic Document Feeder (ADF) Specifications
Scanning Specifications
Fax Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
External USB Device Specifications
Network Interface Specifications
Safety and Approvals Specifications
PostScript Fonts
PCL Fonts
PCL Mode 5 Symbol Sets

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista

https://epson.com/recycle-program
https://www.epson.ca/recycle
https://www.epson.ca/recycle
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• Windows Server 2016
• Windows Server 2012 R2
• Windows Server 2012
• Windows Server 2008 R2
• Windows Server 2008
• Windows Server 2003 R2
• Windows Server 2003 SP2 or later
Windows Server supports only the printer driver, Epson Scan 2, and Document Capture Pro Server; any
additional included software is not supported.

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select
your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select
your product, and select Downloads.

Parent topic: Technical Specifications

http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s
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Paper Specifications
Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Size 13 × 19 inches (330 × 483 mm)
A3 (11.7 × 16.5 inches [297 × 420 mm])
11 × 17 inches (279 × 432 mm)
A4 (8.3 × 11.7 inches [210 × 297 mm])
A6 (4.1 × 5.8 inches [105 × 148 mm])
Letter (8.5 × 11 inches [216 × 279 mm])
Legal (8.5 × 14 inches [216 × 356 mm])
Executive (7.25 × 10.5 inches [184 × 267 mm])
Mexico-Oficio (8.5 × 13.4 inches [216 × 340 mm])
Oficio 9 (8.46 × 12.4 inches [215 × 315 mm])
Half Letter (5.5 × 8.5 inches [140 × 216 mm])

Paper types Plain paper and paper distributed by Epson
Weight Plain paper: 17 lb (64 g/m2) to 24 lb (90 g/m2)

Thick paper: 25 lb (91 g/m2) to 68 lb (256 g/m2)

Envelopes

Size No. 10 (4.1 × 9.5 inches [105 × 241 mm])
Paper types Plain bond paper
Weight 20 lb (75 g/m2) to 24 lb (90 g/m2)

Parent topic: Technical Specifications
Related references
Paper Loading Capacity
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Printable Area Specifications
Single sheets

1 Top/bottom/right/left: 0.12 inch (3 mm) minimum
2 Reduced print quality area/top: 1.93 inches (49 mm) minimum
3 Reduced print quality area/bottom: 2.13 inches (54 mm) minimum

Envelopes
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1 Left/right: 0.12 inch (3 mm) minimum
2 Top/bottom: 0.20 inch (5 mm) minimum
3 Reduced print quality area/left: 2.13 inches (54 mm) minimum
4 Reduced print quality area/right: 1.93 inches (49 mm) minimum

Parent topic: Technical Specifications

Automatic Document Feeder (ADF) Specifications
Paper size From A6 (4.1 × 5.8 inches [105 × 148 mm]) landscape size to A3

(11.7 × 16.5 inches [297 × 420 mm]) size; maximum size 11.7 × 17
inches (297 × 431.8 mm)

Paper type Plain paper, high-quality paper, or recycled paper
Paper weight 14 lb (52 g/m2) to 34 lb (128 g/m2)
Sheet feeding capacity Total thickness: 0.22 inch (5.5 mm)

Approximately 50 sheets

Parent topic: Technical Specifications

Scanning Specifications
Scanner type Flatbed, color
Photoelectric device CIS
Effective pixels 14040 × 20400 pixels (1200 dpi)
Document size Maximum: 11.7 × 17 inches (297 × 431.8 mm)

Scanner glass: A3 or Ledger
Scanning resolution 1200 dpi (main scan)

2400 dpi (sub scan)
Output resolution 50 to 9600 in 1 dpi increments
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Image data Color:
30 bits per pixel (10 bits per pixel per color) internal
24 bits per pixel (8 bits per pixel per color) external
Grayscale:
16 bits per pixel internal
8 bits per pixel external
Black and white:
16 bits per pixel internal
1 bit per pixel external

Light source LED

Parent topic: Technical Specifications

Fax Specifications
Fax type Walk-up black-and-white and color fax capability (ITU-T Super

Group 3)
Support line Standard analog phone lines

PBX (Private Branch Exchange) telephone systems
Speed Up to 33.6 kbps
Resolution Monochrome

Standard: 203 pixels per inch × 98 lines per inch (8 pixels per mm ×
3.85 lines per mm)
Fine: 203 pixels per inch × 196 lines per inch (8 pixels per mm × 7.7
lines per mm)
Super Fine: 203 pixels per inch × 392 lines per inch (8 pixels per mm
× 15.4 lines per mm)
Ultra Fine: 406 pixels per inch × 392 lines per inch (16 pixels per mm
× 15.4 lines per mm)
Color
200 × 200 dpi
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Page memory Up to 550 pages (when an ITU-T No. 1 chart is received in
monochrome draft mode)

Redial 2 times (with 1 minute intervals)
Interface RJ-11 Phone Line

RJ-11 Telephone set connection

Parent topic: Technical Specifications

Ink Cartridge Specifications
Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.
The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Black, Cyan, Magenta, Yellow
Cartridge life Opened package: 6 months

Unopened package: do not use if the date on the package has
expired

Temperature Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at -9.4 °F (–23 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications
Related references
Ink Cartridge Part Numbers
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Dimension Specifications
Printer only

Height Storage: 19.4 inches (493 mm)
Printing: 22.5 inches (571 mm)

Width Storage: 24.1 inches (613 mm)
Printing: 24.1 inches (613 mm)

Depth Storage: 29.7 inches (755 mm)
Printing: 34.1 inches (866 mm)

Weight
(without ink cartridges or power
cord)

Approx. 101 lb (45.8 kg)

Printer with 3 optional cassettes and the optional cabinet

Height Storage: 45.7 inches (1162 mm)
Printing: 48.8 inches (1240 mm)

Width Storage: 30.4 inches (772 mm)
Printing: 30.4 inches (772 mm)

Depth Storage: 34.4 inches (873 mm)
Printing: 34.4 inches (873 mm)

Weight
(without ink cartridges or power
cord)

Approx. 231 lb (104.8 kg)

Parent topic: Technical Specifications

Electrical Specifications
Power supply rating 100 to 240 V
Rated frequency range 50 to 60 Hz
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Rated current 1.3 to 0.7 A
Power consumption Printing: Approximately 39 W (ISO/IEC24712)

Ready mode: Approximately 18 W
Sleep mode: Approximately 1.3 W
Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity
(without condensation)

Operating: 20 to 80% RH
Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
Interface type SuperSpeed USB

Hi-Speed USB (for external USB devices)

Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications
Related references
External USB Device Specifications

External USB Device Specifications
Do not use devices with the following requirements:
• Dedicated driver
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• Security settings, such as password or encryption, etc.

USB memory device 2TB
Formatted in FAT, FAT32, or exFAT

Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications

Network Interface Specifications
Wi-Fi

Standard IEEE 802.11 b/g/n; complies with either IEEE 802.11 b/g or IEEE
802.11 b/g/n, depending on purchase location

Security WPA2-PSK (AES); complies with WPA2 standards with support for
WPA/WPA2 Personal
WPA2-Enterprise (AES)
WEP (64/128 bit)

Note: Wi-Fi Direct supports only WPA2-PSK (AES).
Frequency band 2.4 GHz
Maximum radio-frequency
power transmitted

20 dBm (EIRP)

Communication mode Infrastructure mode
Wi-Fi Direct (Simple AP); not supported for IEEE 802.11b

Ethernet

Standard IEEE802.3i (10BASE-T)*
IEEE802.3u (100BASE-TX)
IEEE802.3ab (1000BASE-T)*
IEEE802.3az (Energy Efficient Ethernet); the connected device
should be IEEE802.3az compliant
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Communication mode Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full
duplex, 100Mbps Half duplex

Connector RJ-45

* Use a category 5e or higher STP (Shielded twisted pair) cable to prevent risk of radio interference.

Security
IEEE802.1X; requires the connected device to comply with IEEE802.1x
IPsec/IP Filtering
SSL/TLS; either HTTPS Server/Client or IPPS
SMTPS (STARTTLS, SSL/TLS)
SNMPv3
Parent topic: Technical Specifications

Safety and Approvals Specifications
United States Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
• Manufacturer: Seiko Epson Corporation.
• Type: J26H006
This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
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This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).
Parent topic: Technical Specifications

PostScript Fonts
Font name Family HP equivalent
Nimbus Mono Medium, Bold, Italic, Bold Italic Courier
Letter Gothic Medium, Bold, Italic, Letter Gothic
Nimbus Mono PS Regular, Bold, Oblique, Bold

Oblique
CourierPS

Nimbus Roman No4 Medium, Bold, Italic, Bold Italic CG Times
URW Classico Medium, Bold, Italic, Bold Italic CG Omega
URW Coronet — Coronet
URW Clarendon Condensed — Clarendon Condensed
URW Classic Sans Medium, Bold, Italic, Bold Italic Univers
URW Classic Sans
Condensed

Medium, Bold, Italic, Bold Italic Univers Condensed

Antique Olive Medium, Bold, Italic Antique Olive
Garamond Antiqua, Halbfett, Kursiv, Kursiv

Halbfett
Garamond

Mauritius — Marigold
Algiers Medium, Extra Bold Albertus
NimbusSansNo2 Medium, Bold, Italic, Bold Italic Arial
Nimbus Roman No9 Medium, Bold, Italic, Bold Italic Times New Roman
Nimbus Sans Medium, Bold, Oblique, Bold

Oblique
Helvetica
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Font name Family HP equivalent
Nimbus Sans Narrow Medium, Bold, Oblique, Bold

Oblique
Helvetica Narrow

Palladio Roman, Bold, Italic, Bold Italic Palatino
URW Gothic Book, Demi, Book Oblique, Demi

Oblique
ITC Avant Garde

URW Bookman Light, Demi, Light Italic, Demi
Italic

ITC Bookman

URW Century Schoolbook Roman, Bold, Italic, Bold Italic New Century Schoolbook
Nimbus Roman Medium, Bold, Italic, Bold Italic Times
URW Chancery Medium Italic — ITC Zapf Chancery Italic
Symbol — Symbol
URW Dingbats — Wingdings
Dingbats — ITC Zapf Dingbats
Standard Symbol — SymbolPS

Parent topic: Technical Specifications

PCL Fonts
Scalable Fonts

Font name Family HP equivalent Symbol set
Nimbus Mono Medium, Bold, Italic, Bold

Italic
Courier 1

Letter Gothic Medium, Bold, Italic, Letter Gothic 1
Nimbus Mono PS Regular, Bold, Oblique,

Bold Oblique
CourierPS 3

Nimbus Roman No4 Medium, Bold, Italic, Bold
Italic

CG Times 2

URW Classico Medium, Bold, Italic, Bold
Italic

CG Omega 3
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Font name Family HP equivalent Symbol set
URW Coronet — Coronet 3
URW Clarendon
Condensed

— Clarendon Condensed 3

URW Classic Sans Medium, Bold, Italic, Bold
Italic

Univers 2

URW Classic Sans
Condensed

Medium, Bold, Italic, Bold
Italic

Univers Condensed 3

Antique Olive Medium, Bold, Italic Antique Olive 3
Garamond Antiqua, Halbfett, Kursiv,

Kursiv Halbfett
Garamond 3

Mauritius — Marigold 3
Algiers Medium, Extra Bold Albertus 3
NimbusSansNo2 Medium, Bold, Italic, Bold

Italic
Arial 3

Nimbus Roman No9 Medium, Bold, Italic, Bold
Italic

Times New 3

Nimbus Sans Medium, Bold, Oblique,
Bold Oblique

Helvetica 3

Nimbus Sans Narrow Medium, Bold, Oblique,
Bold Oblique

Helvetica Narrow 3

Palladio Roman, Bold, Italic, Bold
Italic

Palatino 3

URW Gothic Book, Demi, Book
Oblique, Demi Oblique

ITC Avant Garde Gothic 3

URW Bookman Light, Demi, Light Italic,
Demi Italic

ITC Bookman 3

URW Century
Schoolbook

Roman, Bold, Italic, Bold
Italic

New Century Schoolbook 3

Nimbus Roman Medium, Bold, Italic, Bold
Italic

Times 3
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Font name Family HP equivalent Symbol set
URW Chancery
Medium Italic

— ITC Zapf Chancery Medium
Italic

3

Symbol — Symbol 4
URW DingBats — Wingdings 5
Dingbats — ITC Zapf Dingbats 6
Standard Symbol — SymbolPS 4
URW David Medium, Bold HP David 7
URW Narkis Medium, Bold HP Narkis 7
URW Miryam Medium, Bold, Italic HP Miryam 7
URW Koufi Medium, Bold Koufi 8
URW Naskh Medium, Bold Naskh 8
URW Ryadh Medium, Bold Ryadh 8

Bitmap Font
Line Printer, Symbol set 9

OCR/Barcode Bitmap Font (PCL5 Mode Only)

Font name Family Symbol set
OCR A — 10
OCR B — 11
Code 39 9.37cpi, 4.68cpi 12
EAN/UPC Medium, Bold 13

Note: Depending on the print density, or quality and color of the paper, the OCR/Barcode Bitmap fonts
may not be readable. Print a sample and check for readability before printing large quantities.

Parent topic: Technical Specifications
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PCL Mode 5 Symbol Sets
Your product can access a variety of symbol sets. Many of these symbol sets differ only in the
international characters specific to each language.

Note: Since most software handles fonts and symbols automatically, you may never need to adjust your
product settings. However, if you write your own product control programs, or if you use older software
that cannot control fonts, refer to these tables for details on the symbol sets.

When you consider which font to use, also consider which symbol set to combine with the font.

Symbol set name Attribute Font classification
Norweg1 0D 1, 2, 3
Roman Extension 0E 9
Italian 0I 1, 2, 3
EMC94-1 0N 1, 2, 3, 9
Swedis2 0S 1, 2, 3
ANSI ASCII 0U 1, 2, 3, 7, 8
UK 1E 1, 2, 3
French2 1F 1, 2, 3
German 1G 1, 2, 3
Legal 1U 1, 2, 3, 9
8859-2 ISO 2N 1, 2, 3, 9
Spanish 2S 1, 2, 3
ISO 8859/4 Latin 4 4N 1, 2, 3
Roman-9 4U 1, 2, 3
PsMath 5M 1, 2, 3, 7, 8
8859-9 ISO 5N 1, 2, 3, 9
WiTurkish 5T 1, 2, 3
MsPublishin 6J 1, 2, 3
VeMath 6M 1, 2, 3
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Symbol set name Attribute Font classification
8859-10ISO 6N 1, 2, 3, 9
DeskTop 7J 1, 2, 3
Math-8 8M 1, 2, 3, 7, 8
Roman-8 8U 1, 2, 3, 9
WiE.Europe 9E 1, 2, 3
Pc1004 9J 1, 2, 3
8859-15ISO 9N 1, 2, 3, 9
PcTk437 9T 1, 2, 3
Windows 9U 1, 2, 3
PsText 10J 1, 2, 3
IBM-US 10U 1, 2, 3, 9
IBM-DN 11U 1, 2, 3, 9
McText 12J 1, 2, 3
PcMultiling 12U 1, 2, 3, 9
VeInternati 13J 1, 2, 3
PcEur858 13U 1, 2, 3
VeUS 14J 1, 2, 3
PiFont 15U 1, 2, 3
PcE.Europe 17U 1, 2, 3
Unicode 3.0 18N 1, 2, 3, 7, 8
WiBALT 19L 1, 2, 3
WiAnsi 19U 1, 2, 3
PcBlt775 26U 1, 2, 3
Pc866Cyr 3R 1, 2
Greek8 8G 1, 2
WinGrk 9G 1, 2
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Symbol set name Attribute Font classification
WinCyr 9R 1, 2
Pc851Grk 10G 1, 2
ISOCyr 10N 1, 2, 9
Pc8Grk 12G 1, 2
ISOGrk 12N 1, 2
Pc866Ukr 14R 1, 2
Hebrew7 0H 1, 7
8859-8 ISO 7H 1, 7
Hebrew8 8H 1, 7
Pc862Heb 15H 1, 7
PC-862, Hebrew 15Q 1, 7
Arabic8 8V 8
HPWARA 9V 8
Pc864Ara 10V 8
Symbol 19M 4
Wingdings 579L 5
ZapfDigbats 14L 6
OCR A 0O 10
OCR B 1O 11
OCR B Extension 3Q 11
Code3-9 0Y 12
EAN/UPC 8Y 13

Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.
General Product Safety Instructions
Ink Cartridge Safety Instructions
Wireless Connection Safety Instructions
LCD Screen Safety Instructions
Telephone Equipment Safety Instructions
Parent topic: Notices

General Product Safety Instructions
• Be sure to follow all warnings and instructions marked on the product.
• Use only the type of power source indicated on the product's label.
• Use only the power cord that comes with the product. Use of another cord may cause fires or shock.

Do not use the cord with any other equipment.
• Place the product near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system

that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,

crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.

https://epson.com/recycle-program
https://www.epson.ca/recycle
https://www.epson.ca/recycle
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• If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.

• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.
• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not

operate properly if it is tilted or at an angle.
• Allow space behind the product for the cables, and space above the product so that you can fully raise

the document cover.
• Leave enough space in front of the product for the paper to be fully ejected.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place or store the product outdoors.
• Do not place the product near excessive heat sources or in direct sunlight.
• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the

case or insert objects through the slots.
• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers

or the base units of cordless telephones.
• Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your

product's radio waves from affecting the operation of the pacemaker.
• When connecting the product to a computer or other device with a cable, ensure the correct

orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

• Do not touch the flat white cable inside the product.
• Do not move the print head by hand; this may damage the product.
• Do not put your hand inside the printer while it is printing.
• Do not spill liquid on the product or use the product with wet hands.
• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may

cause fire.
• Do not press too hard on the document table when placing originals.
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• Do not open the scanner section while the product is copying, printing, scanning, or performing any
other functions.

• Be careful not to trap your fingers when closing the document cover or scanner.
• Except as specifically explained in your documentation, do not attempt to service or disassemble the

product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if

the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may
prevent the product from printing.

• Before transporting the product, make sure that the print head is in the home (far right) position and
the ink cartridges are in place.

• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak.

• Do not attempt to move the product by yourself.
Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions
• Keep ink cartridges out of the reach of children and do not drink the ink.
• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply

port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water. If you experience discomfort or vision problems after flushing your eyes, see a
doctor immediately. If ink gets in your mouth, see a doctor immediately.

• Do not put your hand inside the product or touch any cartridges during printing.
• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges

uninstalled can dry out the print head and may prevent the product from printing.
• Do not remove or tear the label on the cartridge; this can cause leakage.
• Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to

become unusable.
• Do not break the hooks on the side of the cartridge when removing it from the packaging.
• Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
• Do not shake cartridges too vigorously; this can cause them to leak.
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• If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in
the same environment as the product. Note that there is a valve in the ink supply port, making covers
or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge
touches. Do not touch the ink cartridge ink supply port or surrounding area.

• Use an ink cartridge before the date printed on its package.
• Do not dismantle an ink cartridge. This could damage the print head.
• Store ink cartridges in a cool, dark place.
• Make sure to install all ink cartridges. The printer only works when all ink cartridges are properly

installed.
• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature

for at least three hours before using it.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions
Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.
Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash

them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

• Do not press too hard on the LCD screen or subject it to heavy impacts.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson

for support.
• Do not subject your product to sudden changes in temperature or humidity; this may cause

condensation to develop inside the LCD screen and degrade its performance.
Parent topic: Important Safety Instructions
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Telephone Equipment Safety Instructions
When using telephone equipment, you should always follow basic safety precautions to reduce the risk
of fire, electric shock, and personal injury, including the following:
• Do not use the Epson product near water.
• Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from

lightning.
• Do not use a telephone to report a gas leak in the vicinity of the leak.

Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.

Parent topic: Important Safety Instructions

FCC Compliance Statement
For United States Users
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the telephone company.
Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.
A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.
The REN is used to determine the number of devices that may be connected to a telephone line.
Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number
of devices that may be connected to a line, as determined by the total RENs, contact the local telephone
company. For products approved after July 23, 2001 , the REN for this product is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a
decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.
If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. But if advance notice isn't practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your
right to file a complaint with the FCC if you believe it is necessary.
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The telephone company may make changes in its facilities, equipment, operations or procedures that
could affect the operation of the equipment. If this happens the telephone company will provide advance
notice in order for you to make necessary modifications to maintain uninterrupted service.
If you have problems with this product and require technical or customer support, please visit
www.epson.com for more information.
This product is not intended to be repaired by the customer. If you experience trouble connecting this
equipment to a telephone line, please contact:
Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840
If the equipment is causing harm to the telephone network, the telephone company may request that you
disconnect the equipment until the problem is resolved.
This equipment may not be used on coin service provided by the telephone company. Connection to
party line service is subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.
If your home has specially wired alarm equipment connected to the telephone line, ensure the
installation of this equipment does not disable your alarm equipment. If you have questions about what
will disable alarm equipment, consult your telephone company or a qualified installer.
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including fax machines, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. (The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.)
In order to program this information into your fax machine, click the link below for instructions on entering
fax header information.
According to the FCC's electrical safety advisory, we recommend that you may install an AC surge
arrester in the AC outlet to which this equipment is connected. Telephone companies report that
electrical surges, typically lightning transients, are very destructive to customer terminal equipment
connected to AC power sources and that this is a major nationwide problem.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
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interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
1. This product meets the applicable Innovation, Science and Economic Development Canada technical
specifications.
2. The Ringer Equivalence Number indicates the maximum number of devices allowed to be connected
to a telephone interface. The termination of an interface may consist of any combination of devices
subject only to the requirement that the sum of the RENs of all the devices does not exceed five.
CAN ICES-3(B)/NMB-3(B)
Le présent produit est conforme aux spécifications techniques applicables d’Innovation, Sciences et
Développement économique Canada.
L’indice d’équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de dispositifs qui peuvent
être raccordés à une interface téléphonique. La terminaison d’une interface peut consister en une
combinaison quelconque de dispositifs, à la seule condition que la somme des IES de tous les dispositifs
n’excède pas cinq.
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices
Related tasks
Using the Fax Setting Wizard
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Binding Arbitration and Class Waiver
1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS
1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.
1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.
1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way,
Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.
1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.
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1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.
1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the
selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.
You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.
a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").
(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

http://www.jamsadr.com
http://www.jamsadr.com
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(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.
b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.
c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.
d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).
e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.
1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).
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1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
Parent topic: Notices

Trademarks
EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
ConnectTM is a trademark of Seiko Epson Corporation.
Epson StoreSM is a service mark of Epson America, Inc.
Epson iPrintTM and Remote PrintTM are trademarks of Seiko Epson Corporation.
Apple, App Store, AirPrint, AirPrint logo, iPad, iPhone, iPod touch, Mac, macOS, and OS X are
trademarks of Apple Inc., registered in the U.S. and other countries.
Google® is a registered trademark and AndroidTM, ChromebookTM, GmailTM, Google ChromeTM, Google
Cloud PrintTM, Google DriveTM, and Google PlayTM are trademarks of Google Inc.
Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
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accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution
Parent topic: Notices

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (I) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Parent topic: Copyright Notice
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A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products
This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
Parent topic: Copyright Notice

Copyright Attribution
© 2018 Epson America, Inc.
4/18
CPD-55202
Parent topic: Copyright Notice
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